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Executive Summary 

 
The main objective of the research project currently under way is to provide an engineering 

assessment of the vulnerability of London’s public infrastructure under projected rates of climate 

change with special emphasis on flooding. An original systematic procedure is used to gather 

and examine available data in order to develop an understanding of the relevant climatic effects 

and their interaction with municipal infrastructure.  Assessment of climate change impacts on 

municipal infrastructure requires floodplain maps and inundation that will correspond to 

examined climate change scenarios. This report presents the results of hydraulic analyses used in 

floodplain mapping under changing climate.  

Combined, climate and hydrologic modeling, were used to generate input flow data for 

hydraulic modelling. Standard computer software HEC-RAS is used for hydraulic computation 

of water elevation. The existing HEC-RAS models of the Upper Thames River basin are not 

georeferenced and therefore they cannot be used for hydraulic modeling under climate change. 

Consequently, it was necessary to develop new HEC-RAS models for the rivers and creeks of 

London that were considered in this project.  

Geometric input data for new HEC-RAS models were created using HEC-GeoRAS 

software, which is an extension of ArcGIS computer package for spatial analysis. In the pre-

processing phase the HEC-GeoRAS is used to create a digital terrain model from the contour 

lines shape file provided by the city of London. In the next step the following geometric data 

layers were generated: river center line, bank lines, flowpaths, cross sections, and bridges. 

Required attributes were assigned to each of the layers.  In the last step of the pre-processing 

stage the input file for the HEC-RAS hydraulic analysis was prepared. The hydraulic analysis 

starts with the geometric data import, followed with the preparation of the hydraulic structures 
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data and flow data.  A very detailed quality control was performed on the cross sections data 

generated during the pre-processing phase. The roughness coefficient values were determined 

using the existing HEC-RAS models and aerial photography of the basin. Data on bridges, taken 

from the existing models and drawings were integrated with the rest of the data.   

Two climate scenarios (historic and wet) developed by climate and hydrologic modeling 

(Eum and Simonovic, 2009) were used and water surface elevation profiles were calculated for 

100- and 250- year return periods. The computation results were used to assemble the HEC-RAS 

GIS export file for floodplain mapping.  The Arc Map software package was used to create water 

surface GIS layer.  Overlaying this layer with the terrain provided for calculation of floodplain 

boundaries and inundation depths. The floodplain maps generated using this process are used in 

vulnerability assessments of London’s public infrastructure to climate change currently in 

progress. 

The results of water surface profile computations are presented in tabular form for the 250-

year flood under historic and wet climate scenarios. The final floodplain maps along Main 

Thames for both scenarios show minor deviation of the floodplain boundaries when compared 

with the existing floodplain lines. However, the water depth difference is up to 50 cm.  The area 

upstream from the culvert on Pottersburg Creek (close to the intersection of Trafalgar St. and 

Clarke St.) is identified as critical due to the high extent of flooding. The flooding at this location 

is caused by insufficient culvert opening that creates a backwater effect.  Areas of special 

concern are identified where the floodplain mapping results are not sufficiently accurate due to 

inaccuracies in the contour lines. The main recommendation based on the work presented in this 

report is that new georeferenced cross sections should be surveyed in order to increase the 
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accuracy of the floodplain mapping process. The hydraulic analyses should be repeated with 

more accurate input data and the resulting floodplain maps should be revised accordingly.    
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1. INTRODUCTION 

1.1 Problem Definition 

The climate is changing and reliable studies have already reported trends of global 

warming.  Evidence of climate change can be found in verified observations of an increase in 

global ocean and air temperature. In addition, it is expected that the extent of anticipated climate 

change will be more severe in the future.  One of the main findings from a recently completed 

study at the University of Western Ontario (on line documentation last accessed October 20, 

2009 http://www.eng.uwo.ca/research/iclr/fids/cfcas-climate.html) is that flooding in the Upper 

Thames River basin will be more frequent and severe under the climate change. The study 

indicates that historic climate data, which are used in management (design, maintenance and 

operations) of public infrastructure, will no longer be appropriate.  

The primary objective of the project initiated by the city of London is to provide an 

engineering assessment of the vulnerability of London’s public infrastructure under projected 

climate change. The elements of infrastructure under consideration include: buildings within and 

adjacent to the floodplains, roads, bridges, culverts, wastewater treatment plants, storm water 

management networks, etc. An original systematic procedure is used in the study to gather and 

examine available data in order to develop an understanding of the relevant climatic effects and 

their interactions with infrastructure. The purpose of the work presented in this report is to 

provide the assessment procedure with the extent of inundation and water depths for two climate 

scenarios under consideration. The integrated hydraulic modeling system and spatial analysis 

software were used in the study.   
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In addition to the fact that climate change was not considered in the development of current 

floodplain maps, there are others reasons why the current (official) maps could not be used in the 

“Vulnerability of Infrastructure to Climate Change” project. Current floodplain maps were 

generated manually about 30 years ago. Recently, the paper maps were digitized and converted 

into shape file format. Floodplain lines from the current (official) floodplain maps represent only 

the floodplain boundaries, and do not provide the inundation depths that are required for an 

assessment of infrastructure vulnerability. Geometric data for current (official) hydraulic models 

are not georeferenced, since the use of GIS software was not in place at the time of data 

surveying (around 1970’s and 1980’s). Hence, the currently available geometric data cannot be 

used with the GIS computer software for spatial analyses. 

 

1.2 Hydrologic input  

A climate modelling in the study is performed using an original weather generator (WG) 

model that provides long sequences of meteorological variables for selected set of climate 

change scenarios. Meteorologic input is then is used with the hydrologic model of the basin to 

generate flow input data for hydraulic modeling. Details on climate and hydrologic modeling are 

presented in the report by Eum and Simonovic (2009).  Two climate change scenarios are 

selected to represent the range of potential impact that climate change will have on the basin.  

The historic scenario is representing the lower bound of potential change and the wet scenario 

represents the upper bound of potential change.      
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1.3 Preparation of spatial data for hydraulic analysis 

Set of tools and utilities provided with the ArcGIS computer package is utilized in the 

preparation of spatial data for the hydraulic analyses. HEC-GeoRAS is an extension of ArcGIS, 

which is used for the preparation of spatial data for input into hydraulic model HEC-RAS and the 

generation of GIS data from the output of HEC-RAS (USACE, 2005). These tasks are organised 

as RAS (River Analysis System) pre-processing and RAS post-processing. The pre-processing 

starts with the development of a Digital Terrain Model (DTM) in Triangulated Irregular Network 

(TIN) format. It is followed with the preparation of the following GIS layers:  river center line, 

banks lines, flowpaths, cross sections, and bridges. The pre-processing ends with the preparation 

of the RAS GIS import file for the use with HEC-RAS computer program. 

The main post-processing task is automatic delineation of floodplains based on the data 

contained in the RAS GIS output file and the original terrain TIN layer.  The final step involves 

overlaying the water surface TIN with the terrain TIN to calculate the inundation depths and 

visualise the floodplain boundaries. 

 

1.4 Hydraulic modelling 

The Hydrologic Engineering Centre River Analysis System, shorter HEC-RAS, (USACE, 

2006) is an integrated software system designed to perform one-dimensional water surface 

calculations. HEC-RAS system is comprised of a graphical user interface, separate hydraulic 

analysis components, data storage and management capabilities, and graphing and reporting 

facilities (USACE, 2002 b). HEC-RAS is able to take into consideration hydraulic effects of 

bridges, culverts, weirs, and other structures in the river and floodplain on water surface 

calculations. 
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HEC-RAS takes most of the data through the RAS GIS import file in order to complete the 

geometric data, hydraulic structure data and flow data input. In the study reported here, the 

Manning’s roughness coefficient values and bridge data were used from the existing HEC-RAS 

models developed by the Upper Thames River Conservation Authority (UTRCA). Two sets of 

generated flow data are used for the historic and wet climate scenarios. The HEC-RAS computed 

water surface elevations stored in the RAS GIS export file are used in the floodplain mapping 

through the post-processing done with the assistance of HEC-GeoRAS.   

 

1.5 Project boundaries 

The spatial extension of the assessment project is limited to the city of London.  The study 

area is determined based on the existing HEC-RAS models. The Dingman Creek is extended to 

the western boundary of the city (around 4.465 m) and to the eastern boundary of the city 

(around 5.592 m). The main branch of the Thames River model starts at the downstream cross 

section, which is located 11,135 m away from the “Fork” (merging point of the North and South 

branches of the Thames River) and ends at “Fork”.  The North branch model of the Thames 

River starts at “Fork” and ends upstream, around 14,281 meters from the “Fork”, below the 

Fanshawe Dam. The South branch of the Thames River model starts at “Fork” and ends 

upstream, around 12,890 meters from the “Fork”, close to the City’s eastern  boundary.  The 

Medway Creek model starts at the confluence of Medway Creek and the North Thames River 

and ends upstream, around 12,534 meters from the confluence, close to the City’s northern  

boundary. The Pottersburg Creek model starts at the confluence of the Pottersburg Creek and the 

South Thames River and ends upstream, around 14,213 meters from the confluence, at the City’s 

eastern boundary.  The Mud Creek model starts at the confluence of the Mud Creek and the Main 
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Thames River and ends upstream around 2,397 meters from the confluence.  The Stoney Creek 

and tributaries model includes: Stoney Creek, Ballymonte Drain, Powel Drain and Norhdale 

Drain. 

 The Stoney Creek model starts at the confluence of the Stoney Creek and the North 

Thames River and ends upstream around 10,028 meters from the confluence. 

 The Ballymonte Drain model starts at the confluence of the Ballymonte Drain and the 

Stoney Creek and ends upstream around 2,483 meters from the confluence.  

 The Powell Drain model starts at the confluence of the Powell Drain and the Stoney 

Creek and ends upstream around 1,299 meters from the confluence. 

 The Northdale Drain model starts at the confluence of the Northdale Drain and the 

Powell Drain and ends upstream around 1,095 meters from the confluence. 

The Dingman Creek and tributaries model includes the Dingman Creek and the following 

tributaries: 2 (D), 3(E), 4(F), 5(G), 6 (I), 7 (B-64), 8(B-62), 9(C-30), 10(R), 11 (P), 12 (J), 13 

(K). 

 Dingman Creek starts approximately at 9,538 m (close to the City’s western boundary) 

from the confluence of the Dingman Creek and the Main Thames River, and ends 

upstream at 35,049 m from its initial origin, very close to the City’s eastern boundary.  

 Tributary 13 (K) starts at the confluence of the Tributary 13 and the Dingman Creek and 

ends approximately at 3, 039 m from the confluence. 

 Tributary 12 (J) (Reach 1 and Reach 3) starts at the confluence of the Tributary 12 and 

the Dingman Creek and ends upstream, approximately at 2,845 m from the confluence. 

Reach 2 of the Tributary 12 starts at the merging point of Tributaries 1, 2 and 3, and ends 

upstream, approximately 902 m from the merging point. 
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 Tributary 11 (P) (Reach 1 and Reach 3) starts at the confluence of the Tributary 11 and 

the Dingman Creek and ends upstream, approximately at 3.333 m from the confluence. 

Reach 2 of Tributary 11 starts at the merging point of Tributaries 1, 2 and 3, and ends 

upstream, approximately at 223 m from the merging point. 

 Tributary 10 (R) starts at the confluence of the Tributary 10 and the Dingman Creek and 

ends approximately at 784 m from the confluence. 

 Tributary 9 (C-30) starts at the confluence of the Tributary 9 and the Dingman Creek and 

ends approximately at 1,557 m from the confluence. 

 Tributary 8 (B-62) starts at the confluence of the Tributary 8 and the Dingman Creek and 

ends approximately at 1,294 m from the confluence. 

 Tributary 7 (B-64) starts at the confluence of the Tributary 7 and the Dingman Creek and 

ends approximately at 2,216 m from the confluence. 

 Tributary 6 (I) starts at the confluence of the Tributary 6 and the Dingman Creek and 

ends approximately at 2,564 m from the confluence. 

 Tributary 5 (G), (Reach 1 and Reach 3) starts at the confluence of the Tributary 5 and the 

Dingman Creek and ends upstream, approximately at 2,082 m from the confluence. 

Reach 2 of Tributary 12 starts at the merging point of Tributaries 1, 2 and 3, and ends 

upstream, approximately at 1,387 m from the merging point. 

 Tributary 4 (F), (Reach 1 and Reach 3) starts at the confluence of the Tributary 4 and the 

Dingman Creek and ends upstream, approximately at 2,267 m from the confluence. 

Reach 2 of Tributary 12 starts at the merging point of Tributaries 1, 2 and 3, and ends 

upstream, approximately at 749 m from the merging point. 
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 Tributary 3 (E) starts at the confluence of the Tributary 3 and the Dingman Creek and 

ends approximately at 4,476 m from the confluence. 

 Tributary 2 (D) starts at the confluence of the Tributary 3 and the Dingman Creek and 

ends approximately at 5,112 m from the confluence. 

 

1.6 Summary of the floodplain mapping results under climate change 

Table 1.1 shows the inundation area for both climate scenarios and two return periods 

(100- and 250-year).  For some rivers and creeks, the difference in flow between 100-years and 

250-years is not significant, and hence, the difference between inundated areas is also not 

significant. 

Table 1.1 Summary of the floodplain mapping results under climate change 

River/Creek 

Area of Flooding (m²) 
Historic Climate Scenario Wet Climate Scenario 

100-Year 
Return Period 

250-Year 
Return Period 

100-Year 
Return Period 

250-Year 
Return Period 

Main Thames River 2,717,208 3,189,657 3,228,637 3,342,766 
North Thames River 4,951,784 6,144,150 6,237,229 6,497,384 
South Thames River 2,676,651 2,886,324 2,885,980 3,128,588 
Medway Creek 1,143,686 1,219,177 1,170,080 1,242,106 
Stoney Creek and 
Tributaries 974,141 1,030,558 1,008,950 1,104,061 
Pottersburg Creek 2,853,112 3,069,149.00 3,063,310 3,283,552 
Mud Creek 72,339 124,241 123,697 226,260 
Dingman Creek and 
Tributaries 7,550,220 8,302,463 8,011,897 9,061,872 
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1.7 Report organization 
 

Chapter 2 explains the methodology used in the reported work. The uses of HEC-GeoRAS 

for pre-processing and post-processing of data, as well as the HEC-RAS for hydraulic modeling, 

are presented step by step. Some basic concepts and equations are also presented in this chapter.  

The results of surface profile calculations and floodplain mapping are presented in Chapter 3. 

The HEC-RAS results were presented in tabular form.  The floodplain mapping results are 

presented using (a) illustrative maps of selected areas, and (b) maps of locations of special 

concern.  Chapter 4 describes data limitations and provides some recommendations for 

increasing the accuracy of surface elevation calculations and floodplain mapping. 

2. METHODOLOGY 
 

This chapter explains in detail the methodology applied in floodplain mapping under 

climate change. The traditional process of floodplain mapping based on the hydraulic 

calculations of water surface elevations was adopted for the local data conditions. The main 

objective was to bring the process into digital format for use of software tools for spatial 

analyses. The methodology used in the reported work consists of three steps: (i) Pre-processing 

of geometric data for HEC-RAS, using HEC-GeoRAS; (ii) Hydraulic analysis in HEC-RAS; and 

(iii) Post-processing of HEC-RAS results and floodplain mapping, using HEC-GeoRAS. Process 

diagram for using HEC-GeoRAS is shown in Figure 2.1: 
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Figure 2.1 Process flow diagram for using HEC-GeoRAS (after USACE, 2005) 
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2.1 Pre-processing of geometric data 

For efficient use of multiple software packages, a very rigorous data preparation procedure 

is implemented in the study. 

2.1.1 Generation of Digital Terrain Model (DTM) 

The first step in the pre-processing stage was to create a Digital Terrain Model (DTM) of 

the river system in a Triangulated Irregular Network (TIN) format. The TIN must be constructed 

with a special care in order to provide for accurate analyses. Elevation data for each cross section 

is extracted from the TIN. The TIN also serves for determining floodplain boundaries and 

calculation of inundation depths. 

The Digital Terrain Model (DTM) is a representation of the topographical surface in terms 

of regularly spaced x, y, z, coordinates. The DTM can be developed from a number of sources 

including ground survey, photogrammetry, surface sensing and cartography. The TIN-based 

model has a vector-based data structure, but it can be converted into grid cells.  In the TIN 

model, each point has defined x, y, and z coordinates. The coordinate z represents the height. 

These points are connected by their edges to form a network of overlapping triangles (finite 

surfaces) that represent the terrain surface (Lo and Yeung, 2005). The basis of TIN-based DTM 

is that a large series of these finite surfaces, sharing common horizontal edges, can be linked 

together and used to interpolate the XYZ coordinate of any point, even though actual 

measurements have not been obtained at that point.  

The contour lines at an interval of 1 m (CNTRLIN.shp) in digital format shape file are used 

in TIN development. The data source of CNTRLIN.shp is: City of London Mapping Data 

Distribution Disc version 2007.00 [computer file]. London, Ontario: The Corporation of the City 

of London, 2007. The TIN development process starts by opening a new project in the ArcMap. 
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The CNTRLIN.shp is added to the map, and Interactive Selection Method “Add to Current 

Selection” is chosen from the Selection main window in order to create the desired size of the 

TIN.  3D Analyst Extension (Create/Modify TIN) is then used to complete TIN. 

Figure 2.2 shows a typical problem in TIN development at a bridge location. Such a 

problem causes inaccurate cross section extraction in that area, as well as a break in floodplain 

mapping. The TIN Editor Extension was used for a manual TIN editing. Aerial Photos (London, 

2007) and river bottom elevations from cross sections at bridge locations from existing HEC-

RAS models are used during the process of TIN editing. This was a tedious, but necessary, step 

because a similar problem was experienced for all bridge locations, especially in the case of 

smaller rivers and creeks. Figure 2.3 shows the same area after TIN editing. 
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Figure 2.2 TIN before editing 
 

 
Figure 2.3 TIN after editing 
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2.1.2 Creating of geometric data layers  

The empty ArcMap map is saved in the working directory and the TIN is added. As a result of 

this step, the appropriate coordinate system is automatically assigned in the ArcMap for the city 

of London: NAD_1983_UTM_Zone_17N.  The main task of the pre-processing is to create the 

geometry data file for the use with HEC-RAS. The geometry data file contains important 

information about cross-sections, hydraulic structures, river bank points and other physical 

attributes of river channels (Merwade, 2006). The pre-processing is done using the HEC-

GeoRAS for creating physical attributes in GIS, and then exporting them to the HEC-RAS 

geometry file. In HEC-GeoRAS, each attribute is stored in a separate feature class referred to as 

a RAS Layer (Merwade, 2006). Before creating river attributes in GIS, it was necessary to create 

empty GIS layers using the RAS Geometry menu on the HEC-GeoRAS toolbar.  The RAS layers 

were created in one step and stored collectively in a GeoDatabase, which HEC-GeoRAS creates 

automatically. By default, this GeoDatabase is saved under the same name and at the same 

location as the ArcMap project.  The RAS layers are created by selecting from the HEC-

GeoRAS toolbar: “RAS Geometry”ĺ “Create RAS Layers”ĺ   “All”. 
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Figure 2.4 Window for selecting RAS layers 
 

 
Figure 2.4 shows all available RAS layers. The following RAS layers are used in this project: 

river, banks, flowpaths, XsCutLines, bridges, levees, and InlineStructures. The following 

sections explain how each individual RAS layer created (digitized) is.  

Creating river center line. The river centerline layer is very important, because it 

represents the river network for HEC-RAS. Digitizing of the stream centerline starts with 

selecting the sketch tool from the Editor Toolbar, and digitization proceeds in the direction of 

river flow. Therefore, the process begins at the uppermost end of the stream (defined by the 

project extent), and ends at the confluence (or the City of London boundary). Beside TINs, the 

digitizing process used the London Aerial Photo (London50 RGB, 2007). Another rule for 

creating the river center line is that the stream centerline must follow the path of lowest 

elevation. Therefore, the process of digitizing the river center line cannot rely only on the Aerial 

Photo only. The elevation from the TIN must be checked, too. Figures 2.5 and 2.6 illustrate the 

process of creating center line at the same location, using aerial photo and TIN, respectively. 

 

 

Figure 2.5 Digitizing of river center line using Aerial Photo  
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Figure 2.6 Digitizing of river center line using TIN 
 

 
In the event when a river has more tributaries (e.g. Stoney and Dingman Creek), it is necessary to 

modify some of the editing options. The Snapping tool was used from the Editor Tool box to 

provide connectivity between reaches within the main stream, as well as the main stream and 

tributaries. 

After digitizing all of the reaches, the next task is to name them.  Each river in HEC-RAS, 

as well as each reach within a river, is assigned a unique name. This was accomplished by the 

selection of Assign RiverCode/ReachCode menu item and assigning appropriate names. 

The next step is to check that the created reaches are connected, and then to populate the 

remaining attributes of the river layer. This is accomplished by selecting RAS “Geometry”ĺ 

“Stream Centerline Attributes”ĺ “Topology”. This function is populated by the FromNode and 

ToNode attribute of the River layer. The Length/Stations fields are populated in a similar way. 

Figure 2.7 shows an attribute table for river GIS layer (Stoney Creek and Tributaries). The 

meaning of each attribute is explained below. 

 



- 27 - 
 

 

 
Figure 2.7 Attributes of the river (River Centerline) layer 

 
HydroID is a unique number for a given feature in a geodatabase. The River and Reach attributes 

contain unique names for rivers and reaches, respectively. The FromNode and ToNode attributes 

define the connectivity between reaches. ArcLength is the actual length of the reach in map 

units, and is equal to Shape_Length. In HEC-RAS, distances are represented using station 

numbers measured from downstream to upstream. For example, each river has a station number 

of zero at the downstream end, and it is equal to the length of the river at the upstream end. Since 

the Figure 2.7 shows only one reach for the Ballymonte Drain tributary, the FromSta attribute is 

zero and the ToSta attribute is equal to the ArcLength.  Figure 2.7 for the Powel Drain has two 

reaches, the FromSta attribute for the Upper Reach = ToSta attribute of the lower reach, and the 

ToSta attribute for the upper reach is the sum of ArcLengths for the upper and the lower reach. 

Similarly, for Stoney Creek the ToSta attribute for the upper reach is the sum of ArcLengths for 

the upper, the middle, and the lower reach.   

Creating River Banks.  The bank lines layer is used to define river channel from overbank 

areas. This definition is important because Manning’s n values are different for channel and for 

floodplain areas. Usually, the overbank areas have higher values of Manning’s n due to   
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vegetation or presence of residential areas. Since Manning’s n values influence the accuracy of 

HEC-RAS modeling, this task is very important. The bank lines are created in similar fashion as 

the river centerline. On the Edit toolbar, select “Editor”ĺ “Start Editing”.  The task window of 

the Edit toolbar is set to “Create New Feature” and the target is set to “Banks”.  Figure 2.8 shows 

the Editor Toolbar and the process of creating River Banks Lines using Aerial Photo (London50 

RGB 2007). 

 

Figure 2.8 Digitizing of River Bank Lines 
 

The digitizing of bank lines starts from the upstream end, with the left bank (looking in 

downstream direction) being digitized first. Since the Aerial Photo is used in digitizing of banks 

lines, river water surface elevation at the moment of taking the aerial photo may influence the 

banks line definition. 

Creating Flowpaths. The flowpath layer is a set of lines that follows the center of mass of 

the water flowing down the river, during the flood event (Meyer and Olivera, 2007). The 

flowpath layer contains three types of lines: centerline, left overbank, and right overbank. For the 

main channel, the flowpath centerline is defined to be the same as the stream centerline.  For 

floodplains, the flowpath centerlines are digitized to represent assumed water flow within the 

floodplain. The flowpath layer is used to determine the length between two neighbouring cross 
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sections (required by HEC-RAS). Flowpath centerlines are also created in the upstream to 

downstream direction. To create left and right flowpaths, it is necessary to start Editing, then 

choose Create New Feature as the Task, followed by  Flowpaths as the Target as shown in Figure 

2.9. 

 

 
Figure 2.9 Digitizing of Flowpaths 

                                                              

By using the Assign LineType button  , the Flowpath is labelled Right, Channel, Right 

looking in downstream direction.     

Creating Cross-sections. Cross-sections are one of the most important inputs to HEC-RAS. 

Cross section cutlines are used to extract the elevation data from the terrain and to create a 

ground profile across the flow. The intersection of cutlines with other RAS layers such as 

centerline and flow path lines are used to compute HEC-RAS attributes such as bank stations 

(locations that separate main channel from the floodplain), and downstream reach lengths 

(distance between cross- sections).   

A significant amount of cut lines are drawn at the same location where the existing 

UTRCA cross sections are surveyed. UTRCA Cross Section Shape files (line), which show 

location, shape and length of surveyed cross sections, are used in the creation of this layer. Some 
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of the UTRCA cross sections were modified to meet criteria (rules) for the appropriate drawing 

of cut lines. A few important rules were followed during the process of drawing cross section cut 

lines (Meyer and Olivera, 2007): 

• Cut lines are drawn perpendicular to the direction of flow. At some locations, “dog-leg” 

shapes of cross-section are used.   

 • Cut lines are drawn directionally from left to right bank, looking at downstream 

direction.   

• Cut lines are extended far enough on either side of the channel to encompass the entire 

portion of the floodplain. Where it is possible, they end at the same elevation at both ends.   

• Cut lines do not intersect each other.  

• Cut lines are spaced close enough to account for notable changes in the hydraulics or 

geometry of the stream, such as changes in discharge, slope, cross section shape, 

roughness or presence of hydraulic structures (bridges, levees, weirs.)  

 • Each bridge intersection requires 4 cut lines, 2 upstream of the bridge and 2 downstream 

of the bridge. In Figure 2.10, Lc represents the contraction reach length and Le is the 

expansion reach length (typically, Lc < Le). These distances can be determined with a 

high degree of accuracy by conducting field investigation during high flows. Since there 

was no field investigation data, distances between cross-sections 1and 2 and cross-sections 

3 and 4, are determined by examining the TIN to locate the points in the channel where 

the flow is fully expanded or contracted. Then, cross sections 1 and 4 are located at these 

points. Also, information from the existing HEC-RAS models are used. Cross-sections 2 

and 3 are placed within a short distance of the upstream and downstream ends of the 

bridge. The purpose of placing these cross-sections near the bridge is to capture the natural 
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ground elevations directly next to the bridge. Usually, cross-sections 2 and 3 are drawn at 

the toe of the bridge embankment on their respective sides of the bridge. In addition to 

TINs and existing HEC-RAS models, Aerial Photo (London50 RGB 2007) are used.  

To draw cross sections, it is necessary to start an editing session and select Create New 

Feature from the Task menu and XSCutLines from the Target menu (see Figure 2.11). The next 

important step is to populate the attribute table of the XSCutLines feature class, which is 

digitized. From the HEC-Geo RAS toolbar, “RAS Geometry”ĺ “XS Cut Line Attributes”ĺ 

“All” is selected.  Figure 2.12 shows the pop-up window for populating the attribute table. The 

drop-down menu is used to select the correct layer name for each item on the list and to populate 

the attribute table of the XSCutLines feature class. The XS Cut Lines Profiles is a new feature 

class that is created in the following way: The 2D feature class XSCutLines is intersected with 

the TIN to create a feature class with 3D cross section. After that, the attribute table and cross-

sections are examined in order to check their correctness. Figures 2.13 and 2.14 show examples 

of an adequately populated attribute table of XSCutLines and of an adequate definition of cross-

section, respectively.  
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Figure 2.10 Location of bridge cross-sections (after USACE, 2002 b) 
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Figure 2.11 Cross sections and commands used for their cutting 
 

 

Figure 2.12 Pop-up window for populating attribute table of XSCutLines feature class 
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Figure 2.13 Example of adequately populated attribute table of XSCutLines 
 

 

Figure 2.14 Example of adequate definition of cross-section 
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Creating Bridges and Culverts. After creating cross-sections, the next step is to define 

bridges, culverts and other structures along the river. Bridges and culverts are created in a similar 

way to the cross section layer. As Figure 2.15 shows, from the Editor Toolbar select Create New 

Feature for the Task and Bridges as the Target. Bridge lines are digitized from the left overbank 

to the right overbank, looking in the downstream direction. TINs and Aerial Photo (London, 

2007) are used to locate each bridge and draw a line along the centerline of the bridge without 

intersecting the cross sections. The Bridge line is drawn with a high degree of accuracy to ensure 

that the sectional topography is well represented.  

 

Figure 2.15 Bridge and commands for bridge digitizing 

The next step after digitizing the bridges/culverts is to label them with the terms as River/Reach, 

as well as to provide a station number for these features. This is accomplished using the 

following procedure: “RAS Geometry”ĺ “Bridge/Culverts”ĺ “River/Reach Names” to assign 
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river/reach names. The next step is as follows: “RAS Geometry”ĺ “Bridge/Culverts”ĺ 

“Stationing” to assign station numbers. Similar to cross-sections, the Bridges feature class stores 

2D polylines, which are converted to 3D by selecting “RAS Geometry”ĺ “Bridge/Culverts”ĺ 

“Elevations” to create a new 3DBridges feature class. Despite the fact that information from the 

existing HEC-RAS models is used for the most of bridge deck data in HEC-RAS, it is necessary 

to provide deck data for bridges that are missing from the original models. 

 

2.1.3 Exporting GIS Data to HEC-RAS  

The last step is to create a GIS import file for HEC-RAS so that it could import the GIS 

data to create the geometry file. Firstly, it is necessary to define which layers would be exported 

to HEC-RAS.  The tabs “RAS Geometry”ĺ “Layer Setup” are selected from the HEC-GeoRAS 

toolbar. The Layer Setup window has four tabs: Required Surface, Required Layers, Optional 

Layers and Optional Tables. The Required Surface option is used for choosing TIN for export. 

The Required Layers option is used for entering the River Layer, XSCutLines Layer and 

XSCutLines 3D Layer. The Optional Layers option is used for entering other RAS layers. Figure 

16 shows a typical RAS Layers definition at Optional Layers tab. Other RAS Layers, which are 

not used in the project, show a Null value. Export of GIS Data is performed in the following 

way: The menu item “RAS Geometry”ĺ “Extract GIS DATA” is selected from the HEC-

GeoRas toolbar. The default name GIS2RAS is accepted and saved in Maps folder. 
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Figure 2.16 Optional Layers definition 

 

For more GIS details, specific extensions or commands consult: HEC-GeoRAS4_Users 

Manual.pdf, September 2005 available on line from the US Army Corps of Engineers 

Hydrologic Engineering Center website: http://www.hec.usace.army.mil/software/hec-ras/hec-

georas_downloads.html. 

 

2.2 Hydraulic analysis 

2.2.1 HEC-RAS basic concepts and equations 

HEC-RAS is an integrated software system, designed for interactive use in a multi-tasking 

environment and used to perform one-dimensional water surface calculations. HEC-RAS system 

is comprised of a graphical user interface, separate hydraulic analysis components, data storage 

and management capabilities, and graphing and reporting facilities (USACE, 2002 b).The most 
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recent version of HEC-RAS supports steady and unsteady flow water surface profile 

calculations, sediment transport computations, and water temperature analysis (USACE, 2002 b). 

HEC-RAS is currently capable of performing one–dimensional water surface profile calculations 

for steady gradually varied flow in natural or constructed channels. It can handle a full network 

of channels or single river reach. Within steady flow it can be model subcritical, supercritical or 

mixed flow regime.  

Computation engine of HEC-RAS is based on the solution of the one-dimensional energy 

equation. Energy losses are evaluated by friction (Manning’s formula), contraction, and 

expansion. In cases where the water surface profile is rapidly varied, use of the momentum 

equitation is necessary. These cases include: mixed flow regime calculations, bridge hydraulic 

calculations and evaluation of profiles at river confluence.  HEC-RAS is capable of calculating 

effects of bridges, culverts, dam’s weirs, and other structures in the river and floodplain. The 

brief introduction of main concept and equations follows.  

Steady and Unsteady Flow. Flow in an open channel is steady if the depth, discharge, and 

mean velocity of flow at a particular location does not change with time, or if it can be assumed 

constant during the time period under consideration. If the depth, discharge and velocity of flow 

at some point changes with time, the flow is unsteady. A time factor is taken into account 

explicitly in the case of unsteady flow analysis, while steady flow analysis neglect time factors 

altogether. 

Uniform and Non Uniform Flow. We say that channel flow is uniform if the depth, the 

discharge and the mean velocity do not change in space. This implies that the energy grade line, 

water surface elevation and channel bottom are all parallel for uniform flow. This type of flow 

rarely occurs in reality. Non-uniform flow is sometimes designated as varied flow and can be 
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further classified as gradually varied and rapidly varied. The flow is rapidly varied if the spatial 

changes to the flow occur rapidly and the pressure distribution is not hydrostatic, otherwise it is 

gradually varied.  Based on these classifications the steady flow can be uniform or varied. The 

unsteady flow is usually varied, as the unsteady uniform flow is practically impossible, because 

it would require that the water surface fluctuates from time to time while remaining parallel to 

the channel bottom (Chow, 1959).  The basic assumption of the gradually varied flow 

computation is that the streamlines are practically parallel and hydrostatic pressure distribution 

prevails over the channel section. The head loss at a section is the same as with a uniform flow 

that has the same hydraulic radius of the section. Accordingly, the uniform flow equation may be 

used to evaluate the energy slope of a gradually varied flow, while the corresponding coefficient 

of roughness developed primarily for uniform flow is applicable to the gradually varied flow 

(Chow, 1959). These assumptions are valid for most river flows including flood flows. The 

assumption of hydrostatic pressure distribution requires the stream to have a small slope of 1:10 

or less. Most floodplain studies are performed on streams which meet this requirement (USACE, 

2002 b). 

Subcritical and Supercritical Flow.  The effect of gravity upon the state of flow is defined 

by a ratio of inertial force to gravitational force as the dimensionless Froude Number.  

ܨ  = ඥܸ݃ܮ 
 

(2.1) 

where, 

F = Froude number (dimensionless) 

V = mean channel flow velocity (m/s) 

g = acceleration due to gravity (m/s2) and 

L = characteristic length (m). 
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In open channel flow, the characteristic length is often taken as the hydraulic depth D, 

which is defined as the cross sectional area channel normal to the direction of flow divided by 

the width of the free surface.  The flow is classified as subcritical, critical or supercritical, 

depending on the Froude number. When the Froude number is less than 1, the effect of 

gravitational force is less than the inertial force and the state of flow is referred to as subcritical 

flow. When inertial and the gravitational forces are equal, the Froude number is equal to unity 

and the flow is said to be at the critical stage. When the inertial forces exceed the gravitational 

force, the Froude number is greater than 1, and the flow is referred to as supercritical flow.  The 

flow regime is an important criterion for the calculation of water surface profiles. When the state 

of flow is subcritical, the state of flow is controlled by channel characteristics at the downstream 

end of the river reach. In the case of supercritical flow, the flow is governed by the upstream end 

of the river reach. 

Continuity Equation.  In the steady open channel flow analysis, the continuity equation 

states that flow remain constant between adjacent cross-sections. 

 ܳ = ଵ ଵܸܣ =  ଶ ଶܸ (2.2)ܣ
Where: ܳ  = flow rate/discharge (m³/s) 

ଵܸ, ଶܸ = mean flow velocity (m/s) and ܣଵ,ܣଶ   = cross-sectional flow area (m²). 

This equation allows tracing of changes in a cross-sectional area and velocity from location to 

location. 
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Energy Equation.  Gradually varied water surface profiles are based on the principle of the 

conservation of energy, which states that the sum of the kinetic energy and potential energy at a 

particular cross section is equal to the sum of the potential and kinetic energy at any other cross 

section plus or minus energy loss or gains between the sections (Figure 2.17). Water surface is 

calculated from one cross section to the next by solving the energy equation written as: 

 ଶܻ + ܼଶ +
ଶߙ ଶܸଶ
2݃ = ଵܻ + ܼଵ +

ଵߙ ଵܸଶ
2݃ + ݄௘ (2.3) 

 
where, 

ଵܻ , ଶܻ  = depth of water at cross sections (m) ܼଵ,ܼଶ = elevation of main channel inverts (m)   

ଵܸ, ଶܸ = average velocities (total discharge/total flow area)  ݃ = gravitational acceleration                                                         ߙଵ,ߙଶ = velocity weighting coefficients (dimensionless) and 

 ݄௘= energy head loss (m). 
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Figure 2.17 Representation of terms in the energy equation (after USACE, 2002 b) 
 

 
Based on the energy equation, the energy head loss is the sum of friction losses and expansion, 

or contraction of coefficient.   

 ݄௘ = ܮ ௙ܵഥ + ܥ ቤߙଶ ଶܸଶ
2݃ െ ଵߙ ଵܸଶ

2݃ ቤ (2.4) 

where, 

L = reach length between the adjacent cross sections  

Sf = friction slope between the two sections and  

C = expansion or contraction loss coefficient (dimensionless). 

The magnitude of Į depends upon the channel characteristics. Typical values of Į, is shown in 

Table 2.1.  
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Table 2.1 Magnitude of Į (after Debo and Reese, 2002) 
 

Channel 
Value of Į 

Min. Avg. Max. 

Regular Channel 1.1 1.15 1.2 

Natural Channel 1.15 1.3 1.5 

Natural Channel-flooded  overbanks 1.5 1.75 2 

                                                                                                                                                     
 

Manning’s Loss Coefficient. The energy losses due to the roughness of the river bed are 

usually evaluated in terms of Manning's Equation: 

 ܳ = ܭ ௙ܵଵ ଶൗ  (2.5) 

ܭ  =
1݊ ଶܴܣ ଷൗ  (2.6) 

where: 
 
K = conveyance of the section (݉ଷିݏଵ)  
n = Manning’s roughness coefficient (݉ିଵ ଷΤ (ݏ  and 
R = hydraulic radius (m). 
 

Selecting the appropriate Manning’s n value is very important for accurate computation of 

water surface profiles. The value of Manning's n  is highly variable and depends upon a number 

of factors including: surface roughness, channel irregularities, channel alignment, size and shape 

of channel, scour and deposition, vegetation, obstructions, stage and discharge, seasonal change, 

temperature, suspended materials and bed load (USACE,2002 b). The n value decreases with 

increases in stage and discharge. When the water depth is shallow, irregularities of the channel 

bottom are exposed and their effect may become pronounced. However, the n value may be large 

at high stages if the banks are rough and grassy (Chow, 1959). 
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If there is observed water surface data (high water marks, gagged data), Manning’s n 

values should be calibrated. If there is no observed data (like in this study), then values of n 

obtained from another stream with similar conditions should be used.  There are several 

references available listing the typical n values. Excerpts of the n value from Chow (1959) for 

natural streams are given in the Table 2.2.   
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Table 2.1 Manning’s n values  
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Table 2.1 Manning’s n values-continued  
 

 
 
 



- 47 - 
 

Table 2.1 Manning’s n values-continued  
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There are various methods and empirical formulae available for the estimation of the 

Manning's n value. Cowen (1956) developed a procedure for the estimation of formula for n as a 

function of type and size of the bed materials and channel properties. In Cowen's procedure, the 

n value is determined by the following equation: 

 
 ݊ = (݊௕ + ݊ଵ + ݊ଶ+݊ଷ+ ݊ସ)݉ 

(2.7) 

where, 
 ݊௕ = base value of n for straight uniform & smooth channel in natural materials ݊ଵ  = value added to correct surface irregularities ݊ଶ = value for variation in size and shape of channel ݊ଷ = value for obstructions ݊ସ  = value for vegetation and flow conditions and ݉ = correcting factor to take account of the meandering of channel. 

Limerinos (1970) related the n related value as the function of bed materials and hydraulic  
 

radius: 

 
 ݊ =

0.0926ܴି଴.ଵ଺
1.16 + 2log (ܴ ଼݀ସ)Τ  

(2.8) 

where, 
 ܴ   = hydraulic radius (feet) and ଼݀ସ= particle size diameter that is equal to or exceeds 84% of particle (feet). 
Limerinos selected the reaches that had a minimum amount of roughness that were caused by 

factors other than the bed materials, and so these base n values should be increased to take 

account of other factors as shown in Cowen's method  (USACE, 2002 b). This equation was 

developed for the data range of hydraulic radius 1.0 to 6.0 and ݀ ଼ସ 1.5 to 250 mm.  

Expansion and Contraction Coefficients. The following equation is used for the 

determination of contraction and expansion losses. 

  

         ݄௖௘ = ܥ ቤߙଵ ଵܸଶ
2݃ െ ଶߙ ଶܸଶ

2݃ ቤ (2.9) 

where:    ܥ     = the contraction or expansion coefficient. 
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The coefficient of expansion and the coefficient of contraction are introduced to take into 

account losses due to the expansion or contraction of flow caused by changes in the cross 

sections. The losses due to these fluctuations are significant, particularly at points where there is 

an abrupt change in the cross section – for example at bridges.  Typical values of expansion and 

contraction coefficients for subcritical flow are given in Table 2.3. 

Table 2.2 Subcritical Flow Expansion and Contraction Coefficient (USACE, 2002 b) 
 

Type of Channel Contraction Expansion 
No transition 0.00 0.00 
Gradual transition 0.10 0.30 
Typical bridge sections 0.30 0.50 
Abrupt transition 0.60 0.80 

 
 

Friction Loss Evaluation. Manning’s equation is used for the calculation of energy slope as 

follows: 

 
 

௙ܵ = ൬ܳܭ൰ ² 
(2.10) 

There are also a few other alternative expressions for the representation of reach friction slope in 

HEC-RAS computer program. 

2.2.2 Computation method 

The method of computation of water surface profiles for gradually varied flow is based on 

the assumption that the slope of the energy grade line at a section is equal to the energy slope for 

a uniform flow with the velocity and hydraulic radius of the section (Chow, 1959). Some of the 

basic steps in the computation of water surface profiles in HEC-RAS are explained below. 
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Cross Section Subdivision for Conveyance Calculations. The determination of the 

conveyance coefficient in HEC-RAS involves subdivision of flow into units based on Manning's 

coefficient n (Figure 2.18). The conveyance for each subdivision is calculated by using Equation 

(2.6). The total conveyance for the cross section is obtained by adding the three subdivision 

conveyances (left, channel, and right). 

 

 
Figure 2.18 Conveyance Subdivision Method (after USACE, 2002 b) 

 
 
 

Mean Kinetic Energy Head Calculation. Mean kinetic energy head for each cross section is 

obtained by computing the flow weighted kinetic energy heads for three subsections of the cross 

sections (main channel, right and left overbank). Figure 2.19 illustrates the mean kinetic energy 

calculation process for the cross section with the main channel and the right overbank. 



- 51 - 
 

 

 
Figure 2.19 Example of Mean Energy calculation (after USACE, 2002 b) 

 
 .૛ is mean velocity for the right overbankࢂ ૚ is mean velocity for the main channel andࢂ 

The calculation of the mean energy head requires the velocity weighing coefficient Į. The 

following equation, which is written in terms of conveyance and area, shows the calculation of Į: 

ߙ  =
²(௧ܣ) ൤ܭ௟௢௕ଷܣ௟௢௕ଶ +

௖௛ଶܣ௖௛ଷܭ +
௥௢௕ଶܣ௥௢௕ଷܭ ൨ܭ௧ଷ  

(2.10) 

where: ܣ௧ =   total flow area of the cross section ܣ௟௢௕,ܣ௖௛,ܣ௥௢௕,=   flow areas of left overbank, main channel, and right overbank, respectively ܭ௧  =   total conveyance of the cross section and ܭ௟௢௕,ܭ௖௛,ܭ௥௢௕,  =   conveyance of left overbank, main channel and right overbank respectively. 
Standard Step Method. The Standard Step Method can be used for both prismatic and non-

prismatic channels, including the adjacent floodplain. This method can be applied to compute 

steady, gradually varied flow, and can also be used for both subcritical and supercritical flow. 

The computation for this method is based on the energy Equation (2.4) by steps from station to 

station. Depending upon the conditions of flow (subcritical or supercritical), the computations 

must be made in different directions. For subcritical flow that is under downstream control, the 

computation starts from downstream and proceeds upstream. For supercritical flow that is under 

upstream control, the computation starts from upstream and proceeds downstream. The 



- 52 - 
 

computation steps used in this procedure for the subcritical flow are as follows (USACE, 2002 

b): 

1. Assume the water surface elevation at the upstream cross section. 

2. Based on the assumed water surface elevation, determine the corresponding total 

conveyance and velocity head. 

3. With values from step 2, calculate the frictional slope Sf and solve Equation (2.4) for 

energy head loss (he) 

4. With values from steps 2 and 3, solve Equation (2.3) for water surface elevation WS2. 

5. The computed value of WS2 is compared with the assumed value in step 1, and steps 1 

through 5 are repeated until the values agree with the predefined tolerance (.003 m). 

 

2.2.3 Step by step modelling using HEC-RAS 

The following section presents brief manual for use of HEC-RAS program for computation 

of water surface profiles. The main objective of this presentation is to provide assistance to those 

who may not be familiar with the HESC-RAS computer program. 

 Creating HEC-RAS project and importing geometry. The initial step for using the program 

involves opening of the main HEC-RAS interface window and entering the title and file name. 
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Figure 2.20 The main HEC-RAS window with the title and file name 
 

 
The Geometric Data Window opens from the main HEC-RAS user window. To enter the 

geometry select: “File”ĺ “Import Geometry Data”ĺ “GIS Format”ĺ “Browse for Desired 

RAS GIS Import File (GIS2RAS.RASImpor.sdf)”. Firstly, from the Import Options window, SI 

(metric) units are selected. Then, “River and Reach Stream Lines” are selected. Cross sections 

and bridges for importing are checked by selecting tab “Cross Sections and IB Nodes” (Figure 

2.21).  The Geometry Data are saved in the Geometric Data window. Figure 2.22 shows the 

Geometric Data window with the georeferenced river system. 

The next step involves the use of Cross Section Points Filter, because some cross-sections 

may have duplicate points or a high number of points (over 500). “Tools” and then the “Cross 

Section Points Filter” are selected from the Geometric Data window. For all rivers and 

tributaries, cross sections were filtered to 250 points.  

Geometric Data Window 
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Figure 2.21 Import options window 
 

 

Figure 2.22 Geometric data window 
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The following sections describe steps and adjustments performed for geometric data completion. 

Cross-sections quality control. First, the newly generated cross-sections are compared with 

the existing UTRCA cross-sections at the same locations. A significant difference in channel 

bottom elevation is subsequently observed. The newly generated cross-sections (using HEC-Geo 

RAS) usually have channel bottom elevation 1 m higher than the UTRCA cross-sections. The 

discrepancy between the cross sections is due to the TIN accuracy. Such a difference in channel 

bottom elevation would have produced inaccurate HEC-RAS water surface profiles.   

In addition, many of the newly generated cross-sections look like the “mirror image” of the 

UTRCA cross-sections. The left side of some generated cross sections corresponds to the right 

side of the UTRCA cross sections, the and right side corresponds to the left side. The reason for 

this”mirror image” problem is inconsistency in the UTRCA cross-sections surveying. Since most 

of the UTRCA cross-sections were surveyed in the 1970s’ and 1980s’, a surveying standard - 

from left to right, looking in downstream direction was probably not used.  

The difference in overbank areas is observed for some cross-sections too. Considering that the 

UTRCA cross-sections are surveyed more than 30 years ago, it is quite possible that some 

overbank areas did change. 

 The channel bottom elevation of newly generated cross sections is edited in order to make 

newly generated cross sections similar to the UTRCA cross section in the river channel area. The 

process of river bottom editing starts in HEC-GeoRAS pre-processing and the first step is TIN 

editing. TIN Editor Extension is used for editing of TIN’s contour lines. Basically, contour lines 

are extended within rivers (creeks). The criterion used in contour lines extension is to match the 

channel bottom elevation of surveyed UTRCA cross-sections. To achieve this task it is necessary 

to use UTRCA cross section shape files to determine the location of UTRCA cross-sections on 
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the map during the TIN editing process. Generally, elevations of newly generated contour lines 

are slightly above the channel bottom elevations of the UTRCA cross-sections. Process is so 

demanding that it was not possible to change contour elevation for every cross-section. This 

problem is addressed through cross-section editing in the HEC-RAS. Although it is possible to 

edit cross-sections directly in the HEC-RAS, TIN editing is necessary to provide for floodplain 

mapping. Without the extension of the TIN’s contour lines (TIN editing), floodplain lines would 

remain discontinued at many locations, especially in the case of smaller creeks.  

After the new TIN is created, attributes are assigned for GIS Layers (River, XS Cut Lines, 

Bridges, etc) as explained in the pre-processing. As mentioned earlier, use of the same contour 

line elevation for few cross sections in pre-processing resulted in an irregularity of the 

longitudinal profile. Longitudinal sections consisted of cross-sections with the same elevation. 

This problem is addressed by editing the cross-sections channel bottom elevations in the HEC-

RAS. From the Geometric Data window, Graphical Cross Sections Edit option is chosen from 

the Tools tab, to start the editing process. First, the editing of cross-sections, which have 

corresponding UTRCA (surveyed) cross-sections at the same locations, has been done. In order 

to increase the accuracy of HEC-RAS modelling and floodplain mapping for this project, more 

cross-sections are generated between the existing UTRCA cross-sections. Channel bottom 

elevations of these cross-sections are edited using the interpolation between 2 already edited 

cross sections. After the completion of this tedious task, the geometric data completion 

continues.  

Determination of bank points. In some cross sections, the bank stations are found to be 

improperly located. Some of them ended on the river bottom and some at different elevations. 

First, the HEC-RAS model is run with a small return period (2 or 5 yr of historic flows). Then 
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bank stations were corrected manually based on the water surface elevation results. The bank 

stations of surveyed UTRCA cross-sections, are also used to perform these manual corrections. 

Manning’s n values. Manning’s n values are part of the Geometry data required for HEC-

RAS modelling. Since UTRCA HEC-RAS models are from the 1980’s, revision of Manning’s n 

values is necessary. In some cases, a horizontal variation in n values is used to increase accuracy 

for Manning’s value.  For this project, Manning’s n values are adopted based on Chow (1959), 

Aerial photo (London50 RGB 2007) and n values from existing UTRCA HEC-RAS models. For 

residential areas, n = 0.08 - 0.12 is used, and for industrial areas, n = 0.1.  

Bridge data. The main source for Bridge Data (Deck/Roadway Data) is the existing set of 

UTRCA HEC-RAS models. The data for missing and newly built bridges are obtained from the 

City of London.  The appropriate placing of bridge cross-sections (four for each bridge) is 

explained in the pre-processing section. The bridge bounding cross-sections 2 and 3 are shown in 

Figure 2.23, below. 

 

Figure 2.23 Bridge bounding cross sections (after USACE 2006) 
  

HEC-RAS automatically adds two more cross sections, immediately inside the upstream (BU for 

bridge upstream) and downstream (BD for bridge downstream) bridge faces. These two new 
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cross sections appear in the Bridge/Culvert Data Editor window.  The bridge deck editor is used 

to describe the area that is blocked out by the bridge deck and road embankment. Since the 

difference in cross sections (HEC-GeoRAS cross sections and existing UTRCA cross sections) it 

is not possible to copy and paste bridge deck data. Stations data from the Deck/Roadway Data 

Editor (UTRCA HEC-RAS models) is manually adjusted to correspond to stations in HEC-

GeoRAS cross sections. This process was tedious, but the only solution for using bridge deck 

data from UTRCA HEC-RAS models. Especial difficulty is experienced for bridges under the 

slope and UTRCA bridge bounding cross sections surveyed in opposite directions.  

For missing bridges (not present in UTRCA HEC-RAS models), the bridge deck data is obtained 

from drawings and combined with extracted bridge deck elevations in pre-processing. Ne bridges 

are added to the model at the following locations:  

Main Branch of Thames River 

 Bridge 1 (Oxford St W) 

 Bridge 2 (Boler Rd) 

 Bridge 4 (Foot Bridge at Thames Valley Golf Course) 

 Bridge 5 (Wonderland Rd S) 

 Bridge 6 (Railway bridge at Greenway Park) 

North Branch of Thames River 

 Bridge 6 (Gibbons Park Foot Bridge) 

 Bridge 11 (Clarke Road) 

Pottersburg Creek 

 Bridge 4 

 Culvert 4 
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Dingman Creek and Tributaries 

 Dingman Creek (Reach 13)-Bridge 39 

 Tributary 13 (K)-Culvert 28 

 Tributary 12 (J)-Culvert 22 

 Tributary 10 (R)-Culvert 6 and Culvert 7 

In the existing UTRCA HEC-RAS for North Thames, two bridges at Richmond Street are 

modeled separately. In this study, these two bridges are modeled as one bridge because the 

distance between bridges is only about 1m and there is no contraction and expansion of flow 

between bridges. Bridge Geometry (bridge openings, high cord and low cord elevation, peers) is 

virtually identical for both bridges. 

It was observed that bridge 13 (Parkhurst Ave) on Pottersburg Creek is replaced with new 

bridge. A technical documentation for the new bridge is used for entering its geometric 

properties. Bridge geometry from UTRCA and UWO HEC-RAS models, and bridge photo, are 

shown in Figures 2.24, 2.25 and 2.26. 

 

Figure 2.24 Parkhurst Ave Bridge (after City of London) 
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Figure 2.25 Parkhurst Ave Bridge (UWO HEC-RAS) 

 

 

Figure 2.26 Parkhurst Ave Bridge (existing UTRCA HEC-RAS) 
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Data for the Wonderland Bridge on the Dingman Creek is used from the third sources, 

DELCAN HEC-RAS model, instead of UTRCA HEC-RAS model. The new bridge is 

constructed in the place of the old culvert and that change has not yet been incorporated in the 

existing UTRCA Dingman HEC-RAS model. 

The following bridge modeling approach is adopted for all bridges. For low flow 

conditions if bridge has no peers, energy (standard step) equation is used and if bridge has peers 

the Yarnell (class A only) calculation is implemented. For high flow conditions pressure and/or 

weir method is used for all bridges 

Levees. At some cross sections, levee option is used in HEC-RAS in order to correctly 

distribute flow between the river channel and the overbanks. This option is originally introduced 

to represent the existing levees (dikes). When levee is in place, no water can enter the floodplain 

until the levee elevation is exceeded (USACE, 2002 b). 

In the Medway HEC-RAS model developed in this study, the levee is set on the left side of 

the river (approximate length is 300 m) to represent a man-made vertical wall. Levee is set at 7 

cross sections. It starts at the cross section 739.48 m and ends at cross section 1031.450 m. 

Levees are also used for the cross sections with a lower elevation of overbank area. 

However, they are only used in cases where the overbank area could not convey flow until the 

channel is overtopped. Figures 2.2.7 and 2.28 show HEC-RAS results for a cross section with 

and without levee.  
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Figure 2.27 A cross section at the North Thames River with the levee 
 

 

 
 

Figure 2.28 A cross section at the North Thames River without the levee 
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Flow data and boundary conditions. The hydraulic analysis is performed using flow data 

for climate scenarios named: Historic Climate Scenario and Wet Climate Scenario. For both 

climate scenarios, steady flow data are entered for the flow return periods of 100- and 250-years. 

Flow changes are entered at the same locations as in the existing UTRCA HEC-RAS models. 

More information on climate and hydrologic modeling is provided in the report by Eum and 

Simonovic (2009).  

Since no observed flow data (Known Water Surface) is available, it was very important to 

choose appropriate Steady Flow Boundary Conditions. Usually, if there is no observed data, the 

normal depth is used. However, another approach for setting the boundary conditions is used in 

this study. First, the existing UTRCA HEC-RAS model “Thames River from Byron to 

Delaware” is run with new flow data for both climate scenarios and both return periods. The 

above mentioned HEC-RAS model is long enough (about 20 km) so the influence of boundary 

conditions at the first cross section do not affect the upstream results.  Then, the calculated 

surface water elevation at the last cross section, which is also the first cross section for the 

UTRCA HEC-RAS model “Main Branch of Thames River,” is used as boundary condition for 

the climate change calculations. Since the metric system is used, Known Water Surface is in 

meters. The last cross section of this model is at “Fork” – a location at which the North Thames 

and South Thames converge to form the Main Thames River. The model is then run with the 

climate change flow data and the results at the above mentioned cross section are used as 

boundary conditions for UTRCA HEC-RAS models: “North Thames” and “South Thames”. 

After these two models were run with the climate change flow data, boundary conditions are 

determined for each tributary. For example, results from the first downstream cross section 

(UTRCA Xs # 3.885) at the North Thames, after confluence with the Medway Creek, are used as 
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boundary conditions for the Medway Creek. Results for other creeks are determined in a similar 

fashion. Table 2.3 shows boundary conditions for all rivers and creeks, with the exception of the 

Dingman Creek.  The Dingman Creek model starts 12 km from the confluence with the main 

branch of the Thames River, and the boundary conditions could not be determined here.  Instead, 

a normal depth is used as the boundary condition for the Dingman Creek. 
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Table 2.3 Flow and boundary conditions 

North Thames 
 
Historic Climate Scenario Wet Climate Scenario 

Event 100 year 250 year 100 year 250 year 

Flow (m3/sec) 902.43 1031.54 1099.53 1258.11 

Boundary Conditions (m) 235.2 235.79 235.95 236.58 

South Thames Historic Climate Scenario Wet Climate Scenario 

Event 100 year 250 year 100 year 250 year 

Flow (m3/sec) 569.33 655.74 655.66 754.23 

Boundary Conditions (m) 235.2 235.79 235.78 236.58 

Main Thames Historic Climate Scenario Wet Climate Scenario 

Event 100 year 250 year 100 year 250 year 

Flow (m3/sec) 1414.98 1618.52 1658.24 1895.57 

Boundary Conditions (m) 225.61 226.12 226.22 226.77 

Medway Creek Historic Climate Scenario Wet Climate Scenario 

Event 100 year 250 year 100 year 250 year 

Flow (m3/sec) 70.96 80.58 72.14 83.96 

Boundary Conditions (m) 239.43 239.8 239.8 240.2 

Stoney Creek Historic Scenario Wet Climate Scenario 

Event 100 year 250 year 100 year 250 year 

Flow (m3/sec) 55.92 64.5 62.18 71.53 

Boundary Conditions (m) 242.51 242.73 242.87 243.14 

Mud Creek Historic Climate Scenario Wet Climate Scenario 

Event 100 year 250 year 100 year 250 year 

Flow (m3/sec) 9.4 10.81 10.23 11.72 

Boundary Conditions (m) 233.97 234.59 234.59 235.41 

Pottersburg Creek Historic  Climate Scenario Wet Climate Scenario 

Event 100 year 250 year 100 year 250 year 

Flow (m3/sec) 123.45 143.3 141.43 163.69 

Boundary Conditions (m) 241.99 242.3 242.3 242.62 
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As it can be seen from Table 2.3, the Main Thames River flow for the wet climate scenario and 

return period of 100 years is higher than the flow for the historic climate scenario and 250 years 

return period. Accordingly, the water surface elevation results at the last cross section of the 

Main Thames (located at “Fork”) follow the same pattern. The results at this cross section are 

used as boundary conditions for the North Thames and the South Thames. Since the South 

Thames 250-year flow for the historic climate scenario is slightly larger than the 100-year wet 

climate scenario flow, it is necessary to make an assumption about boundary conditions. The 

South Thames boundary conditions for 100 year wet climate scenario and 250 year historic 

climate scenario are equalized to avoid situations where the higher flow has a lower value for the 

boundary condition. Similar assumptions are used for the Medway Creek and the Mud Creek.   

HEC-RAS computation and data export. After the geometric data is completed and the 

steady flow data and new boundary conditions are entered, the HEC-RAS system is executed for 

the subcritical flow profile. The output results are checked for hydraulic correctness.  

The final step involves export of the computation results (water surface elevation) back to 

GIS. The following computational steps are used from the main HEC-RAS window: “File”ĺ 

“Export GIS Data”. In the GIS export window, all four profile results (for the four flow 

scenarios) are selected and exported using the default format “RASexport.sdf”. Figure 2.29 

shows the GIS Export window and the selected profiles used for export. 
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Figure 2.29 GIS export window in the HEC-RAS 
 

 
2.3. Post-processing of hydraulic results and floodplain mapping 

The post-processing of computation results is performed using the same maps which where 

used for the pre-processing of geometry data. The only additions to these maps are new map 

layers. The exceptions are made for the Dingman Creek and the Pottersburg Creek. For these, 

post-processing is performed using new maps. Due to the large area covered by the Dingman 

Creek, its post-processing  is quite complicated and requires the creation of a very large  TIN. 

Hardware limitations (when using resolution of 2 map units) required floodplain mapping of the 

Dingman Creek to be done using two maps.  Detailed explanation of the data post-processing 

follows.  
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2.3.1 Data import from HEC-RAS 

Formatting. The process starts with opening a desired ArcMap for post-processing. Since 

the HEC-GeoRAS cannot read the proprietary spatial data format (.RASExport.sdf) file created 

in the HEC-RAS, it is necessary to convert it into the XML file format, supported by HEC-

GeoRAS. This is achieved by selecting the “Import RAS SDF File” option from the HEC-Geo 

RAS Toolbar. 

Layer setup. Establishing the Layer Setup is a necessary step for processing the HEC-RAS 

results. In the Layer Setup window, the type of analysis and the input and output data are 

identified. Figure 2.30 shows a typical Layer Setup window from the data post-processing. For 

the post-processing analyses, the rasterization cell size is set to 2 map units. Basically, a smaller 

number of map units results in a better representation of the resulting floodplain boundary during 

the floodplain delineation. Since at some places (especially at the Dingman tributaries) the 

floodplain lines are too coarse, an attempt is made to rasterization cell size to 1 map unit. 

However, the program is not able to handle this resolution, and two map units are used as the 

best possible rasterization cell size. 
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Figure 2.30 Layer setup window 
 

 
Reading RAS GIS export file. After input data is entered in the layer setup, the HEC-RAS 

results have to be imported into the GIS in order to continue with the post-processing. The 

following computational steps are selected from the HEC-GeoRAS toolbar: “RAS Mapping”ĺ 

“Read RAS GIS Export File”. This selection introduces a new data frame with the following 

feature classes: River2D, XS Cut Lines, and Bounding Polygon.  

 

2.3.2 Floodplain mapping 

Floodplain mapping is performed using the water surface elevations on the XS cut lines, 

within the limits of the bounding polygon. Floodplain mapping is completed in two steps, which 

are explained in following paragraphs. 

Water surface TIN. The first step is to create a water surface TIN from the cross section 

water surface elevations. The following computational steps are selected from the HEC-GeoRAS 
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toolbar: “RAS Mapping”ĺ “Inundation Mapping”ĺ “Water Surface Generation”. All four 

water surface profiles are selected from the window, as shown in Figure 2.31. 

 

Figure 2.31 Selected water surface profiles for the water surface TIN generation 

 

For each selected water surface profile, a water surface TIN is created without consideration of 

the terrain model. The TIN is created using the ArcGIS triangulation method.  This allowed for 

the creation of a surface using cut lines as hard break lines with constant elevation. Also, areas 

which are of little interest are still included in the water surface TIN. These areas are removed in 

the process of delineation with the bounding polygon. Figure 2.32 shows the water surface TIN. 
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Figure 2.32 Water surface TIN (the Stoney Creek and Tributaries) 

 

Floodplain delineation. The following computational procedure is used from the HEC-

GeoRAS toolbar: “RAS Mapping”ĺ“InundationMapping”ĺ“Floodplain Delineation”ĺ“GRID 

Intersection”. Again, all four water surface profiles are selected from the window, Figure 2.33. 

The water surface TIN is converted into a grid based on the rasterization cell size. Then, it is 

compared with the TIN terrain model, which is also in grid format, allowing the elevation 

difference to be calculated within the bounding polygon. The areas with positive results (where 

water surface is higher than the terrain elevation) are included in the floodplain area (inundation 

depth grid), and the areas with negative results are considered as dry. The depth grid has prefix 

“d” (“d” is for depth) before the profile name, e.g. d 250 Historic. Then, the floodplain boundary 

feature class is created based on the depth grid. The flood boundary has prefix “b” (“b” is for 

boundary), before the profile name, e.g. b 250 Historic. The floodplain boundary and the depth 
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grid are added to the analysis map. The feature classes named b 100 Historic, b 100 Wet 

Scenario, b 250 Historic, and b 250 Wet Scenario represent the floodplain boundary feature 

classes on the analysis map. The grids d 100 Historic, d 100 Wet Scenario, d 250 Historic, and d 

250 Wet Scenario represent the water inundation depths within the delineated floodplains. 

 

Figure 2.33 Selected water surface profiles for the floodplain delineation 

 

Figure 2.34 shows floodplain results from the HEC-GeoRas model at one section of the 

Stoney Creek and Tributaries. The floodplain boundary (b 250 Wet Scenario) is represented by a 

yellow line. The inundation depth grid is represented with different hues of blue. The largest 

value of water depth is represented by a dark blue, and the smallest value of water depth is 

represented by a light blue. By using the “identify tool” button, water depth at any point can be 

easily identified. For example, in Figure 2.34, the arrow points to a water depth of 2.249m. More 

flood plain results are presented in the next chapter of the report.  
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Figure 2.34 Floodplain results for one section of the Stoney Creek 

 

2.3.3. Review and editing the floodplain results 

The first review step is to verify that the cross sections are wide enough to allow for the 

proper floodplain delineation. In the verification process it was noticed that at some location 

further extension of the cross sections is required. This ended up in the repetition of all steps for 

modified cross sections: assignment of new attributes, export of a new RAS GIS file to HEC-

RAS, running HEC-RAS, export of HEC-RAS results to ArcGIS, and the floodplain mapping.  

 Another problem is noticed in the floodplain delineation of levee areas close to the “Fork” 

(merging point of the North Thames and the South Thames). At some cross sections where levee 

points are not overtopped, the floodplain results are not satisfactory. The calculated dry areas 

pointed to another deficiency of the floodplain mapping process.  Figure 2.35 shows a typical 

The Inundation depth grid 

Floodplain Boundary 
(b 250 Wet Scenario) 
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problem in floodplain mapping at the Main Thames River. In the figure the dry area is pointed to 

by an arrow. The terrain close to the river at both bounding cross sections is high, and water 

could not overtop it.  Since terrain elevation of the dry area is lower then the water surface 

elevation at the upstream cross section, this area should be flooded.  

 

Figure 2.35 Problem in the floodplain mapping at the Main Thames 

 

The situation at the North Thames is even more severe than the situation at the Main 

Thames River. The first attempt at addressing this problem is tried at the level of the HEC-RAS. 

The area behind the levees at the North Thames and the Main Thames are modeled by using an 

ineffective option instead of the appropriate levee option. Also, an ineffective option is used in 

the existing UTRCA HEC-RAS modeling of the North Thames and the Main Thames. After re-

adjustment the floodplain results were slightly improved, but still not at an acceptable level. 

Consequently, it was necessary to manually edit the flood plain results at these locations. Figure 

2.36 shows the edited floodplain results at the same area. 

Inappropriate 
Floodplain Mapping 
(Dry Area) 
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Figure 2.36 Manually edited floodplain results at the Main Thames 

 

Another problem in the floodplain mapping is observed when the water surface elevations of two 

neighbouring cross sections were not within the same contour line (e.g. one cross section has WS 

= 235.9 m, and upstream cross section has WS = 236.15 m).  The floodplain line at some of these 

areas followed a straight line instead of following the more accurate contour line. These areas 

were carefully analyzed. As a result, some of them were manually edited while others, 

particularly those areas that fell within residential zones, were left unedited as areas of special 

concern. This problem is further discussed in the following chapter.     

 

3. RESULTS OF THE ANALYSES 

In this chapter final results obtained using the process presented in previous chapters are 

presented and discussed.  
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3.1 Results of hydraulic analyses 

HEC-RAS results consist of cross section water surface elevations for flows of 100 year 

and 250 year return periods for both, historic and wet climate scenarios. In addition to water 

surface elevations, values of other hydraulic parameters are available for each cross section from 

HEC-RAS outputs. These parameters include: flows, minimal channel elevation, channel 

velocity, flow area, and critical water surface.  HEC-RAS outputs are available in both, graphical 

and tabular form. In graphical form, HEC-RAS output can be viewed as water surface profiles, 

general profiles, rating curves, and X-Y-Z perspective plots.  

HEC-RAS results are presented in this Chapter in tabular form (Tables 3.1 to 3.8) for all 

rivers and creeks, including selected cross sections (at the beginning, in the middle, around the 

confluence, and at the end of the model) as illustration of modelling results. The detailed 

modelling output is available on the CD Rom attached to this report. HEC-RAS results are also 

presented for selected locations discussed in the floodplain mapping results.  

The table headings, not indicated by full names, are as follows: “River Sta” - river station 

of each cross section; “Q Total” - flow used for each climate scenario; “W.S. Elev” - water 

surface elevations; “Vel Chnl” - velocity in the channel; “Froude # Chl” - Froude number. 
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Table 3.1 HEC-RAS results for the Main Thames River 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Main Thames London 11187.99 250-Historic 1614.99 235.89 2.13 829.3 0.26 
Main Thames London 11187.99 250-Wet Scenario 1891.88 236.59 1.71 1777.24 0.2 
                  
Main Thames London 11106.89 250-Historic 1614.99 235.91 1.94 1053.63 0.24 
Main Thames London 11106.89 250-Wet Scenario 1891.88 236.6 1.53 2105.79 0.18 
                  
Main Thames London 10804.06 250-Historic 1614.99 235.77 2.09 796.09 0.26 
Main Thames London 10804.06 250-Wet Scenario 1891.88 236.34 2.24 873.19 0.27 
                  
Main Thames London 10790.83 250-Historic 1614.99 235.75 2.14 861.24 0.25 
Main Thames London 10790.83 250-Wet Scenario 1891.88 236.32 2.32 945.61 0.26 
                  
Main Thames London 10776.27   Bridge         
                  
Main Thames London 10760.14 250-Historic 1614.99 235.73 2.17 857.24 0.26 
Main Thames London 10760.14 250-Wet Scenario 1891.88 236.29 2.34 940.75 0.27 
                  
Main Thames London 10717.2 250-Historic 1614.99 235.57 2.62 693.42 0.31 
Main Thames London 10717.2 250-Wet Scenario 1891.88 236.32 2.22 1965.07 0.25 
                  
Main Thames London 10324.57 250-Historic 1614.99 235.48 2.29 980.95 0.27 
Main Thames London 10324.57 250-Wet Scenario 1891.88 236.1 2.42 1149.83 0.28 
                  
Main Thames London 9949.081 250-Historic 1614.99 235.44 1.9 1287.29 0.22 
Main Thames London 9949.081 250-Wet Scenario 1891.88 236.06 2.03 1436.76 0.23 
                  
Main Thames London 9670.926 250-Historic 1614.99 235.19 2.25 749.18 0.27 
Main Thames London 9670.926 250-Wet Scenario 1891.88 235.78 2.44 817.9 0.28 
                  
Main Thames London 9655.252   Bridge         
                  
Main Thames London 9640.715 250-Historic 1614.99 235.16 2.26 747.24 0.27 
Main Thames London 9640.715 250-Wet Scenario 1891.88 235.74 2.44 815.11 0.28 
                  
Main Thames London 9459.073 250-Historic 1614.99 235.29 0.96 4680.68 0.11 
Main Thames London 9459.073 250-Wet Scenario 1891.88 235.89 0.97 5500.8 0.11 
                  
Main Thames London 9292.102 250-Historic 1616.25 235.27 1.06 3419.84 0.12 
Main Thames London 9292.102 250-Wet Scenario 1892.72 235.87 1.1 3895.52 0.12 
                  
Main Thames London 8999.401 250-Historic 1616.25 234.99 2.26 795.86 0.27 
Main Thames London 8999.401 250-Wet Scenario 1892.72 235.56 2.41 907.79 0.28 
                  
Main Thames London 8597.229 250-Historic 1616.25 234.98 1.38 1952.69 0.16 
Main Thames London 8597.229 250-Wet Scenario 1892.72 235.58 1.4 2294.01 0.16 
                  
Main Thames London 8216.348 250-Historic 1617.55 234.88 1.61 1748.93 0.19 
Main Thames London 8216.348 250-Wet Scenario 1893.57 235.49 1.62 2054.87 0.18 
                  
Main Thames London 7845.231 250-Historic 1617.55 234.73 1.77 1116.42 0.21 
Main Thames London 7845.231 250-Wet Scenario 1893.57 235.32 1.88 1255.86 0.21 
                  
Main Thames London 7831.712 250-Historic 1617.55 234.74 1.67 1134.44 0.2 
Main Thames London 7831.712 250-Wet Scenario 1893.57 235.33 1.77 1263.61 0.2 
                  
Main Thames London 7809.424   Bridge         
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Table 3.1 HEC-RAS results for the Main Thames River-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Main Thames London 7793.904 250-Historic 1617.55 234.72 1.67 1129.49 0.2 
Main Thames London 7793.904 250-Wet Scenario 1893.57 235.31 1.77 1258.59 0.2 
                  
Main Thames London 7743.635 250-Historic 1617.55 234.67 1.77 1012.67 0.21 
Main Thames London 7743.635 250-Wet Scenario 1893.57 235.25 1.91 1110.9 0.21 
                  
Main Thames London 7066.157 250-Historic 1617.55 234.21 2.17 847.81 0.25 
Main Thames London 7066.157 250-Wet Scenario 1893.57 234.76 2.35 940.24 0.26 
                  
Main Thames London 6836.473 250-Historic 1617.55 234.06 2.38 802.71 0.27 
Main Thames London 6836.473 250-Wet Scenario 1893.57 234.59 2.55 889.3 0.28 
                  
Main Thames London 6661.459 250-Historic 1617.55 234.01 2.14 934.04 0.24 
Main Thames London 6661.459 250-Wet Scenario 1893.57 234.55 2.29 1037.79 0.25 
                  
Main Thames London 6649.045 250-Historic 1617.55 234 2.17 918.43 0.25 
Main Thames London 6649.045 250-Wet Scenario 1893.57 234.54 2.32 1019.21 0.26 
                  
Main Thames London 6644.485   Bridge         
                  
Main Thames London 6640.114 250-Historic 1617.55 233.98 2.17 914.81 0.25 
Main Thames London 6640.114 250-Wet Scenario 1893.57 234.52 2.33 1014.48 0.26 
                  
Main Thames London 6613.312 250-Historic 1617.55 233.97 2.13 918.57 0.25 
Main Thames London 6613.312 250-Wet Scenario 1893.57 234.51 2.28 1022.58 0.26 
                  
Main Thames London 5790.817 250-Historic 1617.55 233.41 2.53 745.58 0.3 
Main Thames London 5790.817 250-Wet Scenario 1893.57 233.9 2.7 847.87 0.31 
                  
Main Thames London 4951.774 250-Historic 1617.55 233.11 2.06 851.9 0.23 
Main Thames London 4951.774 250-Wet Scenario 1893.57 233.56 2.27 920.32 0.25 
                  
Main Thames London 4334.014 250-Historic 1617.55 232.9 1.95 899.13 0.21 
Main Thames London 4334.014 250-Wet Scenario 1893.57 233.33 2.16 957.16 0.23 
                  
Main Thames London 4316.46 250-Historic 1617.55 232.75 2.52 746.43 0.27 
Main Thames London 4316.46 250-Wet Scenario 1893.57 233.13 2.81 791.61 0.3 
                  
Main Thames London 4304.175   Bridge         
                  
Main Thames London 4292.937 250-Historic 1617.55 232.04 2.8 664.03 0.31 
Main Thames London 4292.937 250-Wet Scenario 1893.57 232.68 2.98 738.1 0.32 
                  
Main Thames London 4223.858 250-Historic 1617.55 232.14 1.6 1078.12 0.17 
Main Thames London 4223.858 250-Wet Scenario 1893.57 232.79 1.74 1173.53 0.18 
                  
Main Thames London 3712.046 250-Historic 1617.55 231.59 2.93 635.08 0.34 
Main Thames London 3712.046 250-Wet Scenario 1893.57 232.2 3.13 721.73 0.35 
                  
Main Thames London 3154.553 250-Historic 1615.88 231 3.07 721.66 0.35 
Main Thames London 3154.553 250-Wet Scenario 1892.22 231.6 3.29 798.87 0.36 
                  
Main Thames London 2778.377 250-Historic 1615.88 230.43 2.75 787.78 0.32 
Main Thames London 2778.377 250-Wet Scenario 1892.22 231.01 2.94 881.26 0.33 
                  
Main Thames London 2310.213 250-Historic 1615.88 229.79 2.61 834.72 0.3 
Main Thames London 2310.213 250-Wet Scenario 1892.22 230.36 2.79 926.83 0.31 
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Table 3.1 HEC-RAS results for the Main Thames River-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Main Thames London 2287.847   Bridge         
                  
Main Thames London 2267.38 250-Historic 1615.88 229.71 2.63 822.03 0.31 
Main Thames London 2267.38 250-Wet Scenario 1892.22 230.27 2.81 913.07 0.32 
                  
Main Thames London 2213.693 250-Historic 1615.88 229.57 2.84 763.33 0.34 
Main Thames London 2213.693 250-Wet Scenario 1892.22 230.13 3.02 858.28 0.35 
                  
Main Thames London 1880.584 250-Historic 1615.88 229.09 2.89 788.25 0.36 
Main Thames London 1880.584 250-Wet Scenario 1892.22 229.67 3 919.92 0.35 
                  
Main Thames London 1272.046 250-Historic 1615.88 228.25 2.58 767.8 0.33 
Main Thames London 1272.046 250-Wet Scenario 1892.22 228.85 2.71 876.49 0.33 
                  
Main Thames London 837.2055 250-Historic 1618.52 227.74 2.14 1255.88 0.27 
Main Thames London 837.2055 250-Wet Scenario 1895.57 228.39 2.23 1446.68 0.26 
                  
Main Thames London 379.1213 250-Historic 1618.52 226.71 3.68 714.27 0.45 
Main Thames London 379.1213 250-Wet Scenario 1895.57 227.32 3.89 804.78 0.46 
                  
Main Thames London 66.001 250-Historic 1618.52 226.12 3.24 619.27 0.43 
Main Thames London 66.001 250-Wet Scenario 1895.57 226.77 3.34 723.35 0.42 
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Table 3.2 HEC-RAS results for North Thames River 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
North Thames London 14281.62 250 Historic 962.38 254.23 2.16 494.19 0.35 
North Thames London 14281.62 250 Wet Scenario 1209.17 254.77 2.37 571.56 0.36 
                  
North Thames London 13878.6 250 Historic 962.38 253.33 3.21 338.29 0.54 
North Thames London 13878.6 250 Wet Scenario 1209.17 253.79 3.51 394.26 0.55 
                  
North Thames London 13770.4 250 Historic 962.38 253.15 3.01 435.68 0.47 
North Thames London 13770.4 250 Wet Scenario 1209.17 253.62 3.28 505.26 0.49 
                  
North Thames London 13370.82 250 Historic 962.38 251.96 4.1 359.54 0.64 

North Thames London 13370.82 250 Wet Scenario 1209.17 252.52 4.19 465.08 0.61 
                  
North Thames London 13357.21 250 Historic 962.38 252.05 3.04 354.42 0.47 
North Thames London 13357.21 250 Wet Scenario 1209.17 252.55 3.36 409.72 0.49 
                  
North Thames London 13335.14   Bridge         
                  
North Thames London 13318.85 250 Historic 962.38 251.83 3.22 330.04 0.51 
North Thames London 13318.85 250 Wet Scenario 1209.17 252.29 3.59 380.16 0.54 
                  
North Thames London 13303.81 250 Historic 962.38 251.81 2.8 442.05 0.44 
North Thames London 13303.81 250 Wet Scenario 1209.17 252.3 2.98 539.43 0.45 
                  
North Thames London 12719.86 250 Historic 962.38 250.85 2.79 593.34 0.42 
North Thames London 12719.86 250 Wet Scenario 1209.17 251.45 2.8 750.4 0.39 
                  
North Thames London 11789.97 250 Historic 962.38 249.31 2.82 552.66 0.4 
North Thames London 11789.97 250 Wet Scenario 1209.17 250.02 2.89 720.1 0.38 
                  
North Thames London 11519.01 250 Historic 962.38 249.09 2.29 760.57 0.33 
North Thames London 11519.01 250 Wet Scenario 1209.17 249.85 2.33 981.06 0.31 
                  
North Thames London 10835.59 250 Historic 962.38 247.14 3.59 323.92 0.52 
North Thames London 10835.59 250 Wet Scenario 1209.17 247.71 3.99 374.71 0.55 
                  
North Thames London 10804.63 250 Historic 962.38 247.13 3.09 327.52 0.44 
North Thames London 10804.63 250 Wet Scenario 1209.17 247.7 3.46 370.82 0.47 
                  
North Thames London 10789.3   Bridge         
                  
North Thames London 10774.62 250 Historic 962.38 246.96 3.06 314.53 0.48 
North Thames London 10774.62 250 Wet Scenario 1209.17 247.49 3.4 355.2 0.51 
                  
North Thames London 10728.89 250 Historic 980.47 246.55 3.73 276.47 0.57 
North Thames London 10728.89 250 Wet Scenario 1229.68 246.93 4.28 304.25 0.62 
                  
North Thames London 9687.471 250 Historic 980.47 245.24 1.8 957.93 0.28 
North Thames London 9687.471 250 Wet Scenario 1229.68 245.6 1.93 1098.19 0.29 
                  
North Thames London 8976.408 250 Historic 980.47 244.19 1.54 1269.34 0.24 
North Thames London 8976.408 250 Wet Scenario 1229.68 244.46 1.6 1549.07 0.25 
                  
North Thames London 8297.666 250 Historic 980.47 243.76 1.22 1859.67 0.19 
North Thames London 8297.666 250 Wet Scenario 1229.68 244.06 1.29 2156.65 0.19 
                  
North Thames London 7604.849 250 Historic 980.47 243.62 1.06 2028.79 0.17 
North Thames London 7604.849 250 Wet Scenario 1229.68 243.92 1.11 2339.31 0.17 
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Table 3.2 HEC-RAS results for North Thames River-continued 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
North Thames London 7185.079 250 Historic 980.47 243.2 1.05 2214.08 0.16 
North Thames London 7185.079 250 Wet Scenario 1229.68 243.59 1.07 2678.84 0.16 
                  
North Thames London 6605.999 250 Historic 986.38 242.83 1.83 1123.12 0.29 
North Thames London 6605.999 250 Wet Scenario 1218.38 243.24 1.97 1413.83 0.3 
                  
North Thames London 6071.981 250 Historic 986.38 242.65 0.73 2696.68 0.11 
North Thames London 6071.981 250 Wet Scenario 1218.38 243.04 0.79 3135.01 0.12 
                  
North Thames London 5836.176 250 Historic 986.38 242.3 2.09 916.29 0.31 
North Thames London 5836.176 250 Wet Scenario 1218.38 242.68 2.15 1097.86 0.31 
                  
North Thames London 5232.017 250 Historic 986.38 241.63 1.99 1256.94 0.29 
North Thames London 5232.017 250 Wet Scenario 1218.38 241.95 2.12 1464.09 0.3 
                  
North Thames London 4713.349 250 Historic 986.38 240.87 2.02 912.44 0.28 
North Thames London 4713.349 250 Wet Scenario 1218.38 241.31 2.01 1249.99 0.26 
                  
North Thames London 4685.763 250 Historic 986.38 240.58 2.78 580.74 0.38 
North Thames London 4685.763 250 Wet Scenario 1218.38 241.05 2.76 875.22 0.36 
                  
North Thames London 4668.139   Bridge         
                  
North Thames London 4651.49 250 Historic 986.38 240.2 3.24 387.92 0.46 
North Thames London 4651.49 250 Wet Scenario 1218.38 240.75 3.17 672.27 0.43 
                  
North Thames London 4638.355 250 Historic 986.38 240.22 2.88 564.56 0.42 
North Thames London 4638.355 250 Wet Scenario 1218.38 240.78 2.58 899.58 0.35 
                  
North Thames London 4526.357 250 Historic 986.38 240.02 2.04 1105.77 0.29 
North Thames London 4526.357 250 Wet Scenario 1218.38 240.59 1.9 1510.15 0.26 
                  
North Thames London 4432.608 250 Historic 986.38 239.98 1.43 1378.09 0.19 
North Thames London 4432.608 250 Wet Scenario 1218.38 240.56 1.44 1763.64 0.19 
                  
North Thames London 4364.224 250 Historic 1031.54 239.95 1.11 1530.35 0.16 
North Thames London 4364.224 250 Wet Scenario 1258.11 240.53 1.12 1910.92 0.15 
                  
North Thames London 4212.356 250 Historic 1031.54 239.83 1.62 1166.31 0.22 
North Thames London 4212.356 250 Wet Scenario 1258.11 240.44 1.58 1455.75 0.2 
                  
North Thames London 3902.892 250 Historic 1031.54 239.4 2.42 654.33 0.33 
North Thames London 3902.892 250 Wet Scenario 1258.11 240.05 2.45 811.11 0.31 
                  
North Thames London 3862.952 250 Historic 1031.54 239.34 2.21 467.18 0.31 
North Thames London 3862.952 250 Wet Scenario 1258.11 239.91 2.44 516.45 0.32 
                  
North Thames London 3856.491   Bridge         
                  
North Thames London 3849.061 250 Historic 1031.54 239.22 2.26 456.37 0.32 
North Thames London 3849.061 250 Wet Scenario 1258.11 239.73 2.52 500.72 0.34 
                  
North Thames London 3805.052 250 Historic 1031.54 239.18 2.46 641.65 0.33 
North Thames London 3805.052 250 Wet Scenario 1258.11 239.71 2.62 755.1 0.33 
                  
North Thames London 3456.593 250 Historic 1031.54 238.85 1.79 1102.95 0.23 
North Thames London 3456.593 250 Wet Scenario 1258.11 239.38 1.87 1309.75 0.23 
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Table 3.2 HEC-RAS results for North Thames River-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
North Thames London 3032.41 250 Historic 1031.54 238.31 2.43 820.49 0.31 
North Thames London 3032.41 250 Wet Scenario 1258.11 238.86 2.46 1042.75 0.3 
                  
North Thames London 2990.473 250 Historic 1031.54 238.28 2.32 863.72 0.3 
North Thames London 2990.473 250 Wet Scenario 1258.11 238.84 2.35 1107.05 0.29 
                  
North Thames London 2202.025 250 Historic 1031.54 237.54 1.6 1136.81 0.23 
North Thames London 2202.025 250 Wet Scenario 1258.11 238.11 1.58 1453.17 0.21 
                  
North Thames London 2190.01 250 Historic 1031.54 237.52 1.65 1067.33 0.23 
North Thames London 2190.01 250 Wet Scenario 1258.11 238.1 1.63 1394.72 0.22 
                  
North Thames London 2181.51   Bridge         
                  
North Thames London 2172.707 250 Historic 1031.54 237.5 1.67 1053.84 0.24 
North Thames London 2172.707 250 Wet Scenario 1258.11 238.06 1.65 1374.7 0.22 
                  
North Thames London 2130.325 250 Historic 1031.54 237.51 1.24 1484.27 0.17 
North Thames London 2130.325 250 Wet Scenario 1258.11 238.07 1.27 1832.54 0.16 
                  
North Thames London 1944.315 250 Historic 1031.54 237.45 1.23 1125.55 0.16 
North Thames London 1944.315 250 Wet Scenario 1258.11 238 1.34 1280.49 0.16 
                  
North Thames London 1657.939 250 Historic 1031.54 237.19 1.79 748.2 0.24 
North Thames London 1657.939 250 Wet Scenario 1258.11 237.72 1.92 902.29 0.25 
                  
North Thames London 1469.137 250 Historic 1031.54 237.11 1.47 1033.23 0.2 
North Thames London 1469.137 250 Wet Scenario 1258.11 237.63 1.54 1382.83 0.2 
                  
North Thames London 1464.37 250 Historic 1031.54 237.11 1.47 1031.42 0.21 
North Thames London 1464.37 250 Wet Scenario 1258.11 237.62 1.53 1378.75 0.21 
                  
North Thames London 1453.371   Bridge         
                  
North Thames London 1437.962 250 Historic 1031.54 237.08 1.48 1012.54 0.21 
North Thames London 1437.962 250 Wet Scenario 1258.11 237.6 1.54 1365.56 0.21 
                  
North Thames London 1395.448 250 Historic 1031.54 236.89 2.17 490.27 0.3 
North Thames London 1395.448 250 Wet Scenario 1258.11 237.49 2.04 1228.54 0.27 
                  
North Thames London 934.5929 250 Historic 1031.54 236.3 2.86 369.55 0.43 
North Thames London 934.5929 250 Wet Scenario 1258.11 237.5 0.89 3296.37 0.12 
                  
North Thames London 897.6954 250 Historic 1031.54 236.11 3.16 326.86 0.48 
North Thames London 897.6954 250 Wet Scenario 1258.11 236.77 3.34 376.3 0.48 
                  
North Thames London 890.2701   Bridge         
                  
North Thames London 883.0124 250 Historic 1031.54 236.06 3.18 323.89 0.49 
North Thames London 883.0124 250 Wet Scenario 1258.11 236.73 3.37 373.51 0.48 
                  
North Thames London 836.2322 250 Historic 1031.54 236 3 360.69 0.41 
North Thames London 836.2322 250 Wet Scenario 1258.11 236.99 1.09 2934.08 0.14 
                  
North Thames London 318.2535 250 Historic 1031.54 236.12 0.88 2629.29 0.11 
North Thames London 318.2535 250 Wet Scenario 1258.11 236.95 0.82 3428.04 0.1 
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Table 3.2 HEC-RAS results for North Thames River-continued 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
North Thames London 144.8874 250 Historic 1031.54 235.85 1.96 526.89 0.26 
North Thames London 144.8874 250 Wet Scenario 1258.11 236.62 2.11 597.41 0.27 
                  
North Thames London 34.75945 250 Historic 1031.54 235.79 1.76 637.23 0.21 
North Thames London 34.75945 250 Wet Scenario 1258.11 236.59 1.22 2832.61 0.14 
                  
North Thames London 10.38824 250 Historic 1031.54 235.79 1.69 657.91 0.22 
North Thames London 10.38824 250 Wet Scenario 1258.11 236.58 1.1 2952.58 0.14 
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Table 3.3 HEC-RAS results for the South Thames River 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
South Thames London 12890.16 250 Historic 637.78 245.77 1.59 604.03 0.28 
South Thames London 12890.16 250 Wet Scenario 734.39 246.04 1.65 690.07 0.28 
                  
South Thames London 12801.97 250 Historic 637.78 245.45 2.51 312.73 0.47 
South Thames London 12801.97 250 Wet Scenario 734.39 245.74 2.55 368.2 0.45 
                  
South Thames London 12743.45 250 Historic 637.78 245.34 2.46 262 0.44 
South Thames London 12743.45 250 Wet Scenario 734.39 245.57 2.64 282.72 0.46 
                  
South Thames London 12725.02   Bridge         
                  
South Thames London 12707.53 250 Historic 637.78 245.22 2.53 253.67 0.47 
South Thames London 12707.53 250 Wet Scenario 734.39 245.44 2.72 273.11 0.48 
                  
South Thames London 12638.9 250 Historic 637.78 245.21 1.87 414.87 0.35 
South Thames London 12638.9 250 Wet Scenario 734.39 245.45 1.95 464.82 0.35 
                  
South Thames London 11716.29 250 Historic 637.78 244.59 1.7 734.52 0.3 
South Thames London 11716.29 250 Wet Scenario 734.39 244.91 1.62 871.02 0.27 
                  
South Thames London 10994.08 250 Historic 637.78 244.29 1.29 974.57 0.22 
South Thames London 10994.08 250 Wet Scenario 734.39 244.66 1.28 1138.44 0.21 
                  
South Thames London 10666.53 250 Historic 637.78 243.99 1.98 568.79 0.34 
South Thames London 10666.53 250 Wet Scenario 734.39 244.44 1.85 760.22 0.3 
                  
South Thames London 10634.24 250 Historic 660.31 243.49 3.15 209.32 0.59 
South Thames London 10634.24 250 Wet Scenario 759.96 243.9 3.17 239.4 0.56 
                  
South Thames London 10621.59   Bridge         
                  
South Thames London 10608.59 250 Historic 660.31 243.4 3.26 202.42 0.62 
South Thames London 10608.59 250 Wet Scenario 759.96 243.66 3.44 220.81 0.63 
                  
South Thames London 10562.31 250 Historic 660.31 243.44 2.62 406.23 0.45 
South Thames London 10562.31 250 Wet Scenario 759.96 243.74 2.61 475.67 0.43 
                  
South Thames London 10130.95 250 Historic 660.31 243.04 2.33 439.57 0.38 
South Thames London 10130.95 250 Wet Scenario 759.96 243.31 2.47 495.76 0.39 
                  
South Thames London 9560.527 250 Historic 660.31 242.9 1.74 777.89 0.26 
South Thames London 9560.527 250 Wet Scenario 759.96 243.2 1.76 880.76 0.26 
                  
South Thames London 8993.381 250 Historic 660.31 242.57 1.67 682.89 0.27 
South Thames London 8993.381 250 Wet Scenario 759.96 242.88 1.71 770.2 0.26 
                  
South Thames London 8549.949 250 Historic 660.31 242.37 1.6 672.4 0.27 
South Thames London 8549.949 250 Wet Scenario 759.96 242.68 1.63 764.1 0.26 
                  
South Thames London 8166.684 250 Historic 660.31 241.97 2.13 396.04 0.35 
South Thames London 8166.684 250 Wet Scenario 759.96 242.32 2.15 514.85 0.34 
                  
South Thames London 8098.739 250 Historic 655.74 242.03 1.19 732.33 0.2 
South Thames London 8098.739 250 Wet Scenario 754.23 242.37 1.23 816.94 0.2 
                  
South Thames London 7265.864 250 Historic 655.74 241.31 2.01 326.39 0.33 
South Thames London 7265.864 250 Wet Scenario 754.23 241.65 2.12 356.41 0.33 
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Table 3.3 HEC-RAS results for the South Thames River-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
South Thames London 7257.464   Bridge         
                  
South Thames London 7250.436 250 Historic 655.74 241.29 2.02 324.07 0.34 
South Thames London 7250.436 250 Wet Scenario 754.23 241.63 2.13 353.87 0.34 
                  
South Thames London 6937.855 250 Historic 655.74 241.11 1.89 410.33 0.28 
South Thames London 6937.855 250 Wet Scenario 754.23 241.46 1.98 458.65 0.28 
                  
South Thames London 6908.513 250 Historic 655.74 240.97 2.29 286.51 0.37 
South Thames London 6908.513 250 Wet Scenario 754.23 241.3 2.42 311.38 0.38 
                  
South Thames London 6888.857   Bridge         
                  
South Thames London 6870.035 250 Historic 655.74 240.89 2.33 280.87 0.39 
South Thames London 6870.035 250 Wet Scenario 754.23 241.22 2.47 305.37 0.39 
                  
South Thames London 5839.856 250 Historic 655.74 240.1 1.45 614.85 0.22 
South Thames London 5839.856 250 Wet Scenario 754.23 240.49 1.45 713.88 0.21 
                  
South Thames London 5185.578 250 Historic 655.74 239.4 2.38 274.96 0.38 
South Thames London 5185.578 250 Wet Scenario 754.23 239.82 2.49 303.07 0.38 
                  
South Thames London 5172   Bridge         
                  
South Thames London 5155.075 250 Historic 655.74 239.31 2.45 267.97 0.39 
South Thames London 5155.075 250 Wet Scenario 754.23 239.73 2.55 295.9 0.39 
                  
South Thames London 4771.336 250 Historic 655.74 239.33 1.3 1009.51 0.2 
South Thames London 4771.336 250 Wet Scenario 754.23 239.78 1.28 1192.68 0.19 
                  
South Thames London 4419.571 250 Historic 655.74 239.22 1.19 938.25 0.19 
South Thames London 4419.571 250 Wet Scenario 754.23 239.68 1.17 1120.92 0.18 
                  
South Thames London 3766.49 250 Historic 655.74 239.04 1.59 474.24 0.26 
South Thames London 3766.49 250 Wet Scenario 754.23 239.51 1.57 611.49 0.25 
                  
South Thames London 3657.717 250 Historic 655.74 238.87 2.16 304.11 0.35 
South Thames London 3657.717 250 Wet Scenario 754.23 239.33 2.2 364.07 0.34 
                  
South Thames London 3640.421   Bridge         
                  
South Thames London 3628.674 250 Historic 655.74 238.81 2.2 298.49 0.36 
South Thames London 3628.674 250 Wet Scenario 754.23 239.26 2.24 352.54 0.35 
                  
South Thames London 3256.484 250 Historic 655.74 238.05 2.04 427.32 0.38 
South Thames London 3256.484 250 Wet Scenario 754.23 238.54 1.91 531.33 0.33 
                  
South Thames London 2963.955 250 Historic 655.74 238 1.89 693.05 0.29 
South Thames London 2963.955 250 Wet Scenario 754.23 238.5 1.79 892.06 0.26 
                  
South Thames London 2560.836 250 Historic 655.74 237.68 2.07 403.97 0.32 
South Thames London 2560.836 250 Wet Scenario 754.23 238.21 2.04 485.35 0.3 
                  
South Thames London 2419.805 250 Historic 655.74 237.57 2.22 317.26 0.34 
South Thames London 2419.805 250 Wet Scenario 754.23 238.09 2.25 389.25 0.33 
                  
South Thames London 2388.047 250 Historic 655.74 237.56 2.21 296.41 0.34 
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Table 3.3 HEC-RAS results for the South Thames River-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
South Thames London 2388.047 250 Wet Scenario 754.23 238.07 2.27 332.49 0.33 
                  
South Thames London 2369.654   Bridge         
                  
South Thames London 2355.203 250 Historic 655.74 237.55 2.21 296.18 0.34 
South Thames London 2355.203 250 Wet Scenario 754.23 238.06 2.27 332.24 0.33 
                  
South Thames London 2311.574 250 Historic 655.74 237.49 2.35 306.2 0.36 
South Thames London 2311.574 250 Wet Scenario 754.23 238.02 2.36 378.49 0.35 
                  
South Thames London 1499.458 250 Historic 655.74 236.69 2.51 265.5 0.36 
South Thames London 1499.458 250 Wet Scenario 754.23 237.38 2.52 313.55 0.34 
                  

South Thames London 1498.565   
Inl 
Struct         

                  
South Thames London 1497.378 250 Historic 655.74 236.6 2.57 259.1 0.37 
South Thames London 1497.378 250 Wet Scenario 754.23 237.3 2.56 307.04 0.35 
                  
South Thames London 990.1878 250 Historic 655.74 236.4 1.49 440.55 0.2 
South Thames London 990.1878 250 Wet Scenario 754.23 237.21 1.48 545.95 0.19 
                  
South Thames London 974.1994   Bridge         
                  
South Thames London 960.6936 250 Historic 655.74 236.39 1.5 438.91 0.2 
South Thames London 960.6936 250 Wet Scenario 754.23 237.11 1.52 532.2 0.19 
                  
South Thames London 510.4154 250 Historic 655.74 236 2.64 378.69 0.32 
South Thames London 510.4154 250 Wet Scenario 754.23 236.78 2.61 597.35 0.3 
                  
South Thames London 491.168   Bridge         
                  
South Thames London 474.097 250 Historic 655.74 236 2.27 415.32 0.28 
South Thames London 474.097 250 Wet Scenario 754.23 236.85 2.15 650.63 0.25 
                  
South Thames London 302.2231 250 Historic 655.74 235.68 2.99 247 0.37 
South Thames London 302.2231 250 Wet Scenario 754.23 236.46 3.06 294.16 0.36 
                  
South Thames London 129.4887 250 Historic 655.74 235.66 2.28 319.49 0.28 
South Thames London 129.4887 250 Wet Scenario 754.23 236.44 2.34 367.32 0.27 
                  
South Thames London 123.6912   Bridge         
                  
South Thames London 117.2749 250 Historic 655.74 235.65 2.28 319.97 0.28 
South Thames London 117.2749 250 Wet Scenario 754.23 236.43 2.34 367.59 0.27 
                  
South Thames London 45.02997 250 Historic 655.74 235.75 1.34 781.31 0.16 
South Thames London 45.02997 250 Wet Scenario 754.23 236.55 1.29 1033.21 0.15 
                  
South Thames London 1.273638 250 Historic 655.74 235.79 0.63 1319.2 0.09 
South Thames London 1.273638 250 Wet Scenario 754.23 236.58 0.62 1580.46 0.08 
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Table 3.4 HEC-RAS results for the Medway Creek 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Medway Creek London 12534.02 250 Historic 75.56 262.6 0.24 309.18 0.04 
Medway Creek London 12534.02 250 Wet Scenario 78.05 262.62 0.25 310.44 0.04 
                  
Medway Creek London 12394 250 Historic 75.56 262.6 0.23 327.19 0.04 
Medway Creek London 12394 250 Wet Scenario 78.05 262.61 0.24 328.45 0.04 
                  
Medway Creek London 12337.73 250 Historic 75.56 262.5 1.07 59.95 0.69 
Medway Creek London 12337.73 250 Wet Scenario 78.05 262.52 1.1 62.27 0.69 
                  
Medway Creek London 12335.86   Inl Struct         
                  
Medway Creek London 12334.68 250 Historic 75.56 260.46 0.62 122.49 0.12 
Medway Creek London 12334.68 250 Wet Scenario 78.05 260.5 0.63 124.29 0.12 
                  
Medway Creek London 12270.32 250 Historic 75.56 260.45 0.59 138.06 0.11 
Medway Creek London 12270.32 250 Wet Scenario 78.05 260.49 0.6 140.61 0.12 
                  
Medway Creek London 12243.58 250 Historic 75.56 260.38 1.15 65.91 0.25 
Medway Creek London 12243.58 250 Wet Scenario 78.05 260.41 1.16 67.13 0.25 
                  
Medway Creek London 12230.78   Bridge         
                  
Medway Creek London 12211.96 250 Historic 75.56 260.37 1.15 65.58 0.25 
Medway Creek London 12211.96 250 Wet Scenario 78.05 260.4 1.17 66.79 0.26 
                  
Medway Creek London 11928.78 250 Historic 75.56 259.85 1.97 43.17 0.42 
Medway Creek London 11928.78 250 Wet Scenario 78.05 259.88 2.01 43.76 0.43 
                  
Medway Creek London 11053.9 250 Historic 75.56 258.36 0.85 88.65 0.19 
Medway Creek London 11053.9 250 Wet Scenario 78.05 258.37 0.87 89.32 0.2 
                  
Medway Creek London 11044.33   Bridge         
                  
Medway Creek London 11030.45 250 Historic 75.56 258.36 0.85 88.6 0.19 
Medway Creek London 11030.45 250 Wet Scenario 78.05 258.37 0.87 89.25 0.2 
                  
Medway Creek London 10579.32 250 Historic 75.56 257.91 0.83 171.56 0.23 
Medway Creek London 10579.32 250 Wet Scenario 78.05 257.93 0.84 175.76 0.23 
                  
Medway Creek London 9633.082 250 Historic 75.56 257.2 0.63 258 0.14 
Medway Creek London 9633.082 250 Wet Scenario 78.05 257.23 0.63 264.13 0.14 
                  
Medway Creek London 9396.282 250 Historic 75.56 256.91 1.08 97.16 0.24 
Medway Creek London 9396.282 250 Wet Scenario 78.05 256.94 1.09 99.47 0.24 
                  
Medway Creek London 9352.544 250 Historic 75.56 256.78 1.59 72.35 0.32 
Medway Creek London 9352.544 250 Wet Scenario 78.05 256.81 1.61 73.94 0.32 
                  
Medway Creek London 9157.174   Bridge         
                  
Medway Creek London 9156.027 250 Historic 75.56 256.51 1.51 68.52 0.34 
Medway Creek London 9156.027 250 Wet Scenario 78.05 256.53 1.53 70.37 0.34 
                  
Medway Creek London 8800.228 250 Historic 75.56 256.26 0.74 176.55 0.16 
Medway Creek London 8800.228 250 Wet Scenario 78.05 256.28 0.74 181.7 0.15 
                  
Medway Creek London 8776.636 250 Historic 75.56 256.25 0.45 275.85 0.1 
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Table 3.4 HEC-RAS results for the Medway Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Medway Creek London 8776.636 250 Wet Scenario 78.05 256.28 0.45 283.42 0.1 
                  
Medway Creek London 8774.774   Bridge         
                  
Medway Creek London 8773.424 250 Historic 75.56 256.25 0.46 274.24 0.1 
Medway Creek London 8773.424 250 Wet Scenario 78.05 256.27 0.46 281.82 0.1 
                  
Medway Creek London 8507.261 250 Historic 75.56 256.07 1.4 54.05 0.31 
Medway Creek London 8507.261 250 Wet Scenario 78.05 256.09 1.43 54.63 0.31 
                  
Medway Creek London 8496.955   Bridge         
                  
Medway Creek London 8487.207 250 Historic 75.56 256.06 1.41 53.85 0.31 
Medway Creek London 8487.207 250 Wet Scenario 78.05 256.08 1.44 54.41 0.31 
                  
Medway Creek London 8172.843 250 Historic 77.34 255.37 0.91 154.64 0.21 
Medway Creek London 8172.843 250 Wet Scenario 79.94 255.39 0.91 159.54 0.21 
                  
Medway Creek London 7980.011 250 Historic 77.34 255.25 0.51 245.19 0.12 
Medway Creek London 7980.011 250 Wet Scenario 79.94 255.28 0.51 252.85 0.12 
                  
Medway Creek London 7429.214 250 Historic 77.34 254.97 0.75 185.55 0.16 
Medway Creek London 7429.214 250 Wet Scenario 79.94 255 0.76 189.93 0.16 
                  
Medway Creek London 6743.273 250 Historic 77.34 254.11 0.72 157.7 0.18 
Medway Creek London 6743.273 250 Wet Scenario 79.94 254.14 0.72 161.38 0.18 
                  
Medway Creek London 6038.008 250 Historic 77.34 253.11 0.78 179.54 0.17 
Medway Creek London 6038.008 250 Wet Scenario 79.94 253.14 0.78 184.12 0.17 
                  
Medway Creek London 5758.905 250 Historic 77.34 252.73 1.37 56.28 0.36 
Medway Creek London 5758.905 250 Wet Scenario 79.94 252.76 1.39 57.42 0.36 
                  
Medway Creek London 5738.844   Bridge         
                  
Medway Creek London 5720.785 250 Historic 77.34 252.71 1.39 55.69 0.36 
Medway Creek London 5720.785 250 Wet Scenario 79.94 252.74 1.41 56.8 0.36 
                  
Medway Creek London 5207.577 250 Historic 77.34 251.92 1.4 80.47 0.34 
Medway Creek London 5207.577 250 Wet Scenario 79.94 251.95 1.41 83 0.34 
                  
Medway Creek London 4658.275 250 Historic 77.34 250.93 1.49 109.89 0.36 
Medway Creek London 4658.275 250 Wet Scenario 79.94 250.94 1.52 112.5 0.37 
                  
Medway Creek London 4003.46 250 Historic 80.58 249.86 1.71 96.16 0.43 
Medway Creek London 4003.46 250 Wet Scenario 82.34 249.88 1.71 98.37 0.43 
                  
Medway Creek London 3593.942 250 Historic 80.58 248.68 1.23 110.44 0.32 
Medway Creek London 3593.942 250 Wet Scenario 82.34 248.7 1.23 113.1 0.31 
                  
Medway Creek London 2898.354 250 Historic 80.58 246.64 1.87 47.77 0.55 
Medway Creek London 2898.354 250 Wet Scenario 82.34 246.65 1.89 48.57 0.55 
                  
Medway Creek London 2502.589 250 Historic 82.92 245.72 1.45 76.35 0.35 
Medway Creek London 2502.589 250 Wet Scenario 83.96 245.73 1.46 77.13 0.35 
                  
Medway Creek London 1866.711 250 Historic 82.92 243.16 3.1 37.49 0.87 
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Table 3.4 HEC-RAS results for the Medway Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Medway Creek London 1866.711 250 Wet Scenario 83.96 243.17 3.11 37.93 0.87 
                  
Medway Creek London 1533.288 250 Historic 82.92 242.21 2.32 42.86 0.68 
Medway Creek London 1533.288 250 Wet Scenario 83.96 242.22 2.35 43.29 0.69 
                  
Medway Creek London 1071.312 250 Historic 82.92 240.78 1.59 59.71 0.36 
Medway Creek London 1071.312 250 Wet Scenario 83.96 240.91 1.51 64.65 0.33 
                  
Medway Creek London 1045.327 250 Historic 82.92 240.7 1.65 50.28 0.41 
Medway Creek London 1045.327 250 Wet Scenario 83.96 240.84 1.53 54.71 0.38 
                  
Medway Creek London 1038.507   Bridge         
                  
Medway Creek London 1031.45 250 Historic 82.92 240.66 1.69 49 0.42 
Medway Creek London 1031.45 250 Wet Scenario 83.96 240.81 1.57 53.62 0.39 
                  
Medway Creek London 956.9636 250 Historic 82.92 240.52 1.68 56.75 0.35 
Medway Creek London 956.9636 250 Wet Scenario 83.96 240.7 1.53 63.35 0.31 
                  
Medway Creek London 836.889 250 Historic 82.92 240.16 1.77 48.84 0.39 
Medway Creek London 836.889 250 Wet Scenario 83.96 240.45 1.56 56.58 0.32 
                  
Medway Creek London 772.637 250 Historic 82.92 240.11 1.43 63.23 0.31 
Medway Creek London 772.637 250 Wet Scenario 83.96 240.43 1.24 75.3 0.25 
                  
Medway Creek London 739.4892 250 Historic 82.92 240.1 1.16 71.5 0.24 
Medway Creek London 739.4892 250 Wet Scenario 83.96 240.42 1.03 81.16 0.2 
                  
Medway Creek London 732.3555   Bridge         
                  
Medway Creek London 594.7961 250 Historic 82.92 239.96 1.27 65.15 0.27 
Medway Creek London 594.7961 250 Wet Scenario 83.96 240.33 1.1 76.2 0.22 
                  
Medway Creek London 584.8447   Bridge         
                  
Medway Creek London 573.3849 250 Historic 82.92 239.94 1.29 64.51 0.27 
Medway Creek London 573.3849 250 Wet Scenario 83.96 240.32 1.11 75.78 0.22 
                  
Medway Creek London 328.9676 250 Historic 82.92 239.8 0.89 180.47 0.15 
Medway Creek London 328.9676 250 Wet Scenario 83.96 240.2 0.61 261.68 0.1 
                  
Medway Creek London 46.51068 250 Historic 82.92 239.8 0.24 580.77 0.04 
Medway Creek London 46.51068 250 Wet Scenario 83.96 240.2 0.19 713.06 0.03 
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Table 3.5 HEC-RAS results for the Pottersburg Creek 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Pottersburg Cr London 14213.43 250 Historic 39.3 274.5 0.98 118.14 0.2 
Pottersburg Cr London 14213.43 250 Wet Scenario 46.63 274.56 1.01 131.58 0.2 
                  
Pottersburg Cr London 13917.92 250 Historic 39.3 274.17 1.72 59.66 0.35 
Pottersburg Cr London 13917.92 250 Wet Scenario 46.63 274.26 1.66 77.4 0.33 
                  
Pottersburg Cr London 13087 250 Historic 39.3 273.52 1.13 80.31 0.23 
Pottersburg Cr London 13087 250 Wet Scenario 46.63 273.63 1.12 95.5 0.22 
                  
Pottersburg Cr London 12845.15 250 Historic 39.3 272.83 1.43 68.34 0.28 
Pottersburg Cr London 12845.15 250 Wet Scenario 46.63 272.94 1.46 81.14 0.27 
                  
Pottersburg Cr London 12020.39 250 Historic 39.3 271.26 2.97 22.37 0.64 
Pottersburg Cr London 12020.39 250 Wet Scenario 46.63 271.65 2.22 47.36 0.44 
                  
Pottersburg Cr London 11736.32 250 Historic 39.3 271.18 1.49 26.38 0.33 
Pottersburg Cr London 11736.32 250 Wet Scenario 46.63 271.51 1.53 30.47 0.31 
                  
Pottersburg Cr London 11562.04   Bridge         
                  
Pottersburg Cr London 11390.69 250 Historic 39.3 271.17 1.29 30.52 0.28 
Pottersburg Cr London 11390.69 250 Wet Scenario 46.63 271.25 1.47 31.63 0.31 
                  
Pottersburg Cr London 10999.37 250 Historic 39.3 271.15 0.24 415.08 0.04 
Pottersburg Cr London 10999.37 250 Wet Scenario 46.63 271.23 0.25 451.73 0.05 
                  
Pottersburg Cr London 10705.16 250 Historic 39.3 270.66 1.89 20.84 0.37 
Pottersburg Cr London 10705.16 250 Wet Scenario 46.63 270.73 2.18 21.4 0.42 
                  
Pottersburg Cr London 10403.58 250 Historic 39.3 270.3 1.73 48.7 0.35 
Pottersburg Cr London 10403.58 250 Wet Scenario 46.63 270.32 1.98 51.3 0.4 
                  
Pottersburg Cr London 10391.58   Culvert         
                  
Pottersburg Cr London 10379.76 250 Historic 39.3 270.14 1.37 46.39 0.29 
Pottersburg Cr London 10379.76 250 Wet Scenario 46.63 270.26 1.43 59.85 0.29 
                  
Pottersburg Cr London 9945.8 250 Historic 39.3 269.48 1.06 62.5 0.26 
Pottersburg Cr London 9945.8 250 Wet Scenario 46.63 269.59 1.11 72.24 0.27 
                  
Pottersburg Cr London 9600.814 250 Historic 87.22 269.48 0.51 433.86 0.1 
Pottersburg Cr London 9600.814 250 Wet Scenario 101.01 269.59 0.51 492.4 0.1 
                  
Pottersburg Cr London 9336.81 250 Historic 87.22 269.38 0.73 348.5 0.14 
Pottersburg Cr London 9336.81 250 Wet Scenario 101.01 269.5 0.71 398.84 0.13 
                  
Pottersburg Cr London 9196.486 250 Historic 87.22 269.37 0.57 431.79 0.11 
Pottersburg Cr London 9196.486 250 Wet Scenario 101.01 269.49 0.56 492.1 0.1 
                  
Pottersburg Cr London 9179.952   Bridge         
                  
Pottersburg Cr London 9169.085 250 Historic 87.22 269.31 0.62 404.33 0.12 
Pottersburg Cr London 9169.085 250 Wet Scenario 101.01 269.46 0.58 478.08 0.11 
                  
Pottersburg Cr London 9129.323 250 Historic 87.22 269.31 0.51 366.68 0.1 
Pottersburg Cr London 9129.323 250 Wet Scenario 101.01 269.45 0.51 425.82 0.1 
                  



- 91 - 
 

Table 3.5 HEC-RAS results for the Pottersburg Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Pottersburg Cr London 8787.067 250 Historic 87.22 269.06 1.13 196.74 0.23 
Pottersburg Cr London 8787.067 250 Wet Scenario 101.01 269.29 0.93 267.3 0.18 
                  
Pottersburg Cr London 8767.1 250 Historic 87.22 269.05 1.03 259.28 0.21 
Pottersburg Cr London 8767.1 250 Wet Scenario 101.01 269.28 0.84 377.18 0.16 
                  
Pottersburg Cr London 8755.028   Bridge         
                  
Pottersburg Cr London 8742.553 250 Historic 87.22 268.94 0.99 219.12 0.2 
Pottersburg Cr London 8742.553 250 Wet Scenario 101.01 269.21 0.93 338.81 0.18 
                  
Pottersburg Cr London 8719.361 250 Historic 87.22 268.89 1 190.31 0.21 
Pottersburg Cr London 8719.361 250 Wet Scenario 101.01 269.17 1.12 265.69 0.22 
                  
Pottersburg Cr London 7820.696 250 Historic 87.22 268.41 2.22 88.76 0.39 
Pottersburg Cr London 7820.696 250 Wet Scenario 101.01 268.76 2.03 119.38 0.34 
                  
Pottersburg Cr London 7593.461 250 Historic 87.22 265.89 0.53 307.31 0.13 
Pottersburg Cr London 7593.461 250 Wet Scenario 101.01 266.41 0.42 530.63 0.09 
                  
Potterrsburg Cr London 7377.505 250 Historic 87.22 265.82 0.67 201.67 0.15 
Potterrsburg Cr London 7377.505 250 Wet Scenario 101.01 266.38 0.5 315.98 0.1 
                  
Potterrsburg Cr London 6789.392 250 Historic 87.22 265.05 2.37 68.2 0.43 
Potterrsburg Cr London 6789.392 250 Wet Scenario 101.01 265.98 1.89 111.71 0.3 
                  
Pottersburg Cr London 6780.69 250 Historic 96.94 264.58 3.32 29.24 0.67 
Pottersburg Cr London 6780.69 250 Wet Scenario 111.93 265.76 2.61 42.96 0.43 
                  
Pottersburg Cr London 6766.895   Bridge         
                  
Pottersburg Cr London 6755.016 250 Historic 96.94 264.2 3.85 25.16 0.83 
Pottersburg Cr London 6755.016 250 Wet Scenario 111.93 264.38 4.11 27.22 0.86 
                  
Pottersburg Cr London 6361.93 250 Historic 96.94 264.1 1.34 153.91 0.24 
Pottersburg Cr London 6361.93 250 Wet Scenario 111.93 264.26 1.4 176.27 0.24 
                  
Pottersburg Cr London 6348.452   Bridge         
                  
Pottersburg Cr London 6335.22 250 Historic 96.94 264.03 1.43 143.94 0.26 
Pottersburg Cr London 6335.22 250 Wet Scenario 111.93 264.22 1.47 170.82 0.26 
                  
Pottersburg Cr London 5799.997 250 Historic 99.47 263.86 0.79 234.91 0.13 
Pottersburg Cr London 5799.997 250 Wet Scenario 114.22 264.05 0.77 266.02 0.12 
                  
Pottersburg Cr London 5473.485 250 Historic 99.47 261.95 2.42 137.72 0.45 
Pottersburg Cr London 5473.485 250 Wet Scenario 114.22 262.17 2.32 166.19 0.42 
                  
Pottersburg Cr London 4961.666 250 Historic 99.47 261.62 0.97 224.02 0.16 
Pottersburg Cr London 4961.666 250 Wet Scenario 114.22 261.87 0.94 266.56 0.15 
                  
Potterrsburg Cr London 4953.376   Bridge         
                  
Potterrsburg Cr London 4944.249 250 Historic 99.47 261.59 1.01 217.68 0.17 
Potterrsburg Cr London 4944.249 250 Wet Scenario 114.22 261.85 0.97 263.09 0.15 
                  
Pottersburg Cr London 4740.563 250 Historic 99.47 260.9 2.03 163.61 0.34 
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Table 3.5 HEC-RAS results for the Pottersburg Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Pottersburg Cr London 4740.563 250 Wet Scenario 114.22 261.03 1.99 191.28 0.33 
                  
Pottersburg Cr London 4588.74 250 Historic 99.47 260.78 2.21 137.76 0.36 
Pottersburg Cr London 4588.74 250 Wet Scenario 114.22 260.91 2.29 154.95 0.37 
                  
Pottersburg Cr London 4296.229 250 Historic 99.47 259.87 1.45 147.94 0.24 
Pottersburg Cr London 4296.229 250 Wet Scenario 114.22 259.97 1.5 167.92 0.24 
                  
Pottersburg Cr London 4028.238 250 Historic 99.47 259.58 1.43 162.41 0.21 
Potterrsburg Cr London 4028.238 250 Wet Scenario 114.22 259.67 1.45 180.11 0.21 
                  
Pottersburg Cr London 3383.662 250 Historic 99.47 259.58 0.72 343.09 0.1 
Pottersburg Cr London 3383.662 250 Wet Scenario 114.22 259.66 0.78 373.83 0.11 
                  
Pottersburg Cr London 3372.148   Bridge         
                  
Pottersburg Cr London 3361.717 250 Historic 99.47 259.53 0.74 328.95 0.11 
Potterrsburg Cr London 3361.717 250 Wet Scenario 114.22 259.63 0.8 360.17 0.11 
                  
Pottersburg Cr London 3008.501 250 Historic 99.47 259.53 0.22 1316.91 0.03 
Pottersburg Cr London 3008.501 250 Wet Scenario 114.22 259.63 0.23 1384.27 0.03 
                  
Pottersburg Cr London 2631.258 250 Historic 127.42 259.53 0.19 1512.22 0.02 
Pottersburg Cr London 2631.258 250 Wet Scenario 145.77 259.62 0.21 1606.56 0.02 
                  
Pottersburg Cr London 2619.492   Bridge         
                  
Pottersburg Cr London 2610.263 250 Historic 127.42 259.53 0.19 1511.6 0.02 
Pottersburg Cr London 2610.263 250 Wet Scenario 145.77 259.62 0.21 1605.82 0.02 
                  
Pottersburg Cr London 2272.463 250 Historic 127.42 259.52 0.13 2831.07 0.01 
Potterrsburg Cr London 2272.463 250 Wet Scenario 145.77 259.62 0.15 2919.18 0.02 
                  
Pottersburg Cr London 1805.415 250 Historic 127.42 259.52 0.34 1288.42 0.03 
Potterrsburg Cr London 1805.415 250 Wet Scenario 145.77 259.61 0.38 1316.83 0.04 
                  
Pottersburg Cr London 1787.191   Bridge         
                  
Pottersburg Cr London 1771.452 250 Historic 140.12 252.69 5.96 23.52 1 
Potterrsburg Cr London 1771.452 250 Wet Scenario 160.1 253.02 6.24 25.67 1 
                  
Pottersburg Cr London 1338.223 250 Historic 140.12 248.93 3.9 73.04 0.71 
Potterrsburg Cr London 1338.223 250 Wet Scenario 160.1 248.9 4.52 71 0.83 
                  
Pottersburg Cr London 1002.736 250 Historic 140.12 247.48 2.93 98.92 0.49 
Potterrsburg Cr London 1002.736 250 Wet Scenario 160.1 247.59 3.12 106.29 0.52 
                  
Pottersburg Cr London 710.4677 250 Historic 143.3 245.76 0.71 136.3 0.13 
Pottersburg Cr London 710.4677 250 Wet Scenario 163.69 246.22 0.57 175.57 0.1 
                  
Pottersburg Cr London 309.3382 250 Historic 143.3 242.48 3.3 102.38 0.67 
Pottersburg Cr London 309.3382 250 Wet Scenario 163.69 242.63 3.29 131.02 0.65 
                  
Pottersburg Cr London 64.53727 250 Historic 143.3 242.3 0.28 1443.65 0.05 
Pottersburg Cr London 64.53727 250 Wet Scenario 163.69 242.62 0.27 1700.54 0.04 
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Table 3.6 HEC-RAS results for the Stoney Creek 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Stoney Creek Upper Reach 10028.42 250 Historic 18.36 266.29 1.51 22.96 
Stoney Creek Upper Reach 10028.42 250 Wet Scenario 20.47 266.34 1.54 25.38 
                
Stoney Creek Upper Reach 9216.203 250 Historic 18.36 262.75 1.76 10.45 
Stoney Creek Upper Reach 9216.203 250 Wet Scenario 20.47 262.81 1.89 10.83 
                
Stoney Creek Upper Reach 9206.765   Culvert       
                
Stoney Creek Upper Reach 9199.002 250 Historic 18.36 262.61 1.97 9.33 
Stoney Creek Upper Reach 9199.002 250 Wet Scenario 20.47 262.61 2.18 9.38 
                
Stoney Creek Upper Reach 8750.41 250 Historic 19.81 260.62 1.08 26.3 
Stoney Creek Upper Reach 8750.41 250 Wet Scenario 22.09 260.66 1.13 28.62 
                
Stoney Creek Upper Reach 8469.355 250 Historic 19.81 259.74 0.83 49.38 
Stoney Creek Upper Reach 8469.355 250 Wet Scenario 22.09 259.8 0.84 54.52 
                
Stoney Creek Upper Reach 7986.903 250 Historic 19.81 258.49 0.66 62.58 
Stoney Creek Upper Reach 7986.903 250 Wet Scenario 22.09 258.52 0.69 66.32 
                
Stoney Creek Upper Reach 7106.365 250 Historic 19.81 257.29 1.5 23.9 
Stoney Creek Upper Reach 7106.365 250 Wet Scenario 22.09 257.33 1.52 27 
                
Stoney Creek Upper Reach 6565.449 250 Historic 27.37 256.44 0.78 57.66 
Stoney Creek Upper Reach 6565.449 250 Wet Scenario 30.56 256.54 0.72 69.39 
                
Stoney Creek Upper Reach 6369.594 250 Historic 27.37 256.41 0.26 156.57 
Stoney Creek Upper Reach 6369.594 250 Wet Scenario 30.56 256.51 0.25 178.02 
                
Stoney Creek Middle Reach 6242.931 250 Historic 47.72 256.34 1.02 89.3 
Stoney Creek Middle Reach 6242.931 250 Wet Scenario 52.2 256.45 1.01 101.34 
                
Stoney Creek Middle Reach 6226.208 250 Historic 47.72 256.05 2.33 20.5 
Stoney Creek Middle Reach 6226.208 250 Wet Scenario 52.2 256.13 2.42 21.59 
                
Stoney Creek Middle Reach 6217.025   Bridge       
                
Stoney Creek Middle Reach 6209.119 250 Historic 47.72 255.65 3.2 14.89 
Stoney Creek Middle Reach 6209.119 250 Wet Scenario 52.2 255.7 3.33 15.68 
                
Stoney Creek Middle Reach 5947.052 250 Historic 47.72 255.43 1.92 56.13 
Stoney Creek Middle Reach 5947.052 250 Wet Scenario 52.2 255.48 1.94 60.78 
                
Stoney Creek Middle Reach 5349.737 250 Historic 47.72 254.71 0.83 98.25 
Stoney Creek Middle Reach 5349.737 250 Wet Scenario 52.2 254.76 0.86 103.62 
                
Stoney Creek Middle Reach 4736.068 250 Historic 48.73 253.36 2.24 32.56 
Stoney Creek Middle Reach 4736.068 250 Wet Scenario 53.89 253.4 2.31 35.07 
                
Stoney Creek Middle Reach 4254.917 250 Historic 48.73 252.77 1.44 57.22 
Stoney Creek Middle Reach 4254.917 250 Wet Scenario 53.89 252.74 1.66 55.07 
                
Stoney Creek Middle Reach 3923.573 250 Historic 48.73 250.29 2.75 18.93 
Stoney Creek Middle Reach 3923.573 250 Wet Scenario 53.89 250.35 2.83 20.42 
                
Stoney Creek Middle Reach 3782.788 250 Historic 48.73 249.32 1.03 50.66 
Stoney Creek Middle Reach 3782.788 250 Wet Scenario 53.89 249.46 1.06 54.78 
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Table 3.6 HEC-RAS results for the Stoney Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Stoney Creek Middle Reach 3324.718 250 Historic 48.73 249.08 0.94 60.53 
Stoney Creek Middle Reach 3324.718 250 Wet Scenario 53.89 249.22 0.98 65.88 
                
Stoney Creek Middle Reach 3309.405 250 Historic 48.73 249.08 0.85 57.21 
Stoney Creek Middle Reach 3309.405 250 Wet Scenario 53.89 249.22 0.89 60.86 
                
Stoney Creek Middle Reach 3306.687   Bridge       
                
Stoney Creek Middle Reach 3303.389 250 Historic 48.73 249.08 0.85 57.43 
Stoney Creek Middle Reach 3303.389 250 Wet Scenario 53.89 249.21 0.88 60.99 
                
Stoney Creek Middle Reach 3295.009 250 Historic 48.73 249.07 0.92 62.45 
Stoney Creek Middle Reach 3295.009 250 Wet Scenario 53.89 249.2 0.96 67.98 
                
Stoney Creek Middle Reach 3019.428 250 Historic 48.73 248.99 1.01 57.01 
Stoney Creek Middle Reach 3019.428 250 Wet Scenario 53.89 249.12 1.07 77.23 
                
Stoney Creek Lower Reach 2881.127 250 Historic 59.16 248.83 1.41 55.75 
Stoney Creek Lower Reach 2881.127 250 Wet Scenario 65.65 248.95 1.47 60.38 
                
Stoney Creek Lower Reach 2708.136 250 Historic 59.16 248.76 1.01 58.84 
Stoney Creek Lower Reach 2708.136 250 Wet Scenario 65.65 248.88 1.05 62.48 
                
Stoney Creek Lower Reach 2694.901   Bridge       
                
Stoney Creek Lower Reach 2678.896 250 Historic 59.16 248.75 1.06 56.01 
Stoney Creek Lower Reach 2678.896 250 Wet Scenario 65.65 248.87 1.1 59.7 
                
Stoney Creek Lower Reach 2299.93 250 Historic 59.16 248.39 1.45 59.98 
Stoney Creek Lower Reach 2299.93 250 Wet Scenario 65.65 248.53 1.49 67.28 
                
Stoney Creek Lower Reach 1703.93 250 Historic 59.16 247.97 1.1 68.36 
Stoney Creek Lower Reach 1703.93 250 Wet Scenario 65.65 248.16 1.07 80.77 
                
Stoney Creek Lower Reach 1702.212   Bridge       
                
Stoney Creek Lower Reach 1700.905 250 Historic 59.16 247.6 1.55 45.82 
Stoney Creek Lower Reach 1700.905 250 Wet Scenario 65.65 247.69 1.59 50.38 
                
Stoney Creek Lower Reach 746.7147 250 Historic 64.5 242.97 0.62 228.05 
Stoney Creek Lower Reach 746.7147 250 Wet Scenario 71.53 243.22 0.59 266.89 
                
Stoney Creek Lower Reach 578.084 250 Historic 64.5 242.91 0.22 832.3 
Stoney Creek Lower Reach 578.084 250 Wet Scenario 71.53 243.17 0.2 1001 
                
Stoney Creek Lower Reach 427.6991 250 Historic 64.5 242.89 0.61 232.03 
Stoney Creek Lower Reach 427.6991 250 Wet Scenario 71.53 243.15 0.53 288.02 
                
Stoney Creek Lower Reach 420.5541   Bridge       
                
Stoney Creek Lower Reach 412.8342 250 Historic 64.5 242.87 0.79 227.9 
Stoney Creek Lower Reach 412.8342 250 Wet Scenario 71.53 243.14 0.71 290.21 
                
Stoney Creek Lower Reach 20.46021 250 Historic 64.5 242.87 0.12 874.62 
Stoney Creek Lower Reach 20.46021 250 Wet Scenario 71.53 243.14 0.13 947.2 
                
Ballymonte Drain Reach 1 2511.324 250 Historic 13.14 267.99 2.29 11.71 
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Table 3.6 HEC-RAS results for the Stoney Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Ballymonte Drain Reach 1 2511.324 250 Wet Scenario 14.41 267.99 2.53 11.61 
                
Ballymonte Drain Reach 1 2146.919 250 Historic 13.14 265.48 1.9 15.84 
Ballymonte Drain Reach 1 2146.919 250 Wet Scenario 14.41 265.51 1.84 17.8 
                
Ballymonte Drain Reach 1 1757.441 250 Historic 13.14 262.85 0.9 25.34 
Ballymonte Drain Reach 1 1757.441 250 Wet Scenario 14.41 262.88 0.95 26.62 
                
Ballymonte Drain Reach 1 1412.911 250 Historic 13.14 261.5 2.77 7.82 
Ballymonte Drain Reach 1 1412.911 250 Wet Scenario 14.41 261.52 2.91 8.21 
                
Ballymonte Drain Reach 1 1247.322 250 Historic 13.14 260.57 1.73 7.61 
Ballymonte Drain Reach 1 1247.322 250 Wet Scenario 14.41 260.7 1.75 8.25 
                
Ballymonte Drain Reach 1 1236.629   Culvert       
                
Ballymonte Drain Reach 1 1227.42 250 Historic 13.14 260.44 1.88 6.99 
Ballymonte Drain Reach 1 1227.42 250 Wet Scenario 14.41 260.55 1.93 7.49 
                
Ballymonte Drain Reach 1 992.8035 250 Historic 13.14 259.72 1.91 15.17 
Ballymonte Drain Reach 1 992.8035 250 Wet Scenario 14.41 259.73 2.04 15.51 
                
Ballymonte Drain Reach 1 524.5715 250 Historic 18.32 258.41 2.07 15.31 
Ballymonte Drain Reach 1 524.5715 250 Wet Scenario 20.1 258.62 1.69 20.68 
                
Ballymonte Drain Reach 1 281.2261 250 Historic 18.32 258.31 1.4 13.04 
Ballymonte Drain Reach 1 281.2261 250 Wet Scenario 20.1 258.49 1.45 13.87 
                
Ballymonte Drain Reach 1 268.6835   Culvert       
                
Ballymonte Drain Reach 1 256.5497 250 Historic 18.32 257.96 1.61 11.36 
Ballymonte Drain Reach 1 256.5497 250 Wet Scenario 20.1 258.04 1.71 11.77 
                
Ballymonte Drain Reach 1 180.6748 250 Historic 18.32 257.32 0.59 40.13 
Ballymonte Drain Reach 1 180.6748 250 Wet Scenario 20.1 257.39 0.59 44.46 
                
Ballymonte Drain Reach 1 27.50741 250 Historic 18.32 256.39 0.57 56.5 
Ballymonte Drain Reach 1 27.50741 250 Wet Scenario 20.1 256.49 0.52 67.72 
                
Powell Drain Upper Reach 1355.036 250 Historic 2.96 258.31 1.55 2 
Powell Drain Upper Reach 1355.036 250 Wet Scenario 3.31 258.33 1.64 2.12 
                
Powell Drain Upper Reach 1136.692 250 Historic 2.96 254.22 1.87 2.63 
Powell Drain Upper Reach 1136.692 250 Wet Scenario 3.31 254.23 1.98 2.78 
                
Powell Drain Upper Reach 896.1691 250 Historic 2.96 252.33 0.62 9.21 
Powell Drain Upper Reach 896.1691 250 Wet Scenario 3.31 252.35 0.64 10.01 
                
Powell Drain Upper Reach 687.2398 250 Historic 3.6 251.41 1.15 3.14 
Powell Drain Upper Reach 687.2398 250 Wet Scenario 4.02 251.5 1.2 3.34 
                
Powell Drain Upper Reach 659.3658   Culvert       
                
Powell Drain Upper Reach 640.0165 250 Historic 3.6 250.71 2.64 1.36 
Powell Drain Upper Reach 640.0165 250 Wet Scenario 4.02 250.77 2.73 1.47 
                
Powell Drain Upper Reach 460.996 250 Historic 3.6 249.08 0.51 7.86 



- 96 - 
 

Table 3.6 HEC-RAS results for the Stoney Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Powell Drain Upper Reach 460.996 250 Wet Scenario 4.02 249.2 0.5 8.98 
                
Powell Drain Upper Reach 283.5963 250 Historic 3.6 248.97 0.14 36.51 
Powell Drain Upper Reach 283.5963 250 Wet Scenario 4.02 249.11 0.14 41.12 
                
Powell Drain Upper Reach 282.5818 250 Historic 3.6 248.97 0.12 42.26 
Powell Drain Upper Reach 282.5818 250 Wet Scenario 4.02 249.11 0.12 47.11 
                
Powell Drain Lower Reach 269.5363 250 Historic 9.06 248.97 0.34 34.77 
Powell Drain Lower Reach 269.5363 250 Wet Scenario 10.13 249.11 0.34 38.24 
                
Powell Drain Lower Reach 213.9913 250 Historic 9.06 248.96 0.39 32.13 
Powell Drain Lower Reach 213.9913 250 Wet Scenario 10.13 249.1 0.4 35.62 
                
Powell Drain Lower Reach 199.4174 250 Historic 9.06 248.96 0.4 22.77 
Powell Drain Lower Reach 199.4174 250 Wet Scenario 10.13 249.1 0.41 24.43 
                
Powell Drain Lower Reach 192.1507   Bridge       
                
Powell Drain Lower Reach 184.5587 250 Historic 9.06 248.94 0.4 22.57 
Powell Drain Lower Reach 184.5587 250 Wet Scenario 10.13 249.08 0.42 24.17 
                
Powell Drain Lower Reach 172.5238 250 Historic 9.06 248.94 0.5 25.82 
Powell Drain Lower Reach 172.5238 250 Wet Scenario 10.13 249.08 0.51 28.39 
                
Powell Drain Lower Reach 60.04735 250 Historic 9.06 248.93 0.42 32.16 
Powell Drain Lower Reach 60.04735 250 Wet Scenario 10.13 249.07 0.47 38.94 
                
Northdale Drain Reach 1 1114.278 250 Historic 1.25 257.36 1.72 0.8 
Northdale Drain Reach 1 1114.278 250 Wet Scenario 1.39 257.39 1.78 0.87 
                
Northdale Drain Reach 1 966.8527 250 Historic 1.25 255.64 0.38 3.74 
Northdale Drain Reach 1 966.8527 250 Wet Scenario 1.39 255.67 0.4 3.98 
                
Northdale Drain Reach 1 931.9177 250 Historic 1.25 255.59 0.76 1.82 
Northdale Drain Reach 1 931.9177 250 Wet Scenario 1.39 255.61 0.8 1.92 
                
Northdale Drain Reach 1 758.9473 250 Historic 1.25 254.38 0.65 4.88 
Northdale Drain Reach 1 758.9473 250 Wet Scenario 1.39 254.4 0.68 5.18 
                
Northdale Drain Reach 1 457.1955 250 Historic 4.09 252.14 1.79 5.97 
Northdale Drain Reach 1 457.1955 250 Wet Scenario 4.57 252.14 1.92 6.18 
                
Northdale Drain Reach 1 265.3042 250 Historic 4.09 249.69 0.81 5.02 
Northdale Drain Reach 1 265.3042 250 Wet Scenario 4.57 249.75 0.86 5.29 
                
Northdale Drain Reach 1 254.4174   Bridge       
                
Northdale Drain Reach 1 242.3045 250 Historic 4.09 249.47 1.01 4.03 
Northdale Drain Reach 1 242.3045 250 Wet Scenario 4.57 249.52 1.08 4.24 
                
Northdale Drain Reach 1 174.2316 250 Historic 4.09 249.09 0.7 6.37 
Northdale Drain Reach 1 174.2316 250 Wet Scenario 4.57 249.19 0.65 7.74 
                
Northdale Drain Reach 1 51.28607 250 Historic 4.09 248.97 0.62 7.6 
Northdale Drain Reach 1 51.28607 250 Wet Scenario 4.57 249.11 0.55 9.55 
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Table 3.6 HEC-RAS results for the Stoney Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Northdale Drain Reach 1 51.18607 250 Historic 4.09 248.97 0.3 15.2 
Northdale Drain Reach 1 51.18607 250 Wet Scenario 4.57 249.11 0.3 17.13 
                
Northdale Drain Reach 1 18.44887 250 Historic 4.09 248.97 0.28 22.06 
Northdale Drain Reach 1 18.44887 250 Wet Scenario 4.57 249.11 0.27 25.79 
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Table 3.7 HEC-RAS results for the Dingman Creek 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Dingman Creek Reach 13 35235.36 250 Historic 32.31 269.8 1.84 25.52 
Dingman Creek Reach 13 35235.36 250 Wet Scenario 36.06 269.87 1.86 29.66 
                
Dingman Creek Reach 13 33798.37 250 Historic 32.31 267.41 1.77 37.19 
Dingman Creek Reach 13 33798.37 250 Wet Scenario 36.06 267.48 1.8 42.72 
                
Dingman Creek Reach 13 32914.46 250 Historic 32.31 265.75 1.41 25.77 
Dingman Creek Reach 13 32914.46 250 Wet Scenario 36.06 265.82 1.5 27.26 
                
Dingman Creek Reach 12 32757.15 250 Historic 48.48 265.72 0.78 98.8 
Dingman Creek Reach 12 32757.15 250 Wet Scenario 54.47 265.8 0.8 108.8 
                
Dingman Creek Reach 12 31610.83 250 Historic 48.48 264.82 0.67 173.46 
Dingman Creek Reach 12 31610.83 250 Wet Scenario 54.47 264.93 0.66 195.78 
                
Dingman Creek Reach 11 31417.08 250 Historic 72.99 264.83 0.2 753.21 
Dingman Creek Reach 11 31417.08 250 Wet Scenario 82.19 264.93 0.21 803.49 
                
Dingman Creek Reach 11 29624.61 250 Historic 83.28 264.54 1.67 96.06 
Dingman Creek Reach 11 29624.61 250 Wet Scenario 93.73 264.62 1.77 104.78 
                
Dingman Creek Reach 11 29619.85   Bridge       
                
Dingman Creek Reach 11 29615.87 250 Historic 83.28 264.22 2.53 32.95 
Dingman Creek Reach 11 29615.87 250 Wet Scenario 93.73 264.29 2.79 33.59 
                
Dingman Creek Reach 11 29179.73 250 Historic 83.53 263.58 1.98 66.86 
Dingman Creek Reach 11 29179.73 250 Wet Scenario 94.02 263.71 2.02 75.65 
                
Dingman Creek Reach 10 29098.12 250 Historic 77.24 263.59 1.25 104.94 
Dingman Creek Reach 10 29098.12 250 Wet Scenario 87.04 263.73 1.26 115.92 
                
Dingman Creek Reach 10 28323.04 250 Historic 83.09 262.88 1.61 96.51 
Dingman Creek Reach 10 28323.04 250 Wet Scenario 93.73 263 1.6 108.71 
                
Dingman Creek Reach 10 26350.68 250 Historic 87 261.87 0.87 190.82 
Dingman Creek Reach 10 26350.68 250 Wet Scenario 97.92 262.18 0.78 259.57 
                
Dingman Creek Reach 10 26342.14   Bridge       
                
Dingman Creek Reach 10 26335.16 250 Historic 87 261.79 1.03 176.72 
Dingman Creek Reach 10 26335.16 250 Wet Scenario 97.92 262.13 0.91 247.32 
                
Dingman Creek Reach 10 25735.1 250 Historic 87 260.48 2.75 54.18 
Dingman Creek Reach 10 25735.1 250 Wet Scenario 97.92 260.65 2.81 61.57 
                
Dingman Creek Reach 10 23276.36 250 Historic 101.78 258 0.83 281.68 
Dingman Creek Reach 10 23276.36 250 Wet Scenario 113.75 258.13 0.83 344.97 
                
Dingman Creek Reach 10 22693.54 250 Historic 101.78 257.58 1.57 136.56 
Dingman Creek Reach 10 22693.54 250 Wet Scenario 113.75 257.66 1.64 147.8 
                
Dingman Creek Reach 8 18900.88 250 Historic 123.29 254.21 1.51 211.38 
Dingman Creek Reach 8 18900.88 250 Wet Scenario 137.91 254.3 1.54 233.58 
                
Dingman Creek Reach 8 18398.32 250 Historic 123.29 253.88 0.91 462.58 
Dingman Creek Reach 8 18398.32 250 Wet Scenario 137.91 254.1 0.79 597.78 
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Table 3.7 HEC-RAS results for the Dingman Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Dingman Creek Reach 7 18147.96 250 Historic 130.98 253.87 0.32 837.82 
Dingman Creek Reach 7 18147.96 250 Wet Scenario 146.09 254.1 0.3 991.16 
                
Dingman Creek Reach 7 17883.05 250 Historic 130.98 253.87 0.33 814.18 
Dingman Creek Reach 7 17883.05 250 Wet Scenario 146.09 254.09 0.3 973.1 
                
Dingman Creek Reach 6 17717.42 250 Historic 131.45 253.86 0.35 740.19 
Dingman Creek Reach 6 17717.42 250 Wet Scenario 146.59 254.08 0.31 869.57 
                
Dingman Creek Reach 6 16691.8 250 Historic 131.45 253.21 1.48 305.04 
Dingman Creek Reach 6 16691.8 250 Wet Scenario 146.59 253.47 1.2 411.12 
                
Dingman Creek Reach 5 16598.71 250 Historic 130.6 253.2 0.96 413.52 
Dingman Creek Reach 5 16598.71 250 Wet Scenario 145.66 253.45 0.88 493.26 
                
Dingman Creek Reach 5 16565.42 250 Historic 130.6 253.19 1.01 421.01 
Dingman Creek Reach 5 16565.42 250 Wet Scenario 145.66 253.44 0.94 498.85 
                
Dingman Creek Reach 4 16328.61 250 Historic 129.34 253.06 1.78 248.5 
Dingman Creek Reach 4 16328.61 250 Wet Scenario 144.26 253.35 1.6 314.13 
                
Dingman Creek Reach 4 14539.36 250 Historic 128.45 252.58 1.79 71.67 
Dingman Creek Reach 4 14539.36 250 Wet Scenario 143.28 252.93 1.82 78.65 
                
Dingman Creek Reach 4 14526.73   Bridge       
                
Dingman Creek Reach 4 14515.18 250 Historic 128.45 252.3 1.78 72.07 
Dingman Creek Reach 4 14515.18 250 Wet Scenario 143.28 252.54 1.86 76.98 
                
Dingman Creek Reach 4 12864.36 250 Historic 128.01 252.21 0.62 562.27 
Dingman Creek Reach 4 12864.36 250 Wet Scenario 142.8 252.47 0.59 665.48 
                
Dingman Creek Reach 4 11725.65 250 Historic 128.01 251.67 1.24 389.95 
Dingman Creek Reach 4 11725.65 250 Wet Scenario 142.8 251.94 1.25 430.16 
                
Dingman Creek Reach 3 11556.95 250 Historic 127.46 251.63 1.29 372.81 
Dingman Creek Reach 3 11556.95 250 Wet Scenario 142.19 251.89 1.29 413.65 
                
Dingman Creek Reach 3 10250.11 250 Historic 127.4 250.75 1.56 154.99 
Dingman Creek Reach 3 10250.11 250 Wet Scenario 142.12 250.94 1.61 168.35 
                
Dingman Creek Reach 2 10155.01 250 Historic 130.52 250.61 1.98 148.62 
Dingman Creek Reach 2 10155.01 250 Wet Scenario 145.65 250.8 2.05 163.56 
                
Dingman Creek Reach 2 9415.808 250 Historic 130.52 249.81 2.15 100.37 
Dingman Creek Reach 2 9415.808 250 Wet Scenario 145.65 249.97 2.24 110.81 
                
Dingman Creek Reach 1 9249.62 250 Historic 134.1 249.79 1.49 198.01 
Dingman Creek Reach 1 9249.62 250 Wet Scenario 149.71 249.95 1.53 217.14 
                
Dingman Creek Reach 1 8018.647 250 Historic 134.1 248.73 2.25 122.04 
Dingman Creek Reach 1 8018.647 250 Wet Scenario 149.71 248.85 2.31 135.14 
                
Dingman Creek Reach 1 7170.537 250 Historic 134.1 247.91 2.11 146.82 
Dingman Creek Reach 1 7170.537 250 Wet Scenario 149.71 248.03 2.14 163.16 
                
Dingman Creek Reach 1 5726.107 250 Historic 134.1 246.14 2.38 56.44 
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Table 3.7 HEC-RAS results for the Dingman Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Dingman Creek Reach 1 5726.107 250 Wet Scenario 149.71 246.28 2.54 59.04 
                
Dingman Creek Reach 1 5718.255   Bridge       
                
Dingman Creek Reach 1 5712.288 250 Historic 138.2 246.11 2.48 55.79 
Dingman Creek Reach 1 5712.288 250 Wet Scenario 154.36 246.25 2.65 58.32 
                
Dingman Creek Reach 1 4146.032 250 Historic 138.2 243.6 1.98 209.53 
Dingman Creek Reach 1 4146.032 250 Wet Scenario 154.36 243.71 2.04 229.61 
                
Dingman Creek Reach 1 3104.552 250 Historic 140.73 241.69 2.29 140.15 
Dingman Creek Reach 1 3104.552 250 Wet Scenario 157.22 241.81 2.38 158.39 
                
Dingman Creek Reach 1 2137.112 250 Historic 140.73 239.28 2.93 110.08 
Dingman Creek Reach 1 2137.112 250 Wet Scenario 157.22 239.38 3.04 122.1 
                
Dingman Creek Reach 1 1458.81 250 Historic 140.73 236.92 3.52 41.97 
Dingman Creek Reach 1 1458.81 250 Wet Scenario 157.22 236.96 3.83 43.17 
                
Dingman Creek Reach 1 800.6564 250 Historic 140.73 234.99 3.11 78.49 
Dingman Creek Reach 1 800.6564 250 Wet Scenario 157.22 235.09 3.26 94.38 
                
Dingman Creek Reach 1 275.0753 250 Historic 140.73 234.2 1.51 192.4 
Dingman Creek Reach 1 275.0753 250 Wet Scenario 157.22 234.31 1.57 210.55 
                
Tributary 13 (K) Reach 1 3457.278 250 Historic 3.29 269.56 0.15 44.39 
Tributary 13 (K) Reach 1 3457.278 250 Wet Scenario 3.75 269.64 0.14 55.74 
                
Tributary 13 (K) Reach 1 3154.85 250 Historic 3.29 268.55 1.01 3.25 
Tributary 13 (K) Reach 1 3154.85 250 Wet Scenario 3.75 268.62 1.08 3.46 
                
Tributary 13 (K) Reach 1 3133.654   Culvert       
                
Tributary 13 (K) Reach 1 3110.776 250 Historic 3.29 268.47 1.09 3.01 
Tributary 13 (K) Reach 1 3110.776 250 Wet Scenario 3.75 268.53 1.18 3.19 
                
Tributary 13 (K) Reach 1 2339.263 250 Historic 3.29 268.22 0.42 19.3 
Tributary 13 (K) Reach 1 2339.263 250 Wet Scenario 3.75 268.28 0.39 27.84 
                
Tributary 13 (K) Reach 1 1499.36 250 Historic 3.29 267.53 0.52 9.7 
Tributary 13 (K) Reach 1 1499.36 250 Wet Scenario 3.75 267.62 0.52 11.87 
                
Tributary 13 (K) Reach 1 211.7297 250 Historic 3.29 265.77 1.29 3.92 
Tributary 13 (K) Reach 1 211.7297 250 Wet Scenario 3.75 265.85 1.3 4.53 
                
Tributary 12 (J) Reach 1 3098.65 250 Historic 4.2 273.67 0.05 233.9 
Tributary 12 (J) Reach 1 3098.65 250 Wet Scenario 4.7 273.68 0.06 235.3 
                
Tributary 12 (J) Reach 1 2316.435 250 Historic 4.2 268.39 0.44 14.18 
Tributary 12 (J) Reach 1 2316.435 250 Wet Scenario 4.7 268.48 0.44 18.61 
                
Tributary 12 (J) Reach 2 1080.846 250 Historic 11.29 269.7 1.96 5.78 
Tributary 12 (J) Reach 2 1080.846 250 Wet Scenario 12.63 269.79 2.1 6.03 
                
Tributary 12 (J) Reach 2 178.4853 250 Historic 11.29 268.47 0.87 15.89 
Tributary 12 (J) Reach 2 178.4853 250 Wet Scenario 12.63 268.56 0.89 18.23 
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Table 3.7 HEC-RAS results for the Dingman Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Tributary 12 (J) Reach 3 2213.149 250 Historic 19.86 268.08 2.01 13.75 
Tributary 12 (J) Reach 3 2213.149 250 Wet Scenario 22.23 268.17 2.05 17.75 
                
Tributary 12 (J) Reach 3 621.3592 250 Historic 28.49 267.1 2.24 12.72 
Tributary 12 (J) Reach 3 621.3592 250 Wet Scenario 31.87 267.44 0.98 79.28 
                
Tributary 12 (J) Reach 3 610.4087   Culvert       
                
Tributary 12 (J) Reach 3 601.6315 250 Historic 28.49 265.71 3.52 8.09 
Tributary 12 (J) Reach 3 601.6315 250 Wet Scenario 31.87 265.79 3.83 8.33 
                
Tributary 12 (J) Reach 3 252.1656 250 Historic 28.49 264.74 2.75 26.65 
Tributary 12 (J) Reach 3 252.1656 250 Wet Scenario 31.87 264.85 2.41 36.52 
                
Tributary 11 (P) Reach 1 3514.93 250 Historic 6 263.13 2.06 2.96 
Tributary 11 (P) Reach 1 3514.93 250 Wet Scenario 6.31 263.25 1.79 3.64 
                
Tributary 11 (P) Reach 1 2610.112 250 Historic 7.05 259.36 2.26 3.13 
Tributary 11 (P) Reach 1 2610.112 250 Wet Scenario 7.41 259.42 2.3 3.23 
                
Tributary 11 (P) Reach 1 851.6322 250 Historic 7.05 254.04 0.05 337.18 
Tributary 11 (P) Reach 1 851.6322 250 Wet Scenario 7.41 254.27 0.04 432.17 
                
Tributary 11 (P) Reach 2 311.5762 250 Historic 14.1 254.04 0.13 274.54 
Tributary 11 (P) Reach 2 311.5762 250 Wet Scenario 14.8 254.27 0.1 370.56 
                
Tributary 11 (P) Reach 2 88.10411 250 Historic 14.1 254.04 0.09 378.33 
Tributary 11 (P) Reach 2 88.10411 250 Wet Scenario 14.8 254.27 0.07 495.3 
                
Tributary 11 (P) Reach 3 610.848 250 Historic 14.09 254.04 0.06 662.89 
Tributary 11 (P) Reach 3 610.848 250 Wet Scenario 14.8 254.27 0.04 866.33 
                
Tributary 11 (P) Reach 3 181.0659 250 Historic 14.09 253.88 0.12 344.92 
Tributary 11 (P) Reach 3 181.0659 250 Wet Scenario 14.8 254.1 0.1 435.37 
                
Tributary 10 (R) Reach 1 784.3457 250 Historic 6.32 253.53 0.1 232.84 
Tributary 10 (R) Reach 1 784.3457 250 Wet Scenario 6.74 253.81 0.06 364.25 
                
Tributary 10 (R) Reach 1 336.6994 250 Historic 6.32 253.53 0.11 217.82 
Tributary 10 (R) Reach 1 336.6994 250 Wet Scenario 6.74 253.81 0.07 360.03 
                
Tributary 10 (R) Reach 1 46.67747 250 Historic 6.32 253.22 0.07 235.47 
Tributary 10 (R) Reach 1 46.67747 250 Wet Scenario 6.74 253.46 0.06 286.1 
                
Tributary9(C-30) Reach 1 1649.276 250 Historic 0.91 262.83 1.14 1.12 
Tributary9(C-30) Reach 1 1649.276 250 Wet Scenario 0.97 262.84 1.18 1.17 
                
Tributary9(C-30) Reach 1 800.777 250 Historic 0.91 255.39 1.74 0.52 
Tributary9(C-30) Reach 1 800.777 250 Wet Scenario 0.97 255.4 1.77 0.55 
                
Tributary9(C-30) Reach 1 752.6324 250 Historic 0.91 255.09 1.12 0.81 
Tributary9(C-30) Reach 1 752.6324 250 Wet Scenario 0.97 255.11 1.14 0.85 
                
Tributary9(C-30) Reach 1 743.3839   Culvert       
                
Tributary9(C-30) Reach 1 734.0452 250 Historic 0.91 254.91 1.39 0.66 
Tributary9(C-30) Reach 1 734.0452 250 Wet Scenario 0.97 254.92 1.43 0.68 
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Table 3.7 HEC-RAS results for the Dingman Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Tributary9(C-30) Reach 1 72.17505 250 Historic 0.91 251.67 0.01 147.56 
Tributary9(C-30) Reach 1 72.17505 250 Wet Scenario 0.97 251.93 0.01 162.9 
                
Tributary8(B-62) Reach 1 1354.271 250 Historic 3.8 262.7 1.78 3.4 
Tributary8(B-62) Reach 1 1354.271 250 Wet Scenario 4.08 262.71 1.81 3.61 
                
Tributary8(B-62) Reach 1 1190.894 250 Historic 3.8 262.22 0.46 15.38 
Tributary8(B-62) Reach 1 1190.894 250 Wet Scenario 4.08 262.3 0.41 18.85 
                
Tributary8(B-62) Reach 1 999.0443 250 Historic 3.8 261.92 1.92 1.98 
Tributary8(B-62) Reach 1 999.0443 250 Wet Scenario 4.08 261.98 1.97 2.08 
                
Tributary8(B-62) Reach 1 985.5711   Culvert       
                
Tributary8(B-62) Reach 1 969.8938 250 Historic 3.8 261.37 2.91 1.31 
Tributary8(B-62) Reach 1 969.8938 250 Wet Scenario 4.08 261.41 3.01 1.36 
                
Tributary8(B-62) Reach 1 442.3338 250 Historic 3.8 255.03 1.26 3.13 
Tributary8(B-62) Reach 1 442.3338 250 Wet Scenario 4.08 255.1 1.26 3.39 
                
Tributary8(B-62) Reach 1 239.1602 250 Historic 3.8 252 2.5 1.7 
Tributary8(B-62) Reach 1 239.1602 250 Wet Scenario 4.08 252.04 2.53 1.82 
                
Tributary8(B-62) Reach 1 60.5166 250 Historic 3.8 250.87 0.44 11.91 
Tributary8(B-62) Reach 1 60.5166 250 Wet Scenario 4.08 251.07 0.39 14.85 
                
Tributary7(B-64) Reach 1 2297.615 250 Historic 6.18 265.56 0.07 133.72 
Tributary7(B-64) Reach 1 2297.615 250 Wet Scenario 6.64 265.61 0.07 139.2 
                
Tributary7(B-64) Reach 1 2006.106 250 Historic 6.18 265.56 0.09 125.5 
Tributary7(B-64) Reach 1 2006.106 250 Wet Scenario 6.64 265.61 0.09 130.16 
                
Tributary7(B-64) Reach 1 1973.936   Culvert       
                
Tributary7(B-64) Reach 1 1960.685 250 Historic 6.18 264.81 0.56 19.28 
Tributary7(B-64) Reach 1 1960.685 250 Wet Scenario 6.64 264.82 0.59 19.67 
                
Tributary7(B-64) Reach 1 655.4799 250 Historic 6.18 252.17 1.51 5.99 
Tributary7(B-64) Reach 1 655.4799 250 Wet Scenario 6.64 252.19 1.48 6.45 
                
Tributary7(B-64) Reach 1 80.94641 250 Historic 6.18 249.89 0.08 114.18 
Tributary7(B-64) Reach 1 80.94641 250 Wet Scenario 6.64 250.06 0.07 135.74 
                
Tributary 6 (I) Reach 1 2622.822 250 Historic 7.48 267.74 2.5 2.99 
Tributary 6 (I) Reach 1 2622.822 250 Wet Scenario 8.39 267.8 2.56 3.27 
                
Tributary 6 (I) Reach 1 2057.843 250 Historic 7.48 265.43 0.88 8.48 
Tributary 6 (I) Reach 1 2057.843 250 Wet Scenario 8.39 265.56 0.88 9.52 
                
Tributary 6 (I) Reach 1 2011.807 250 Historic 7.48 265.34 1.17 6.37 
Tributary 6 (I) Reach 1 2011.807 250 Wet Scenario 8.39 265.45 1.24 6.79 
                
Tributary 6 (I) Reach 1 1982.81   Bridge       
                
Tributary 6 (I) Reach 1 1969.807 250 Historic 7.48 265.3 1.2 6.23 
Tributary 6 (I) Reach 1 1969.807 250 Wet Scenario 8.39 265.41 1.26 6.64 
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Table 3.7 HEC-RAS results for the Dingman Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Tributary 6 (I) Reach 1 1962.426 250 Historic 7.48 265.31 0.47 16.21 
Tributary 6 (I) Reach 1 1962.426 250 Wet Scenario 8.39 265.42 0.49 17.42 
                
Tributary 6 (I) Reach 1 1687.523 250 Historic 7.48 264.58 2 3.73 
Tributary 6 (I) Reach 1 1687.523 250 Wet Scenario 8.39 264.65 2.07 4.05 
                
Tributary 6 (I) Reach 1 1140.616 250 Historic 7.48 263.74 0.04 353.5 
Tributary 6 (I) Reach 1 1140.616 250 Wet Scenario 8.39 263.89 0.03 401.69 
                
Tributary 6 (I) Reach 1 58.44173 250 Historic 7.48 263.68 0.18 87.67 
Tributary 6 (I) Reach 1 58.44173 250 Wet Scenario 8.39 263.81 0.18 97.41 
                
Tributary 5 (G) Reach 1 2181.574 250 Historic 14.12 261.38 0.4 59.92 
Tributary 5 (G) Reach 1 2181.574 250 Wet Scenario 15.69 261.55 0.38 79.26 
                
Tributary 5 (G) Reach 1 2019.322 250 Historic 14.12 260.92 2.37 5.96 
Tributary 5 (G) Reach 1 2019.322 250 Wet Scenario 15.69 261.05 2.46 6.37 
                
Tributary 5 (G) Reach 1 1989.496   Culvert       
                
Tributary 5 (G) Reach 1 1970.787 250 Historic 14.12 260.29 3.54 3.98 
Tributary 5 (G) Reach 1 1970.787 250 Wet Scenario 15.69 260.38 3.67 4.28 
                
Tributary 5 (G) Reach 1 1148.506 250 Historic 14.12 258.27 1.19 20.6 
Tributary 5 (G) Reach 1 1148.506 250 Wet Scenario 15.69 258.32 1.19 23.78 
                
Tributary 5 (G) Reach 1 279.0797 250 Historic 14.12 257.59 0.27 95.42 
Tributary 5 (G) Reach 1 279.0797 250 Wet Scenario 15.69 257.68 0.28 102.57 
                
Tributary 5 (G) Reach 2 1429.644 250 Historic 9 257.69 0.66 16.02 
Tributary 5 (G) Reach 2 1429.644 250 Wet Scenario 10 257.78 0.68 17.42 
                
Tributary 5 (G) Reach 2 864.2008 250 Historic 9 257.62 0.31 30.09 
Tributary 5 (G) Reach 2 864.2008 250 Wet Scenario 10 257.71 0.32 32.06 
                
Tributary 5 (G) Reach 2 41.99506 250 Historic 9 257.59 0.16 179.02 
Tributary 5 (G) Reach 2 41.99506 250 Wet Scenario 10 257.68 0.15 207.42 
                
Tributary 5 (G) Reach 3 179.6919 250 Historic 34.07 257.59 0.35 228.58 
Tributary 5 (G) Reach 3 179.6919 250 Wet Scenario 37.86 257.68 0.34 260.33 
                
Tributary 5 (G) Reach 3 99.05259 250 Historic 34.07 257.55 0.72 47.57 
Tributary 5 (G) Reach 3 99.05259 250 Wet Scenario 37.86 257.63 0.78 48.61 
                
Tributary 4 (F) Reach 1 2394.624 250 Historic 13.48 259.42 0.29 51.71 
Tributary 4 (F) Reach 1 2394.624 250 Wet Scenario 14.64 259.46 0.3 53.46 
                
Tributary 4 (F) Reach 1 2372.165 250 Historic 13.48 259.41 0.48 51.59 
Tributary 4 (F) Reach 1 2372.165 250 Wet Scenario 14.64 259.46 0.51 53.19 
                
Tributary 4 (F) Reach 1 2362.02   Culvert       
                
Tributary 4 (F) Reach 1 2355.249 250 Historic 13.48 258.29 0.98 21.49 
Tributary 4 (F) Reach 1 2355.249 250 Wet Scenario 14.64 258.36 1 23.01 
                
Tributary 4 (F) Reach 1 2171.989 250 Historic 13.48 258.1 1 13.6 
Tributary 4 (F) Reach 1 2171.989 250 Wet Scenario 14.64 258.16 1.02 14.68 
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Table 3.7 HEC-RAS results for the Dingman Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Tributary 4 (F) Reach 1 1741.343 250 Historic 14.1 256.58 1.1 12.79 
Tributary 4 (F) Reach 1 1741.343 250 Wet Scenario 15.32 256.65 1.11 13.82 
                
Tributary 4 (F) Reach 1 751.819 250 Historic 15.76 254.79 1.48 15.12 
Tributary 4 (F) Reach 1 751.819 250 Wet Scenario 17.12 254.85 1.5 16.55 
                
Tributary 4 (F) Reach 2 895.0485 250 Historic 2.86 258.68 1.3 2.2 
Tributary 4 (F) Reach 2 895.0485 250 Wet Scenario 3.1 258.71 1.36 2.29 
                
Tributary 4 (F) Reach 2 145.6887 250 Historic 2.86 254.79 1.68 1.71 
Tributary 4 (F) Reach 2 145.6887 250 Wet Scenario 3.1 254.85 1.66 1.87 
                
Tributary 4 (F) Reach 3 588.1453 250 Historic 21.35 254.5 1.57 18.92 
Tributary 4 (F) Reach 3 588.1453 250 Wet Scenario 23.18 254.59 1.55 21.98 
                
Tributary 4 (F) Reach 3 127.2696 250 Historic 21.35 254.32 0.53 79.57 
Tributary 4 (F) Reach 3 127.2696 250 Wet Scenario 23.18 254.41 0.51 90.43 
                
Tributary 3 (E) Reach 1 4832.017 250 Historic 2.54 268.9 0.89 2.84 
Tributary 3 (E) Reach 1 4832.017 250 Wet Scenario 2.75 268.92 0.92 2.99 
                
Tributary 3 (E) Reach 1 3273.808 250 Historic 2.54 263.01 0.64 3.96 
Tributary 3 (E) Reach 1 3273.808 250 Wet Scenario 2.75 263.06 0.66 4.14 
                
Tributary 3 (E) Reach 1 3267.409   Bridge       
                
Tributary 3 (E) Reach 1 3261.207 250 Historic 2.54 263.01 0.64 3.96 
Tributary 3 (E) Reach 1 3261.207 250 Wet Scenario 2.75 263.06 0.67 4.13 
                
Tributary 3 (E) Reach 1 1560.724 250 Historic 8.27 257.02 0.91 11.64 
Tributary 3 (E) Reach 1 1560.724 250 Wet Scenario 8.93 257.04 0.92 13.68 
                
Tributary 3 (E) Reach 1 85.37607 250 Historic 12.45 253.86 0.05 364.94 
Tributary 3 (E) Reach 1 85.37607 250 Wet Scenario 13.44 254.09 0.05 419.48 
                
Tributary 2 (D) Reach 1 5183.482 250 Historic 3.88 269.72 0.81 11.75 
Tributary 2 (D) Reach 1 5183.482 250 Wet Scenario 4.14 269.75 0.85 12.11 
                
Tributary 2 (D) Reach 1 4399.641 250 Historic 3.88 267.86 1.43 2.72 
Tributary 2 (D) Reach 1 4399.641 250 Wet Scenario 4.14 267.88 1.47 2.82 
                
Tributary 2 (D) Reach 1 3359.25 250 Historic 6.71 263.42 1.3 5.15 
Tributary 2 (D) Reach 1 3359.25 250 Wet Scenario 7.16 263.46 1.31 5.47 
                
Tributary 2 (D) Reach 1 2686.215 250 Historic 6.71 260.08 1.94 3.46 
Tributary 2 (D) Reach 1 2686.215 250 Wet Scenario 7.16 260.12 1.99 3.61 
                
Tributary 2 (D) Reach 1 2668.427   Bridge       
                
Tributary 2 (D) Reach 1 2651.819 250 Historic 6.71 259.78 2.55 2.63 
Tributary 2 (D) Reach 1 2651.819 250 Wet Scenario 7.16 259.81 2.6 2.75 
                
Tributary 2 (D) Reach 1 2042.215 250 Historic 6.71 256.84 0.78 8.65 
Tributary 2 (D) Reach 1 2042.215 250 Wet Scenario 7.16 256.87 0.79 9.01 
                
Tributary 2 (D) Reach 1 1094.016 250 Historic 9.75 254.35 0.79 15.6 
Tributary 2 (D) Reach 1 1094.016 250 Wet Scenario 10.41 254.38 0.8 16.67 
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Table 3.7 HEC-RAS results for the Dingman Creek-continued 
 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Tributary 2 (D) Reach 1 71.18511 250 Historic 9.75 253.17 0.21 169.32 
Tributary 2 (D) Reach 1 71.18511 250 Wet Scenario 10.41 253.42 0.18 208.63 
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Table 3.8 HEC-RAS results for the Mud Creek 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area 
        (m3/s) (m) (m/s) (m2) 
Mud Creek London 2397.303 250 Historic 0.88 238.06 0.96 1.73 
Mud Creek London 2397.303 250 Wet Scenario 0.96 238.07 0.94 1.96 
                
Mud Creek London 2090.643 250 Historic 0.88 236.6 1.24 0.95 
Mud Creek London 2090.643 250 Wet Scenario 0.96 236.61 1.24 1.11 
                
Mud Creek London 1823.279 250 Historic 0.88 234.76 0.4 2.19 
Mud Creek London 1823.279 250 Wet Scenario 0.96 235.58 0.11 17.26 
                
Mud Creek London 1820.875   Bridge       
                
Mud Creek London 1818.822 250 Historic 0.88 234.76 0.4 2.19 
Mud Creek London 1818.822 250 Wet Scenario 0.96 235.58 0.11 17.21 
                
Mud Creek London 1601.478 250 Historic 0.88 234.76 0.21 4.1 
Mud Creek London 1601.478 250 Wet Scenario 0.96 235.58 0.03 53.62 
                
Mud Creek London 1598.02   Bridge       
                
Mud Creek London 1595.472 250 Historic 0.88 234.75 0.21 4.15 
Mud Creek London 1595.472 250 Wet Scenario 0.96 235.58 0.03 53.67 
                
Mud Creek London 1384.955 250 Historic 4.51 234.74 0.31 14.46 
Mud Creek London 1384.955 250 Wet Scenario 4.9 235.58 0.26 18.52 
                
Mud Creek London 1370.456   Bridge       
                
Mud Creek London 1357.1 250 Historic 4.51 234.74 0.31 14.59 
Mud Creek London 1357.1 250 Wet Scenario 4.9 235.57 0.26 18.63 
                
Mud Creek London 1340.192 250 Historic 4.51 234.74 0.22 22.93 
Mud Creek London 1340.192 250 Wet Scenario 4.9 235.57 0.1 105.67 
                
Mud Creek London 1160.276 250 Historic 4.51 234.74 0.21 21.45 
Mud Creek London 1160.276 250 Wet Scenario 4.9 235.57 0.19 26.44 
                
Mud Creek London 1144.729   Bridge       
                
Mud Creek London 1125.822 250 Historic 4.51 234.74 0.21 21.44 
Mud Creek London 1125.822 250 Wet Scenario 4.9 235.57 0.19 26.43 
                
Mud Creek London 814.0285 250 Historic 4.51 234.73 0.16 49.76 
Mud Creek London 814.0285 250 Wet Scenario 4.9 235.57 0.1 123.7 
                
Mud Creek London 527.7888 250 Historic 7.27 234.6 0.28 63.58 
Mud Creek London 527.7888 250 Wet Scenario 7.89 235.41 0.12 166.26 
                
Mud Creek London 263.5877 250 Historic 10.81 234.59 0.34 125.48 
Mud Creek London 263.5877 250 Wet Scenario 11.72 235.41 0.24 224.14 
                
Mud Creek London 163.5299   Culvert       
                
Mud Creek London 63.27246 250 Historic 10.81 234.59 0.15 472.02 
Mud Creek London 63.27246 250 Wet Scenario 11.72 235.41 0.11 692.91 
                
Mud Creek London 54.52624 250 Historic 10.81 234.59 0.02 1336.17 
Mud Creek London 54.52624 250 Wet Scenario 11.72 235.41 0.02 1708.87 
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3.2 Floodplain mapping results 

Floodplain mapping results are shown using floodplain boundary lines. Floodplain lines 

are shown for two climate scenarios: 250-year flood historic climate scenario and 250-year flood 

wet climate scenario.  

 

3.2.1. Floodplain results for selected locations 

The locations that show a larger difference between the historic and wet climate scenarios 

are presented in Figures 3.1 to 3.13. Every figure with floodplain results is supported with HEC-

RAS results.  It is important to emphasize that the presentation of the floodplain results on the 

map is highly dependent on the terrain characteristics. If the terrain is steep (distance between 

contour lines is small), then the difference between the floodplain lines cannot be clearly visible. 

For example, Figure 3.1 shows floodplain mapping results for one section of the Main Thames 

River. On the map it looks as there is no significant difference between 250 year historic climate 

scenario floodplain line and 250 year wet climate scenario floodplain line. However, according 

to the HEC-RAS results, there is a difference in water surface elevations of about 40 - 50 cm 

between the two. The difference in water depth between historic and wet climate scenario will be 

considered in the Risk Assessment Phase of the Project.    
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Figure 3.1 Floodplain results for a location at the Main Thames River 
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Table 3.9 HEC-RAS results for a location at the Main Thames River 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Main Thames London 8999.401 250-Historic 1616.25 234.99 2.26 795.86 0.27 
Main Thames London 8999.401 250-Wet Scenario 1892.72 235.56 2.41 907.79 0.28 
                  
Main Thames London 8733.405 250-Historic 1616.25 234.98 1.65 1452.93 0.2 
Main Thames London 8733.405 250-Wet Scenario 1892.72 235.58 1.68 1706.46 0.19 
                  
Main Thames London 8597.229 250-Historic 1616.25 234.98 1.38 1952.69 0.16 
Main Thames London 8597.229 250-Wet Scenario 1892.72 235.58 1.4 2294.01 0.16 
                  
Main Thames London 8465.656 250-Historic 1617.55 234.97 1.26 2149.59 0.15 
Main Thames London 8465.656 250-Wet Scenario 1893.57 235.58 1.25 2579.85 0.14 
                  
Main Thames London 8359.158 250-Historic 1617.55 234.94 1.43 1945.72 0.17 
Main Thames London 8359.158 250-Wet Scenario 1893.57 235.54 1.45 2271.6 0.17 
                  
Main Thames London 8266.557 250-Historic 1617.55 234.93 1.37 1943.83 0.16 
Main Thames London 8266.557 250-Wet Scenario 1893.57 235.53 1.4 2239.92 0.16 
                  
Main Thames London 8216.348 250-Historic 1617.55 234.88 1.61 1748.93 0.19 
Main Thames London 8216.348 250-Wet Scenario 1893.57 235.49 1.62 2054.87 0.18 
                  
Main Thames London 8078.313 250-Historic 1617.55 234.86 1.39 1648.14 0.16 
Main Thames London 8078.313 250-Wet Scenario 1893.57 235.46 1.45 1857.92 0.16 
                  
Main Thames London 7991.973 250-Historic 1617.55 234.84 1.28 1377.6 0.15 
Main Thames London 7991.973 250-Wet Scenario 1893.57 235.44 1.38 1525.46 0.15 
                  
Main Thames London 7936.935 250-Historic 1617.55 234.76 1.74 1016.87 0.2 
Main Thames London 7936.935 250-Wet Scenario 1893.57 235.34 1.87 1120.7 0.21 
                  
Main Thames London 7845.231 250-Historic 1617.55 234.73 1.77 1116.42 0.21 
Main Thames London 7845.231 250-Wet Scenario 1893.57 235.32 1.88 1255.86 0.21 
                  
Main Thames London 7831.712 250-Historic 1617.55 234.74 1.67 1134.44 0.2 
Main Thames London 7831.712 250-Wet Scenario 1893.57 235.33 1.77 1263.61 0.2 
                  
Main Thames London 7809.424   Bridge         
                  
Main Thames London 7793.904 250-Historic 1617.55 234.72 1.67 1129.49 0.2 
Main Thames London 7793.904 250-Wet Scenario 1893.57 235.31 1.77 1258.59 0.2 
                  
Main Thames London 7743.635 250-Historic 1617.55 234.67 1.77 1012.67 0.21 
Main Thames London 7743.635 250-Wet Scenario 1893.57 235.25 1.91 1110.9 0.21 
                  
Main Thames London 7635.993 250-Historic 1617.55 234.5 2.36 752.87 0.28 
Main Thames London 7635.993 250-Wet Scenario 1893.57 235.05 2.54 829.03 0.29 
                  
Main Thames London 7524.016 250-Historic 1617.55 234.4 2.49 754.83 0.3 
Main Thames London 7524.016 250-Wet Scenario 1893.57 234.95 2.67 838.54 0.31 
                  
Main Thames London 7369.606 250-Historic 1617.55 234.39 2 873.66 0.24 
Main Thames London 7369.606 250-Wet Scenario 1893.57 234.95 2.16 969.82 0.24 
                  
Main Thames London 7258.678 250-Historic 1617.55 234.3 2.19 843.26 0.25 
Main Thames London 7258.678 250-Wet Scenario 1893.57 234.85 2.36 943.07 0.26 
                  
Main Thames London 7066.157 250-Historic 1617.55 234.21 2.17 847.81 0.25 
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Table 3.9 HEC-RAS results for a location at the Main Thames River-continued 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Main Thames London 7066.157 250-Wet Scenario 1893.57 234.76 2.35 940.24 0.26 
                  
Main Thames London 6991.004 250-Historic 1617.55 234.21 1.95 871.16 0.23 
Main Thames London 6991.004 250-Wet Scenario 1893.57 234.75 2.12 948.51 0.24 
                  
Main Thames London 6908.691 250-Historic 1617.55 234.18 1.93 931.89 0.22 
Main Thames London 6908.691 250-Wet Scenario 1893.57 234.73 2.08 1023.65 0.23 
                  
Main Thames London 6836.473 250-Historic 1617.55 234.06 2.38 802.71 0.27 
Main Thames London 6836.473 250-Wet Scenario 1893.57 234.59 2.55 889.3 0.28 
                  
Main Thames London 6779.345 250-Historic 1617.55 234.04 2.32 835.67 0.27 
Main Thames London 6779.345 250-Wet Scenario 1893.57 234.57 2.49 926.96 0.28 
                  
Main Thames London 6703.037 250-Historic 1617.55 234.03 2.11 931.3 0.24 
Main Thames London 6703.037 250-Wet Scenario 1893.57 234.57 2.26 1038.32 0.25 
                  
Main Thames London 6661.459 250-Historic 1617.55 234.01 2.14 934.04 0.24 
Main Thames London 6661.459 250-Wet Scenario 1893.57 234.55 2.29 1037.79 0.25 
                  
Main Thames London 6649.045 250-Historic 1617.55 234 2.17 918.43 0.25 
Main Thames London 6649.045 250-Wet Scenario 1893.57 234.54 2.32 1019.21 0.26 
                  
Main Thames London 6644.485   Bridge         
                  
Main Thames London 6640.114 250-Historic 1617.55 233.98 2.17 914.81 0.25 
Main Thames London 6640.114 250-Wet Scenario 1893.57 234.52 2.33 1014.48 0.26 
                  
Main Thames London 6613.312 250-Historic 1617.55 233.97 2.13 918.57 0.25 
Main Thames London 6613.312 250-Wet Scenario 1893.57 234.51 2.28 1022.58 0.26 
                  
Main Thames London 6534.023 250-Historic 1617.55 233.96 1.99 941.26 0.23 
Main Thames London 6534.023 250-Wet Scenario 1893.57 234.49 2.14 1037.07 0.24 
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Figure 3.2 Floodplain results for a location at the North Thames River 
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Table 3.10 HEC-RAS results for a location at the North Thames River 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
North Thames London 3662.343 250 Historic 1031.54 238.95 2.56 612.51 0.33 
North Thames London 3662.343 250 Wet Scenario 1258.11 239.45 2.78 715.54 0.35 
                  
North Thames London 3552.279 250 Historic 1031.54 238.9 2.19 841.93 0.29 
North Thames London 3552.279 250 Wet Scenario 1258.11 239.41 2.31 1011.9 0.3 
                  
North Thames London 3456.593 250 Historic 1031.54 238.85 1.79 1102.95 0.23 
North Thames London 3456.593 250 Wet Scenario 1258.11 239.38 1.87 1309.75 0.23 
                  
North Thames London 3352.649 250 Historic 1031.54 238.73 1.99 987.22 0.26 
North Thames London 3352.649 250 Wet Scenario 1258.11 239.25 2.08 1204.96 0.26 
                  
North Thames London 3247.213 250 Historic 1031.54 238.67 1.81 1042.66 0.23 
North Thames London 3247.213 250 Wet Scenario 1258.11 239.2 1.88 1270.01 0.23 
                  
North Thames London 3137.104 250 Historic 1031.54 238.48 2.52 824.99 0.32 
North Thames London 3137.104 250 Wet Scenario 1258.11 239.01 2.61 1046.88 0.32 
                  
North Thames London 3032.41 250 Historic 1031.54 238.31 2.43 820.49 0.31 
North Thames London 3032.41 250 Wet Scenario 1258.11 238.86 2.46 1042.75 0.3 
                  
North Thames London 2990.473 250 Historic 1031.54 238.28 2.32 863.72 0.3 
North Thames London 2990.473 250 Wet Scenario 1258.11 238.84 2.35 1107.05 0.29 
                  
North Thames London 2940.241 250 Historic 1031.54 238.29 2.01 1034.64 0.26 
North Thames London 2940.241 250 Wet Scenario 1258.11 238.84 2.03 1286.86 0.25 
                  
North Thames London 2866.759 250 Historic 1031.54 238.25 2.04 1198.15 0.26 
North Thames London 2866.759 250 Wet Scenario 1258.11 238.81 2.02 1486.83 0.25 
                  
North Thames London 2862.548 250 Historic 1031.54 238.22 1.86 1480.76 0.24 
North Thames London 2862.548 250 Wet Scenario 1258.11 238.78 1.83 1824.64 0.23 
                  
North Thames London 2754.405 250 Historic 1031.54 238.08 2.17 1272.64 0.28 
North Thames London 2754.405 250 Wet Scenario 1258.11 238.64 2.22 1525.68 0.28 
                  
North Thames London 2673.227 250 Historic 1031.54 238 2.26 1006.5 0.3 
North Thames London 2673.227 250 Wet Scenario 1258.11 238.52 2.49 1177.87 0.31 
                  
North Thames London 2544.147 250 Historic 1031.54 237.57 3.48 565.56 0.48 
North Thames London 2544.147 250 Wet Scenario 1258.11 238.09 3.64 673.19 0.48 
                  
North Thames London 2361.037 250 Historic 1031.54 237.56 2.09 847.18 0.29 
North Thames London 2361.037 250 Wet Scenario 1258.11 238.12 2.13 1063.3 0.28 
                  
North Thames London 2308.115 250 Historic 1031.54 237.58 1.74 1116.32 0.24 
North Thames London 2308.115 250 Wet Scenario 1258.11 238.14 1.76 1360.04 0.23 
                  
North Thames London 2202.025 250 Historic 1031.54 237.54 1.6 1136.81 0.23 
North Thames London 2202.025 250 Wet Scenario 1258.11 238.11 1.58 1453.17 0.21 
                  
North Thames London 2190.01 250 Historic 1031.54 237.52 1.65 1067.33 0.23 
North Thames London 2190.01 250 Wet Scenario 1258.11 238.1 1.63 1394.72 0.22 
                  
North Thames London 2181.51   Bridge         
                  
North Thames London 2172.707 250 Historic 1031.54 237.5 1.67 1053.84 0.24 
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Table 3.10 HEC-RAS results for a location at the North Thames River-continued 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
North Thames London 2172.707 250 Wet Scenario 1258.11 238.06 1.65 1374.7 0.22 
                  
North Thames London 2130.325 250 Historic 1031.54 237.51 1.24 1484.27 0.17 
North Thames London 2130.325 250 Wet Scenario 1258.11 238.07 1.27 1832.54 0.16 
                  
North Thames London 2040.504 250 Historic 1031.54 237.51 0.99 1805.86 0.13 
North Thames London 2040.504 250 Wet Scenario 1258.11 238.07 1.03 2158.83 0.13 
                  
North Thames London 1995.466 250 Historic 1031.54 237.49 1.03 1670.65 0.13 
North Thames London 1995.466 250 Wet Scenario 1258.11 238.05 1.1 1902.21 0.13 
                  
North Thames London 1944.315 250 Historic 1031.54 237.45 1.23 1125.55 0.16 
North Thames London 1944.315 250 Wet Scenario 1258.11 238 1.34 1280.49 0.16 
                  
North Thames London 1858.895 250 Historic 1031.54 237.29 1.94 650.74 0.26 
North Thames London 1858.895 250 Wet Scenario 1258.11 237.81 2.13 737.09 0.27 
                  
North Thames London 1733.633 250 Historic 1031.54 237.19 2.04 607.2 0.28 
North Thames London 1733.633 250 Wet Scenario 1258.11 237.71 2.21 737.15 0.29 
                  
North Thames London 1657.939 250 Historic 1031.54 237.19 1.79 748.2 0.24 
North Thames London 1657.939 250 Wet Scenario 1258.11 237.72 1.92 902.29 0.25 
                  
North Thames London 1627.085 250 Historic 1031.54 237.19 1.68 765.52 0.24 
North Thames London 1627.085 250 Wet Scenario 1258.11 237.73 1.79 937.03 0.24 
                  
North Thames London 1560.961 250 Historic 1031.54 237.16 1.7 1013.51 0.23 
North Thames London 1560.961 250 Wet Scenario 1258.11 237.7 1.74 1395.58 0.23 
                  
North Thames London 1515.005 250 Historic 1031.54 237.14 1.54 671.63 0.26 
North Thames London 1515.005 250 Wet Scenario 1258.11 237.65 1.63 769.5 0.26 
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Figure 3.3 Floodplain results for a location at the Stoney Creek 
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Table 3.11 HEC-RAS results for a location at the Stoney Creek 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Stoney Creek Lower Reach 2881.127 250 Historic 59.16 248.83 1.41 55.75 0.29 
Stoney Creek Lower Reach 2881.127 250 Wet Scenario 65.65 248.95 1.47 60.38 0.3 
                  
Stoney Creek Lower Reach 2721.468 250 Historic 59.16 248.75 1.49 57 0.29 
Stoney Creek Lower Reach 2721.468 250 Wet Scenario 65.65 248.87 1.57 60.77 0.3 
                  
Stoney Creek Lower Reach 2708.136 250 Historic 59.16 248.76 1.01 58.84 0.23 
Stoney Creek Lower Reach 2708.136 250 Wet Scenario 65.65 248.88 1.05 62.48 0.23 
                  
Stoney Creek Lower Reach 2694.901   Bridge         
                  
Stoney Creek Lower Reach 2678.896 250 Historic 59.16 248.75 1.06 56.01 0.25 
Stoney Creek Lower Reach 2678.896 250 Wet Scenario 65.65 248.87 1.1 59.7 0.25 
                  
Stoney Creek Lower Reach 2621.681 250 Historic 59.16 248.67 1.66 60.82 0.33 
Stoney Creek Lower Reach 2621.681 250 Wet Scenario 65.65 248.8 1.71 67.76 0.33 
                  
Stoney Creek Lower Reach 2471 250 Historic 59.16 248.48 1.92 51.73 0.4 
Stoney Creek Lower Reach 2471 250 Wet Scenario 65.65 248.6 1.96 58.02 0.39 
                  
Stoney Creek Lower Reach 2408.007 250 Historic 59.16 248.44 1.8 51.29 0.37 
Stoney Creek Lower Reach 2408.007 250 Wet Scenario 65.65 248.57 1.82 57.23 0.37 
                  
Stoney Creek Lower Reach 2357.588 250 Historic 59.16 248.45 1.47 69.35 0.3 
Stoney Creek Lower Reach 2357.588 250 Wet Scenario 65.65 248.58 1.5 76.62 0.29 
                  
Stoney Creek Lower Reach 2346.78 250 Historic 59.16 248.46 0.89 66.13 0.21 
Stoney Creek Lower Reach 2346.78 250 Wet Scenario 65.65 248.59 0.93 70.91 0.21 
                  
Stoney Creek Lower Reach 2328.596   Bridge         
                  
Stoney Creek Lower Reach 2311.613 250 Historic 59.16 248.45 0.9 66.02 0.21 
Stoney Creek Lower Reach 2311.613 250 Wet Scenario 65.65 248.58 0.93 70.75 0.21 
                  
Stoney Creek Lower Reach 2299.93 250 Historic 59.16 248.39 1.45 59.98 0.3 
Stoney Creek Lower Reach 2299.93 250 Wet Scenario 65.65 248.53 1.49 67.28 0.3 
                  
Stoney Creek Lower Reach 2245.418 250 Historic 59.16 248.27 2.05 46.56 0.43 
Stoney Creek Lower Reach 2245.418 250 Wet Scenario 65.65 248.41 2.07 53.28 0.42 
                  
Stoney Creek Lower Reach 2085.312 250 Historic 59.16 248.16 1.53 60.08 0.32 
Stoney Creek Lower Reach 2085.312 250 Wet Scenario 65.65 248.32 1.5 68.33 0.3 
                  
Stoney Creek Lower Reach 2024.432 250 Historic 59.16 248.14 1.19 80.82 0.24 
Stoney Creek Lower Reach 2024.432 250 Wet Scenario 65.65 248.3 1.16 93.09 0.23 
                  
Stoney Creek Lower Reach 1826.422 250 Historic 59.16 248.04 1.22 91.33 0.25 
Stoney Creek Lower Reach 1826.422 250 Wet Scenario 65.65 248.21 1.2 105.32 0.24 
                  
Stoney Creek Lower Reach 1753.131 250 Historic 59.16 248.02 0.94 103.6 0.19 
Stoney Creek Lower Reach 1753.131 250 Wet Scenario 65.65 248.2 0.93 118.61 0.18 
                  
Stoney Creek Lower Reach 1714.154 250 Historic 59.16 247.99 1.16 78.46 0.25 
Stoney Creek Lower Reach 1714.154 250 Wet Scenario 65.65 248.17 1.13 91.67 0.23 
                  
Stoney Creek Lower Reach 1703.93 250 Historic 59.16 247.97 1.1 68.36 0.25 
Stoney Creek Lower Reach 1703.93 250 Wet Scenario 65.65 248.16 1.07 80.77 0.23 



- 116 - 
 

Table 3.11 HEC-RAS results for a location at the Stoney Creek-continued 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Stoney Creek Lower Reach 1702.212   Bridge         
                  
Stoney Creek Lower Reach 1700.905 250 Historic 59.16 247.6 1.55 45.82 0.38 
Stoney Creek Lower Reach 1700.905 250 Wet Scenario 65.65 247.69 1.59 50.38 0.38 
                  
Stoney Creek Lower Reach 1678.303 250 Historic 59.16 247.56 1.77 53.92 0.37 
Stoney Creek Lower Reach 1678.303 250 Wet Scenario 65.65 247.65 1.83 58.48 0.37 
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Figure 3.4 Floodplain results for a location at the Pottersburg Creek 
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Table 3.12 HEC-RAS results for a location at the Pottersburg Creek 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Pottersburg Cr London 3320.489 250 Historic 99.47 259.54 0.41 588.1 0.06 
Pottersburg Cr London 3320.489 250 Wet Scenario 114.22 259.63 0.44 632.45 0.06 
                  
Pottersburg Cr London 3124.122 250 Historic 99.47 259.53 0.27 1014.62 0.04 
Pottersburg Cr London 3124.122 250 Wet Scenario 114.22 259.63 0.29 1073.12 0.04 
                  
Pottersburg Cr London 3008.501 250 Historic 99.47 259.53 0.22 1316.91 0.03 
Pottersburg Cr London 3008.501 250 Wet Scenario 114.22 259.63 0.23 1384.27 0.03 
                  
Pottersburg Cr London 2859.465 250 Historic 99.47 259.53 0.29 1049.78 0.04 
Pottersburg Cr London 2859.465 250 Wet Scenario 114.22 259.63 0.31 1109.7 0.04 
                  
Pottersburg Cr London 2696.997 250 Historic 127.42 259.53 0.21 1066.83 0.02 
Pottersburg Cr London 2696.997 250 Wet Scenario 145.77 259.63 0.24 1107.01 0.03 
                  
Pottersburg Cr London 2646.932 250 Historic 127.42 259.53 0.49 1243.26 0.06 
Pottersburg Cr London 2646.932 250 Wet Scenario 145.77 259.62 0.56 1293.63 0.06 
                  
Pottersburg Cr London 2631.258 250 Historic 127.42 259.53 0.19 1512.22 0.02 
Pottersburg Cr London 2631.258 250 Wet Scenario 145.77 259.62 0.21 1606.56 0.02 
                  
Pottersburg Cr London 2619.492   Bridge         
                  
Pottersburg Cr London 2610.263 250 Historic 127.42 259.53 0.19 1511.6 0.02 
Pottersburg Cr London 2610.263 250 Wet Scenario 145.77 259.62 0.21 1605.82 0.02 
                  
Potterrsburg Cr London 2565.58 250 Historic 127.42 259.52 0.42 1504.67 0.05 
Pottrsburg Cr London 2565.58 250 Wet Scenario 145.77 259.62 0.45 1598.65 0.05 

                
Pottersburg Cr London 2527.268 250 Historic 127.42 259.52 0.21 1539.47 0.02 
Pottersburg Cr London 2527.268 250 Wet Scenario 145.77 259.62 0.22 1630.88 0.02 
                  
Pottersburg Cr London 2457.719 250 Historic 127.42 259.52 0.3 1681.07 0.03 
Pottersburg Cr London 2457.719 250 Wet Scenario 145.77 259.62 0.32 1774.79 0.03 
                  
Pottersburg Cr London 2272.463 250 Historic 127.42 259.52 0.13 2831.07 0.01 
Pottersburg Cr London 2272.463 250 Wet Scenario 145.77 259.62 0.15 2919.18 0.02 
                  
Pottersburg Cr London 2169.292 250 Historic 127.42 259.52 0.12 2619.31 0.01 
Pottersburg Cr London 2169.292 250 Wet Scenario 145.77 259.62 0.14 2694.15 0.01 
                  
Pottersburg Cr London 2059.38 250 Historic 127.42 259.52 0.07 2947.99 0.01 
Pottersburg Cr London 2059.38 250 Wet Scenario 145.77 259.62 0.07 3033.96 0.01 
                  
Pottersburg Cr London 1883.751 250 Historic 127.42 259.52 0.07 2930.62 0.01 
Pottersburg Cr London 1883.751 250 Wet Scenario 145.77 259.62 0.07 3010.11 0.01 
                  
Pottersburg Cr London 1814.873 250 Historic 127.42 259.52 0.06 3350.51 0.01 
Pottersburg Cr London 1814.873 250 Wet Scenario 145.77 259.62 0.07 3435.73 0.01 
                  
Pottersburg Cr London 1805.415 250 Historic 127.42 259.52 0.34 1288.42 0.03 
Pottersburg Cr London 1805.415 250 Wet Scenario 145.77 259.61 0.38 1316.83 0.04 
                  
Pottersburg Cr London 1787.191   Bridge         
                  
Pottersburg Cr London 1771.452 250 Historic 140.12 252.69 5.96 23.52 1 
Pottersburg Cr London 1771.452 250 Wet Scenario 160.1 253.02 6.24 25.67 1 
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Table 3.12 HEC-RAS results for a location at the Pottersburg Creek-continued 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Pottersburg Cr London 1734.825 250 Historic 140.12 251.14 1.81 187.79 0.33 
Pottersburg Cr London 1734.825 250 Wet Scenario 160.1 251.26 1.9 203.71 0.34 
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Figure 3.5 Floodplain results for a location at the Dingman Creek 
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Table 3.13 HEC-RAS results for a location at the Dingman Creek 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Dingman Creek Reach 10 26102.15 250 Historic 87 260.93 2.93 104.36 0.55 
Dingman Creek Reach 10 26102.15 250 Wet Scenario 97.92 261.11 2.88 123.48 0.52 
                  
Dingman Creek Reach 10 25904.62 250 Historic 87 260.97 1.07 268.33 0.2 
Dingman Creek Reach 10 25904.62 250 Wet Scenario 97.92 261.14 1.09 303.27 0.2 
                  
Dingman Creek Reach 10 25735.1 250 Historic 87 260.48 2.75 54.18 0.57 
Dingman Creek Reach 10 25735.1 250 Wet Scenario 97.92 260.65 2.81 61.57 0.56 
                  
Dingman Creek Reach 10 25563.7 250 Historic 87 260.33 1.84 140.18 0.37 
Dingman Creek Reach 10 25563.7 250 Wet Scenario 97.92 260.58 1.69 171.07 0.33 
                  
Dingman Creek Reach 10 25283.32 250 Historic 87 260.07 1.36 153.94 0.31 
Dingman Creek Reach 10 25283.32 250 Wet Scenario 97.92 260.4 1.21 202.07 0.25 
                  
Dingman Creek Reach 10 25005.04 250 Historic 87 259.9 1.36 215.06 0.27 
Dingman Creek Reach 10 25005.04 250 Wet Scenario 97.92 260.3 1.15 285.3 0.21 
                  
Dingman Creek Reach 10 24761.7 250 Historic 87 259.64 1.66 90.78 0.34 
Dingman Creek Reach 10 24761.7 250 Wet Scenario 97.92 260.17 1.34 140.86 0.25 
                  
Dingman Creek Reach 10 24509.31 250 Historic 87 259.52 1.21 132.17 0.25 
Dingman Creek Reach 10 24509.31 250 Wet Scenario 97.92 260.13 0.84 254.13 0.15 
                  
Dingman Creek Reach 10 24311.37 250 Historic 87 259.5 0.74 242.91 0.15 
Dingman Creek Reach 10 24311.37 250 Wet Scenario 97.92 260.13 0.51 415.63 0.09 
                  
Dingman Creek Reach 10 24296.22 250 Historic 87 258.99 2.52 34.59 0.5 
Dingman Creek Reach 10 24296.22 250 Wet Scenario 97.92 259.74 2.2 44.47 0.38 
                  
Dingman Creek Reach 10 24282.59   Bridge         
                  
Dingman Creek Reach 10 24269.29 250 Historic 101.78 258.89 3.07 33.2 0.62 
Dingman Creek Reach 10 24269.29 250 Wet Scenario 113.75 258.95 3.35 34 0.67 
                  
Dingman Creek Reach 10 24254.15 250 Historic 101.78 258.88 2.61 68.47 0.57 
Dingman Creek Reach 10 24254.15 250 Wet Scenario 113.75 258.95 2.73 76.22 0.59 
                  
Dingman Creek Reach 10 24208.61 250 Historic 101.78 258.88 1.91 119.91 0.4 
Dingman Creek Reach 10 24208.61 250 Wet Scenario 113.75 258.96 1.97 131.7 0.41 
                  
Dingman Creek Reach 10 24075.93 250 Historic 101.78 258.43 2.73 79.49 0.51 
Dingman Creek Reach 10 24075.93 250 Wet Scenario 113.75 258.5 2.81 88.9 0.52 
                  
Dingman Creek Reach 10 23923.71 250 Historic 101.78 258.11 2.36 99.14 0.48 
Dingman Creek Reach 10 23923.71 250 Wet Scenario 113.75 258.22 2.29 119.49 0.46 
                  
Dingman Creek Reach 10 23737.45 250 Historic 101.78 258.15 0.85 417.53 0.16 
Dingman Creek Reach 10 23737.45 250 Wet Scenario 113.75 258.25 0.81 486.17 0.15 
                  
Dingman Creek Reach 10 23602.88 250 Historic 101.78 258.12 0.9 429.02 0.17 
Dingman Creek Reach 10 23602.88 250 Wet Scenario 113.75 258.23 0.83 506.97 0.15 
                  
Dingman Creek Reach 10 23580.06 250 Historic 101.78 258.11 0.95 378.14 0.17 
Dingman Creek Reach 10 23580.06 250 Wet Scenario 113.75 258.23 0.85 467.3 0.15 
                  
Dingman Creek Reach 10 23572.33   Culvert         
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Table 3.13 HEC-RAS results for a location at the Dingman Creek-continued 

River Reach River Sta Profile Q Total W.S. Elev Vel Chnl Flow Area Froude # Chl 
        (m3/s) (m) (m/s) (m2)   
Dingman Creek Reach 10 23565.27 250 Historic 101.78 258.11 0.97 372.78 0.17 
Dingman Creek Reach 10 23565.27 250 Wet Scenario 113.75 258.22 0.85 463.93 0.15 
                  
Dingman Creek Reach 10 23527.47 250 Historic 101.78 258.1 0.65 456.5 0.12 
Dingman Creek Reach 10 23527.47 250 Wet Scenario 113.75 258.22 0.61 538.08 0.11 
                  
Dingman Creek Reach 10 23389.79 250 Historic 101.78 258.02 1.2 269.57 0.22 
Dingman Creek Reach 10 23389.79 250 Wet Scenario 113.75 258.16 1.07 335.11 0.19 
                  
Dingman Creek Reach 10 23276.36 250 Historic 101.78 258 0.83 281.68 0.17 
Dingman Creek Reach 10 23276.36 250 Wet Scenario 113.75 258.13 0.83 344.97 0.17 

 

3.2.2. Floodplain results for locations of special concern 

The results requiring special attention are discussed here. Results for some of these 

locations do not adhere to a desirable level, most likely due to imprecision of the contour lines. 

Some of the areas where the existing UTRCA 250-year floodplain line is overestimated are also 

identified. 

Figure 3.6 shows results for the North Thames River around the intersection of Oxford St 

W and Wharncliffe Rd N. The blue floodplain line representing the 250-year flood for historic 

climate scenario shows as straight line. In spite of the fact that the area has high elevations, the 

blue line around the Oxford St should not be straight line. This error is the consequence of 

inaccurate contour lines in that area.  

Figure 3.7 shows floodplain results for the North Thames River around the intersection of 

Richmond St and University Dr. The yellow floodplain line, which represents 250-year flood for 

wet climate scenario, is closer to the river (lower flooding extent) then the existing UTRCA 250-

year floodplain line (red line).  According to the HEC-RAS results, however, it should be the 

opposite. The yellow floodplain line should have higher extent of flooding than the UTRCA red 

line, because the water surface elevations are higher (about 40 cm on average) for the 250 year 

wet climate scenario profiles when compared with the existing 250 year UTRCA profiles. Again, 
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the reason for this is the inaccuracy of contour lines. Also, it appears that the UTRCA floodplain 

line (which is entered manually) is overestimated at some cross sections.  

Figures 3.8a and 3.8.b show floodplain results at the South Thames River around the 

intersection of York St and Ridout St N, as well as the area upstream. Since both contour lines 

have a value of 237 m, the red floodplain line (UTRCA) should not cross York St at that 

location.  The water surface elevation at the corresponding cross section is 236.4 m. Again, the 

existing UTRCA floodplain line is overestimated for that area.  

Figure 3.9 shows the upstream area (close to the east city boundary) of the Dingman Creek 

around tributaries 12 and 13. There is no existing UTRCA HEC-RAS model for that area, and 

the delineation of the existing UTRCA 250-year floodplain line (red) is most likely a rough 

estimate of water elevation. This is probably the reason why the floodplain results are different 

for that area. 

Figure 3.10 shows the floodplain mapping results for the Stoney Creek, around Fanshawe 

Park Rd E. The inaccuracy of contour lines resulted in sections of both floodplain lines (250-year 

historic and wet climate scenario) showing as straight lines, instead of following the contour line. 

Figure 3.11 shows the floodplain mapping results for the Stoney Creek, between Adelaide 

St N and Blackwater Rd. This is another area where the existing UTRCA 250-year floodplain 

line is highly overestimated.    

Figure 3.12 shows floodplain mapping results at the Northdale Drain (tributary of the 

Stoney Creek). The part of the Northdale Drain (pointed with arrow on the map modeled by both 

the existing UTRCA and DELCAN HEC-RAS models no longer exist in reality. The extensive 

residential development can be seen by comparing the more recent (London 2007) with the older 

aerial photographs (Figure 3.13) taken from the UTRCA HEC-RAS model. Also, it appears  
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(from the aerial photos) that some regulation work has been done in the channel and its 

surrounding area. The inaccuracy of contour lines (especially around two ponds) affected the 

accuracy of floodplain mapping. This area requires special attention and probably more field 

investigation. 
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Figure 3.6 Location of special concern at the North Thames River 
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Figure 3.7 Location of special concern at the North Thames River 
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Figure 3.8 (a) Location of special concern at the South Thames River 
 

Both contours have 
values of 237m 

Overestimated 
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Figure 3.8 (b) Location of special concern at the South Thames River 
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Figure 3.9 Location of special concern at the Dingman Creek 
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Figure 3.10 Location of special concern at the Stoney Creek 
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Figure 3.11 Location of special concern at the Stoney Creek (Powell Drain) 
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Figure 3.12 Location of special concern at the Stoney Creek (Northdale Drain)  
 

This “reach” of Northdale Drain 
Exist in DELCAN and UTRCA 
HEC-RAS models 
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Figure 3.13 Location of special concern at the Stoney Creek (Northdale Drain) 
Source: UTRCA HEC-RAS model (Stoney Creek and Tributaries) 

 
 

HEC-RAS results and Floodplain Mapping results for all rivers and creeks are included on 

4 DVDs in Appendix A. The content of each DVD with its accompanying software 

requirements, data and results locations, and detailed instructions on how to open and rerun each 

model are presented in Read_Me doc.file.  

 

Adelaide St N 

Sunningdale Rd E 
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4. CONCLUSIONS AND RECOMMENDATIONS 

Completed hydraulic and floodplain mapping analyses under climate change for the 

territory of the City of London have been done using existing data (as presented in earlier 

Chapters) and new computer-based approach that combines GIS tools and classical hydraulic 

modelling. Data quality and modelling approach used have certain limitations that are affecting 

the accuracy of the modelling results. Following sections present the limitations of the work 

presented in this report and set of recommendations that are based on the identified limitations. 

 

4.1. Limitations 

Cross section data. One of the biggest limitations of the Hydraulic and Floodplain 

Mapping activities conducted in the project is the quality of cross sections provided by the 

UTRCA. The cross sections data is one of the key inputs for the HEC-RAS hydraulic analyses 

and therefore the quality of cross sections has direct impact on the water surface elevation results 

and therefore on floodplain mapping results.  

Firstly, the available cross sections are not georeferenced due to unavailability of necessary 

data. This prevents the use of cross section data with any software (like HEC-GeoRAS) for 

automatic floodplain delineation and risk analyses. Second, the available cross sections were 

surveyed during 1970’s and 1980’s.  The geomorphology of the channel and surrounding area is 

significantly changed at many locations due to sedimentation and erosion as well as land use 

change. Third, the available cross sections were initially surveyed for the use with HEC-2 

hydraulic model (previous version of the HEC-RAS). At that time, there was no rule for 

surveying cross sections from left to right (looking downstream). Therefore, the current cross 

sections include the mix of data surveyed in different directions.  As a result of mixed data at 
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bridge cross sections, entering bridge data in this project was made significantly more 

complicated. Fourth, many cross sections were not wide enough to cover the entire floodplain.  

TIN data.  Since the TIN is used for creating geometric data during pre-processing and 

floodplain mapping during post-processing, limitations related to TIN are seriously considered. 

The inaccuracy of contour lines threatened the overall quality of TIN.  The TIN accuracy within 

the river channel has been improved by recreation TIN within the channel.  This is done by using 

information from the available UTRCA cross sections. 

There have been some noticeable limitations in TIN quality at some locations in the 

floodplain. At those locations, the contour lines were broken, or insufficient for the 

representation terrain. In most cases this limitation is reflected in the final result through straight 

line representation of flood lines. 

 

4.2 Recommendations 

All the limitations identified during the project have direct impact on the quality of final 

results and therefore the following section provides a set of recommendations that can improve 

the accuracy of future floodplain analyses. 

 New georeferenced cross sections should be surveyed for London’s rivers and 

Creeks. Cross sections should be surveyed from left to right (looking at downstream 

direction) and they should be wide enough to capture the whole floodplain. 

 The new cross sections should be incorporated into existing TINs to ensure higher 

level of accuracy. 

 If possible a LIDAR surveying and TIN creation from LIDAR data is recommended. 

It has been reported in the literature that LIDAR collected data produce more accurate 
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results. A very accurate Medway TIN has been generated from LIDAR data. Even 

with LIDAR data it is still necessary to do surveying within the river in conventional 

ways in order to incorporate the river channel cross sections results into the LIDAR 

TIN.    

 A new land use shape file with appropriate Manning’s n values should be created in 

high resolution for whole area within the City of London. Manning’s values could 

then be automatically assigned to each cross section, particularly in the  pre-

processing phase of HEC-GeoRAS use.  

 If new data is available, repeat the pre-processing to generate more accurate 

geometric data. Run the HEC-RAS models with more accurate geometric data to get 

more accurate water surface elevation results.  Repeat the floodplain mapping 

analyses.  
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Appendix A:  Data on the attached DVD’s  
 
Vulnerability of Infrastructure to Climate Change: The City of L ondon 
Principal Investigator: Prof. Slobodan P. Simonovic 
Research Associate: Dragan Sredojevic, M.Sc Student 
Date: September 2009 
Hydraulic Modeling and Floodplain Mapping 
-------------------------------------------------------------------------------------------------------------- 
Ź Required Software 
- HEC-RAS (version 3.1.3 or higher)  
- Arc View ( version 9.3) 
- Copy content from DVD discs to the C drive 

       Ź Input Data 
- Geometry input data are generated in Arc Map by using HEC-GeoRAS Extension 

(From TIN terrain model) 
- RAS Gis Import File (.RASImport.sdf)  was created and located in Maps folder  
- Input data for HEC-RAS models: Newly generated  100 and 250 years flows under 2 

climate change scenarios (Historic and Wet Scenarios); Newly generated boundary 
conditions (Known WS); Bridge data and Manning values (UTRCA HEC-RAS 
Models); Bridge drawings (City of London) ; 

                           
Ź HEC-RAS Modeling 

- Create HEC-RAS project and Import RAS GIS Import file 
- Complete geometric, hydraulic structures (bridges) and flow data  
- Compute HEC-RAS results and review results for hydraulic correctness  
- Create the RAS GIS Export File (.RASexport.sdf)  with HEC-RAS simulations 

results-water surface data at same location as HEC-RAS model 
Ź Output Data 

- Convert .RASexport.sdf to XML and Import it in Arc Map 
-  Layer Setup  for Inundation Mapping Results 
- Generate Water surface Tin 
- Generate floodplain and depth grid 

Location of Data Base with Floodplain Mapping Results: 
- Geo HECRAS Project>Results>Models>Geo HECRAS >Final results 

 
Ź DVDs Content 

 
        Ź DVD 1 

1. GeoHECRAS Project-Main Thames 
    Opening of Arc Map with Geometry: 

- Open Arc Map>Check an existing map>Brows for map >Results 
>Maps>Main_New.mxd>Activate Main Geometry Layer 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results 
>Maps>Main_New.mxd>Activate Main Thames in London_ New Flows1 Layer 

- Opening of HEC-RAS Model: 
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- Start HEC-RAS>Open Project>Results>Models>HECRAS >Final Results >                     
Open Project: Main Thames_ London_NewFlows1 

2. GeoHECRAS Project-South Thames 
    Opening of Arc Map with Geometry: 

- Open Arc Map>Check an existing map>Brows for map>Results> 
Maps>South.mxd>Activate South Geometry Layer 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results 
>Maps>South_New.mxd>Activate South Thames_City Boundary_New Flows Layer 
Opening of HEC-RAS Model: 

- Start HEC-RAS>Open Project>Results>Models>HECRAS >Final Results >                                 
Open Project: South Thames in London_New Flows 

 
3. GeoHECRAS Project-Mud Creek 

    Opening of Arc Map with Geometry: 
- Open Arc Map>Check an existing map>Brows for map>Results> Maps>Mud.mxd>   

Activate Mud_Cr_ Geometry Layer 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results >Maps>Mud.mxd> 
Activate Mud Creek_New Flows Layer 
Opening of HEC-RAS Model: 

- Start HEC-RAS>Open Project>Results>Models>HECRAS >Final Results >                                 
Open Project: Mud Creek in London_New Flows 

 
 
        Ź DVD 2 

1. GeoHECRAS Project-North Thames 
    Opening of Arc Map with Geometry: 

- Open Arc Map>Check an existing map>Brows for map >Results 
>Maps>North_New.mxd>Activate North Geometry Layer 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results 
>Maps>North_New.mxd>Activate North Thames_New Flows  Layer 

- Opening of HEC-RAS Model: 
- Start HEC-RAS>Open Project>Results>Models>HECRAS >Final Results >                     

Open Project: North Branch of Thames River_NewFlows 

2. GeoHECRAS Project-Medway Creek New 
    Opening of Arc Map with Geometry: 

- Open Arc Map>Check an existing map>Brows for map>Results                                              
> Maps>Medway new.mxd>Activate Medway Geometry Layer 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results 
>Maps>South_New.mxd>Activate Medway_New Flows Layer 
Opening of HEC-RAS Model: 
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- Start HEC-RAS>Open Project>Results>Models>HECRAS >Final Results >                                 
Open Project: Medway  in London_New Flows 

 
Ź DVD 3 

1. GeoHECRAS Project-Pottersburg Creek 
    Opening of Arc Map with Geometry: 

- Open Arc Map>Check an existing map>Brows for map >Results                    
>Maps>Pottersburg.mxd 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results                          
>Maps>Pottersburg Creek_NewFlows.mxd 

- Opening of HEC-RAS Model: 
- Start HEC-RAS>Open Project>Results>Models>HECRAS >Final Results >                     

Open Project: Pottersburg Creek_London_New Flows 
 

2. GeoHECRAS Project-Stoney Creek and Tributaries 
    Opening of Arc Map with Geometry: 

- Open Arc Map>Check an existing map>Brows for map>Results                                              
> Maps>Stoney.mxd>Activate Stoney _Geometry Layer 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results 
>Maps>South_New.mxd>Activate Stoney_New Flows Layer 
Opening of HEC-RAS Model: 

- Start HEC-RAS>Open Project>Results>Models>HECRAS >Newest Results >                                 
Open Project: Stoney Creek  in London_New Flows 

 
Ź DVD 4 

1. GeoHECRAS Project-Dingman Results 
    Opening of Arc Map with Geometry: 

- Open Arc Map>Check an existing map>Brows for map >Results                    
>Maps>Dingman.mxd 
Opening of Arc Map with Floodplain Mapping Results: 

- Open Arc Map>Check an existing map>Brows for map >Results                          
>Maps>WholeDingman_NewFlows.mxd 

- Opening of HEC-RAS Model: 
- Start HEC-RAS>Open Project>Results>Models>HECRAS >                                                     

Open Project: Dingman Creek New Flows 

 
         Ź Remarks 

- Since Arc GIS required identical folder structure, some of layer links in the Arc Map 
may be broken 

- To fix it, click on red sign (!) beside the layer and set up data source                           
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Appendix B: Previous Reports in the Series 
 
ISSN: (print) 1913-3200; (online) 1913-3219 
 
(1) Slobodan P. Simonovic (2001). Assessment of the Impact of Climate Variability and Change 
on the Reliability, Resiliency and Vulnerability of Complex Flood Protection Systems. Water 
Resources Research Report no. 038, Facility for Intelligent Decision Support, Department of 
Civil and Environmental Engineering, London, Ontario, Canada, 91 pages. ISBN: (print) 978-0-
7714-2606-3; (online) 978-0-7714-2607-0. 
 
(2) Predrag Prodanovic (2001). Fuzzy Set Ranking Methods and Multiple Expert Decision 
Making. Water Resources Research Report no. 039, Facility for Intelligent Decision Support, 
Department of Civil and Environmental Engineering, London, Ontario, Canada, 68 pages. ISBN: 
(print) 978-0-7714-2608-7; (online) 978-0-7714-2609-4. 
 
(3) Nirupama and Slobodan P. Simonovic (2002). Role of Remote Sensing in Disaster 
Management. Water Resources Research Report no. 040, Facility for Intelligent Decision 
Support, Department of Civil and Environmental Engineering, London, Ontario, Canada, 107 
pages. ISBN: (print) 978-0-7714-2610-0; (online) 978-0-7714- 2611-7. 
 
(4) Taslima Akter and Slobodan P. Simonovic (2002). A General Overview of Multiobjective 
Multiple-Participant Decision Making for Flood Management. Water Resources Research Report 
no. 041, Facility for Intelligent Decision Support, Department of Civil and Environmental 
Engineering, London, Ontario, Canada, 65 pages. ISBN: (print) 978-0-7714-2612-4; (online) 
978-0-7714-2613-1. 
 
(5) Nirupama and Slobodan P. Simonovic (2002). A Spatial Fuzzy Compromise Approach for 
Flood Disaster Management. Water Resources Research Report no. 042, Facility for Intelligent 
Decision Support, Department of Civil and Environmental Engineering, London, Ontario, 
Canada, 138 pages. ISBN: (print) 978-0-7714-2614-8; (online) 978-0-7714-2615-5. 
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Analysis Methods for Resolution of Conflicts in Water Resources Management. Water 
Resources Research Report no. 043, Facility for Intelligent Decision Support, Department of 
Civil and Environmental Engineering, London, Ontario, Canada, 216 pages. ISBN: (print) 978-0-
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(7) K. D. W. Nandalal and Slobodan P. Simonovic (2003). Conflict Resolution Support System – 
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Research Report no. 044, Facility for Intelligent Decision Support, Department of Civil and 
Environmental Engineering, London, Ontario, Canada, 144 pages. ISBN: (print) 978-0-7714-
2618-6; (online) 978-0-7714-2619-3. 
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